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Introduction
This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.
Do not copy or print any item for which reproduction is prohibited by law.
Copying or printing the following items is generally prohibited by local law:
bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.
The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Important
Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks
Microsoft®, Windows®, Windows NT® and Windows Server® are either registered trademarks or trade-
marks of Microsoft Corporation in the United States and/or other countries.
Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.
Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and True Type are trademarks of Apple Computer
Inc., registered in the U.S. and other countries.
BonjourTM is a trademark of Apple Computer, Inc.
Citrix® and MetaFrame® are registered trademarks of Citrix Systems, Inc.
UPnP is a trademark of the UPnP Implementers Corporation.
HP-GL is a registered trademark of Hewlett-Packard Co.
Sun, Sun Microsystems, the Sun logo, Java, the Java Coffee Cup logo, J2SE, and all trademarks and
logos based on Java are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S.
and other countries.
IPS-PRINTTM Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Reserved.
UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.
Novell, NetWare are registered trademarks of Novell, Inc.
Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation.
Ethernet is a registered trademark of Xerox Corporation.
Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.
The proper names of the Windows operating systems are as follows:
• The product name of Windows 98 is Microsoft® Windows® 98.
• The product name of Windows Me is Microsoft® Windows® Millennium Edition (Windows Me).
• The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
Microsoft® Windows® Media Center Edition
Microsoft® Windows® Tablet PC Edition

• The product names of Windows Server 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition
Microsoft® Windows Server® 2003 Enterprise Edition
Microsoft® Windows Server® 2003 Web Edition
Microsoft® Windows Server® 2003 Datacenter Edition

• The product names of Windows Server 2003 R2 are as follows:
Microsoft® Windows Server® 2003 R2 Standard Edition
Microsoft® Windows Server® 2003 R2 Enterprise Edition
Microsoft® Windows Server® 2003 R2 Datacenter Edition

• The product names of Windows NT 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Notes
Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.
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Manuals for This Printer

Refer to each manual as required.

Important
❒ Media differ according to manual.
❒ To view the PDF versions of these manuals, Adobe Acrobat Reader/Adobe

Reader must be installed on your computer.
❒ Depending on which country you are in, HTML versions of these manuals

might also be provided. To view these, a Web browser must be installed on
your computer.

❖ Safety Information
Provides information on safe usage of this machine.
To prevent damage to the machine and avoid injury, be sure to read this.

❖ Hardware Guide
Contains information about paper and explains procedures such as installing
options, replacing consumables, responding to error messages, and resolving
jams.

❖ Software Guide (This manual)
Contains procedures for using this machine in a network environment, utiliz-
ing the software, and using security functions.

❖ Security Reference
This manual is for machine administrators.
The machine’s security functions prevent unauthorized use of the machine,
data tampering, and information leakage.
For increased security, configure the following settings.
• Using Server Certificates
• Using SSL
• Changing Administrator User Names and Passwords
For details, see “Setting Up the Printer”, Security Guide.
Be sure to refer to this manual when configuring the machine’s security and
authentication settings.
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How to Read This Manual

Symbols

The following set of symbols is used in this manual.

Indicates important safety notes.
Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information”.

Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
“Safety Information”.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.
[ ]
Indicates the names of keys that appear on the machine’s display panel.
{ }
Indicates the names of keys on the machine’s control panel.
Keys on the computer’s keyboard.

Names of Major Options

This section explains the names of the major options described in this manual.
Major options for this machine are referred to as follows:
• Paper Cassette Type 240 → Cut paper tray
• Folder FD6500A → Folding finisher
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Model-Specific Information

In this manual, model-specific information is indicated by the following marks:

Indicates information that is specific to the 220 to 240 V model.

Indicates information that is specific to the 120 V model.

Note
❒ Check the label on the rear of the printer to identify the model.

❒ Dimensions in this manual are given in two units of measure: metric and inch.
If your printer is the 220 to 240 V model, refer to the metric units. If your print-
er is the 120 V model, refer to the inch units.

BAL006S
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Using Keys

This section explains names and usage of the parts of the control panel.

1. Display
Displays current printer status and error
messages.
Entering energy saver mode turns off the
back light. For details about energy saver
mode, see Software Guide.

2. Selection keys
Correspond to the function items shown
on the bottom line of the display.

3.  {Escape} key
Press this key to return to the previous
display.

4. Scroll keys
Press to move the cursor in each direction.
When the {U}{T}{V}{W} keys appears
in this manual, press the scroll key of the
same direction.

5.  {OK} key
Use this key to confirm settings, or set-
ting values, or move to the next menu
level.

6. Data In indicator
Blinks when the printer is receiving data
from a computer. The Data In indicator
lights up if there is data to be printed.

7. Alert indicator
Lights up when a printer error occurs.
Follow the instructions that appear on
the display.

8. Power indicator
Remains lit while the power is on. It is
unlit when the power is off or while the
printer is in energy saver mode.

9.  {Job Reset} key
When the printer is online, press this key
to cancel an ongoing print job.

10.  {Menu} key
Press this key to configure and check the
current printer settings.

11.  {Online} key
Indicates whether the printer is online or
offline. Press this to switch between on-
line and offline status.
When the lamp is lit, the printer is online,
enabling data reception from connected
computers.
When the lamp is unlit, the printer is of-
fline, disabling data reception from the
connected computers.
While configuring settings, press the
{Online} key to return to the initial
screen.

BAL048S
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1. Preparing for Printing
1

Quick Install

Windows 95/98/Me/2000/XP, and Windows Server 2003/2003 R2 users can
easily install this software using the CD-ROM provided.
Quick Install sets the TCP/IP port and installs DeskTopBinder - SmartDevice-
Monitor for Client and the RPCS printer driver.

Important
❒ To install printer driver under Windows 2000/XP and Windows Server

2003/2003 R2, you must have an account that has Manage Printers permis-
sion. Log on as an Administrator.

❒ The Quick Install is not available when using this printer under USB connec-
tion.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

E After reading the agreement, click [I accept the agreement.], and then click
[Next >].

F Select the printer model you want to use in the [Select Printer] dialog box.
For network connection via TCP/IP, select the printer whose IP address is
displayed in [Connect To].
For parallel connection, select the printer whose printer port is displayed in
[Connect To].

G Click [Install].
The printer driver installation starts.

H Click [Finish].
A message about restarting the computer may appear. Restart the computer
to complete installation.
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I Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Select a printer to whose IP address is displayed in [Connect To] to install

SmartDeviceMonitor for Client when using TCP/IP.
❒ Download the printer driver from the supplier’s web site when using un-

der Windows NT 4.0.

Reference
p.52 “Making Option Settings for the Printer” 
p.46 “Installing the Printer Driver Using USB”
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Confirming the Connection Method

This printer supports network and local connection.
Before installing the printer driver, check how the printer is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this printer as the Windows printing port

Network connections can be established through Ethernet and IEEE 802.11b.
Available ports are determined based on the combination of Windows operating
system version and connection method used.

ZZZ500S
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❖ Windows 95/98

❖ Windows Me

❖ Windows 2000

❖ Windows XP

❖ Windows Server 2003/2003 R2

❖ Windows NT 4.0

Note
❒ See the explanation of how to install the printer driver for each type of port.

Reference
p.7 “Using the SmartDeviceMonitor Port”
p.26 “Using the Standard TCP/IP Port”
p.32 “Using the LPR Port”

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

LPR port
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Using as a network printer

This printer can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Important
❒ In an IPv6 environment, Netware servers cannot be used.

Note
❒ See the explanation of how to install the printer driver for each type of net-

work printer.

Reference
p.37 “Using as the Windows Network Printer”
p.42 “Using as the NetWare Print Server/Remote Printer”

Windows 2000/XP
Windows Server 2003/2003 R2
Windows NT 4.0
Print Server

Windows 95/98/Me Windows 2000 Windows XP/
Server 2003/2003 R2

Windows NT 4.0

NetWare
Print Server

NetWare
File Server

ZZZ501S
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Local Connection

Local connections can be established via USB connection.
Windows operating system version that can use the USB connection is as follows:
• Windows Me
• Windows 2000
• Windows XP, Windows Server 2003/2003 R2

Note
❒ See the explanation about how to install the printer driver for USB connection.

Reference
p.46 “Installing the Printer Driver Using USB”
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Using the SmartDeviceMonitor Port

Installing DeskTopBinder-SmartDeviceMonitor for Client

Important
❒ To install SmartDeviceMonitor for Client under Windows 2000/XP, Win-

dows Server 2003/2003 R2, and Windows NT 4.0, you must have an account
that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [DeskTopBinder - SmartDeviceMonitor for Client].

E The message to quit all other applications appears. Quit all applications,
and then click [Next>].

F The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

G Click [Full install] or [Custom Install].
[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.
[Custom Install] installs selected applications.

H Follow the instructions on the display and click [Next>] to proceed next step.

I After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
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Installing the RPCS Printer Driver (TCP/IP)

Important
❒ To install this printer driver under Windows 2000/XP and Windows Server

2003/2003 R2, you must have an account that has Manage Printers permis-
sion. Log on as an Administrators or Power Users group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [RPCS Printer Driver].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next
>].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:] , [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [SmartDeviceMonitor], and then click [OK].

L Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.
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M Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IP address
or host name of the printer.

N Check that the port of the selected printer is displayed in [Port].

O Set a user code, if necessary.
Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].
Installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ Under Windows 95/98/Me, you cannot add an IPv4 address partially sim-

ilar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used.

❒ This allows a SmartDeviceMonitor for Admin user to display and check
statistics about the number of sheets which each user prints. For details,
see SmartDeviceMonitor for Admin Help.

❒ A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, install using [Add Printer].

Reference
p.50 “Having Problems Installing the Printer Driver from the CD-ROM”
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Installing the RPCS Printer Driver (IPP)

Important
❒ To install printer driver under Windows 2000/XP and Windows Server

2003/2003 R2, you must have an account that has Manage Printers permis-
sion. Log on as an Administrators or Power Users group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [RPCS Printer Driver].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [SmartDeviceMonitor], and then click [OK].

K Click [IPP].

L In the [Printer URL] box, enter “http://printer’s address/printer” as the printer's
address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://printer’s address/printer” (Internet Explorer
5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http: //printer’s address/ipp” as the printer’s address.
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M Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

N Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

O Click [OK].

P Check that the port of the selected printer is displayed in [Port:].

Q Set a user code, if necessary.
Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

R Select the [Default Printer] check box to configure the printer as default.

S Click [Continue].
Installation starts.

T After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ This allows a SmartDeviceMonitor for Admin user to display and check

the number of sheets each user prints. For details, see SmartDeviceMonitor
for Admin Help.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

❒ A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer].

Reference
p.50 “Having Problems Installing the Printer Driver from the CD-ROM”
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Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

M On the [Details] tab, click [Add Port…].

N Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

O Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.
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P Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IPv4 ad-
dress or host name of the printer.
You cannot add an IPv4 address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

Q Click [OK].

R Check that the selected port is highlighted in [Print to the following port:], and
then click [OK].

S Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ A User Code can be set after the printer driver installation. For information

about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

Important
❒ IPv6 cannot be used under Windows 95/98/Me.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

M On the [Details] tab, click [Add Port…].

N Click [SmartDeviceMonitor] in the Other list, and then click [OK].

O Click [IPP].
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P In the [Printer URL] box, enter “http://(printer’s address)/printer” as the print-
er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypt-
ed communication), enter “https://(printer’s address)/printer” (Internet
Explorer 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://(printer’s address)/ipp” as the printer’s address.

Q Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

R Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

S Click [OK].

T Check that the selected port is highlighted in [Print to the following port:], and
then click [OK].

U Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IPv4 ad-
dress or host name of the printer.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.
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M Specify whether or not to share the printer, and then click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ IPv6 cannot be used under Windows 2000.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Click [Create a new port:].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er’s address.
If the server authentification is issued, to enable SSL (a protocol for encrypt-
ed communication), enter “https://(printer’s address)/printer” (Internet
Explorer 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://(printer’s address)/ipp” as the printer’s address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.
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L Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].

N Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

O Change the printer name if you want, and then click [Next >].

P Click [Next >].

Q Specify whether or not to print a test page, and then click [Next >].

R Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003/2003 R2 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Click [Create a new port:].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

J Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IPv4 ad-
dress or host name of the printer.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.
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M Specify whether or not to print a test page, and then click [Next >].

N Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected:Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003/2003 R2 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Click [Create a new port:].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypt-
ed communication), enter “https://(printer’s address)/printer” (Internet
Explorer 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter “http://(printer’s address)/ipp” as the printer’s address.
If you are using Firefox or Netscape under Windows XP SP 2 or Windows
Server 2003/2003 R2, you can enter IPv6 address as “http://IPv6 printer’s
address/printer”.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.
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L [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].

N Check that the name of the printer driver you want to install is selected, and
then click [Next >].

O Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95/98/Me:

A On the [Start] menu, point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Port Settings...].
The [Port Settings] dialog box appears.

Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Ports] tab, click [Configure Port...].
The [Port Configuration] dialog box appears.

Windows XP and Windows Server 2003/2003 R2:

A On the [Start] menu, click [Printers and Faxes].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Ports] tab, and then click [Configure Port...].
The [Port Configuration] dialog box appears.
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Note
❒ For TCP/IP, timeout setting can be configured.
❒ User, proxy, and timeout settings can be configured for IPP.
❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow the

procedure below.
A Click [Cancel] to close the [Port Configuration:] dialog box.
B Start SmartDeviceMonitor for Client, and then right-click the SmartDe-

viceMonitor for Client icon on the tasktray.
C Point to [Properties], and then click [Extended Features Settings].
D Select the [Set Recovery/Parallel Printing for each port] check box.
E Click [OK] to close the [Extended Features Settings] dialog box.

❒ For information about these settings, see SmartDeviceMonitor for Client
Help.
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Using the Standard TCP/IP Port

Installing the RPCS Printer Driver

Important
❒ To install printer driver under Windows 2000/XP and Windows Server

2003/2003 R2, you must have an account that has Manage Printers permis-
sion. Log on as an Administrators or Power Users group member.

❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor port

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [RPCS Printer Driver].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [Standard TCP/IP Port], and then click [OK].
Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.
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L Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

M Enter the printer name or IPv4 address in the [Printer Name or IP Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

N Click [Next >].

O Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

P Check that the port of the selected printer is displayed in [Port:].

Q Configure the default printer as necessary.

R Click [Continue].
The printer driver installation starts.

S After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ A message appears if there is a newer version of the printer driver already

installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer].

Reference
p.50 “Having Problems Installing the Printer Driver from the CD-ROM”
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Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the

SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP Port], and then click [Next >].

I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

J Enter the printer name or IPv4 address in the [Printer Name or IP Address] box,
and then click [Next >].
When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

K Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

L Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

N Click [Next >].

O Specify whether or not to print a test page, and then click [Next>].

P Click [Finish].
The printer driver installation starts.
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Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003/2003 R2)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the

SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP Port] in [Create a new Port], and then click [Next >].

I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

J Enter the printer name or IPv4 address in the [Printer Name or IP Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

K Click [Next >].

L Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

M Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].
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N Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

O Click [Next >].

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Using the LPR Port

Installing the RPCS Printer Driver

Important
❒ To install this printer driver under Windows 2000/XP Windows Server

2003/2003 R2, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

❒ In an IPv6 environment, you cannot use the LPR Port. Use the SmartDevice-
Monitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [RPCS Printer Driver].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.
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K Enter the printer's IPv4 address in the [Name or address of server providing lpd]
box.

L Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].
The port is added.

M Check that the port of the selected printer is displayed in [Port:].

N Configure the default printer as necessary.

O Click [Finish].
The printer driver installation starts.

P After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ A message appears if there is a newer version of the printer driver already

installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer].

Reference
p.50 “Having Problems Installing the Printer Driver from the CD-ROM”.
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Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the LPR Port. Use the SmartDevice-

Monitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [LPR Port], and then click [Next >].

I Enter the printer's IPv4 address in the [Port Name] box, and then click [OK].

J Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

K Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

L Specify whether or not to share the printer, and then click [Next >].

M Specify whether or not to print a test page, and then click [Next >].

N Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003/2003 R2)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the LPR Port. Use the SmartDevice-

Monitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer attached to this computer], and then click [Next >].

G Click [Create a new port:].

H Click [LPR Port] in [Create a new Port], and then click [Next >].

I Enter the printer's IP address in the [Name or address of server providing lpd]
box.

J Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.
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Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the RPCS Printer Driver

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000/XP, or Windows Server 2003/2003
R2 shared printer.
This section assumes that the client has already been configured to communicate
with a Windows 2000/XP, or Windows Server 2003/2003 R2 print server. Do not
begin the following procedure before the client is set up and configured correctly.

Important
❒ To install printer driver under Windows 2000/XP and Windows Server

2003/2003 R2, you must have an account that has Manage Printers permis-
sion. For this, log on as an Administrators or Power Users group member.

❒ If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

❒ SmartDeviceMonitor’s notification functions are not available if you are us-
ing a Windows XP or Windows Server 2003/2003 R2 print server.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [RPCS Printer Driver].

E The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the printer models you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.
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J Click [Port:], and then click [Add].

K Click [Network Printer], and then click [OK].

L Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

M Select the printer you want to use, and then click [OK].

N Check that the port of the selected printer is displayed in [Port:].

O Configure the User Code as necessary.
For an RPCS printer driver, a User Code can be set after the printer driver in-
stallation. For information about User Code, see the printer driver Help.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].
The printer driver installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ A message appears if there is a newer version of the printer driver already

installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer].

Reference
p.50 “Having Problems Installing the Printer Driver from the CD-ROM”



Using as the Windows Network Printer

39

1

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

Important
❒ If you print from a print server connected to the printer using the SmartDevice-

Monitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Network Printer], and then click [Next >].

G Click [Browse].

H Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

I Select the printer you want to use, and then click [OK].

J Check the location of the selected printer is shown, and then click [Next >].

K Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].

M Restart the computer.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.



Preparing for Printing

40

1

Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the SmartDevice-

Monitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Network printer], and then click [Next >].

G Select the location method from the [Locate Your Printer] screen, and then
click [Next >].

H Double-click the computer name you want to use as a print server in the
[Shared printers:] window.

I Select the printer you want to use, and then click [Next >].

J The printer driver installation starts.

K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003/2003 R2)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the SmartDevice-

Monitor port, the client cannot use Recovery Printing and Parallel Printing.
❒ If you print with a Windows XP or Windows Server 2003/2003 R2 print server,

SmartDeviceMonitor notification functions may not be possible for the client.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [A network printer, or a printer attached to another computer], and then click
[Next >].

G Select [Browse for a printer], and then click [Next >].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next >].

J The printer driver installation starts.

K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Using as the NetWare Print Server/Remote 
Printer

This explains how to set up the Windows computer used as the NetWare client.

Important
❒ To install this printer driver under Windows 2000/XP Windows Server

2003/2003 R2, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

❒ In an IPv6 environment, Netware servers cannot be used.
The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.
Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:
• Operating system: Windows 98
• NetWare version: 4.1
• File server name: CAREE
• Queue name: R-QUEUE

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

C Click [RPCS Printer Driver].

D The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

F Click [Next >].

G Select the printer models you want to use.
The printer name can be changed in the [Change settings for 'Printer Name’] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.
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I Click [Port:], and then click [Add].

J Click [Network Printer], and then click [OK].

K Double-click the name of the NetWare file server on the network tree.
The created queue is displayed.

L Select the print queue, and then click [OK].

M Check that the port of the selected printer is displayed in [Port:].

N Click [Continue].
The printer driver installation starts.

O Click [Finish] in the [Select Program] dialog box.

P After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Q After restarting the computer, launch the [Printers] window, and then open
the printer properties.
Under Windows XP or Windows Server 2003/2003 R2, open the printer prop-
erties from the [Printers and Faxes] window.

R Click [Finish] in the [Introduction complete] dialog box.

S In the [Printers] window, open the printer properties.
Under Windows XP or Windows Server 2003/2003 R2, open the printer prop-
erties from the [Printers and Faxes] window.

T On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.
Under Windows 2000/XP, Windows Server 2003/2003 R2, or Windows NT
4.0, click the [NetWare setting] tab.
Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

U Click [OK] to close the printer properties dialog box.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ The protocol is set to inactive as default. Enable it using Web Image Mon-

itor or telnet.
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When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

Important
❒ In an IPv6 environment, NetWare servers cannot be used.

A  In the [Printers] or [Printers and Faxes] window, open the printer properties.

B Click the [PostScript] tab.
If you are using Windows 2000/XP or Windows NT4.0, click the [Device Set-
tings] tab, and then clear the check boxes.

C Click [Advanced].

D Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

E Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly.
Follow the procedure below to disable form feed according to the operating sys-
tem used:
• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• Under Windows 2000/XP, Windows Server 2003/2003 R2, or Windows NT

4.0, clear the [Form feed] check box on the [NetWare Settings] tab in the printer
properties dialog box.

Banner Page

Do not use NetWare to configure a banner page.
Follow the procedure below to disable banner pages according to the operating
system used:
• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• Under Windows 2000/XP, Windows Server 2003/2003 R2, or Windows NT

4.0, clear the [Enable banner] check box on the [NetWare Settings] tab in the print-
er properties dialog box.
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Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.
To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.
Before installing, check that only the operating system is running on the comput-
er and no print jobs are in progress.
The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows Me - USB

The following explains how to install the printer driver using USB under Win-
dows Me.

Important
❒ Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-

dows Me or later.
❒ Download USB Printing Support for Windows Me from the supplier's Web

site.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

A Download USB Printing Support from the supplier's Web site.
Use a search to find the model name, and then download USB Printing Sup-
port from the supplier's Web site.
Save it where you can locate it easily.

B Check the printer's power switch is off.

C Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

D Turn on the printer's power switch.
The Plug and Play is enabled, and [Found New Hardware Wizard] appears.
If USB Printing Support is already installed on the computer proceed to Step J.

E In the [Found New Hardware Wizard] display, click [Install from a list or specific lo-
cation (Advanced)], and then click [Next >].

F Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

G Specify the location where USB Printing Support is located, and then click
[Next >].
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H Check the location, and then click [Next >].
USB Printing Support is installed.

I Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

J Install the printer driver.

K In the [Found New Hardware Wizard] dialog box, click [Install from a list or specific
location (Advanced)], and then click [Next >].

L Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

M Insert the CD-ROM into the CD-ROM drive.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

N Specify the location where the source files of the printer driver are stored,
and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN9X_ME\(Language)DISK1
• PostScript 3

D:\DRIVERS\PS\WIN9X_ME\(Language)DISK1

O Check the location, and then click [Next >].
Add Printer Wizard starts.

P Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
❒ It is not necessary to reinstall USB Printing Support when connecting a dif-

ferent machine via USB interface when USB Printing Support is installed.
❒ After installing USB Printing Support, if the printer driver is not installed,

follow the plug-and-play instructions of the printer.
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Windows 2000 - USB

The following explains how to install the printer driver using USB under Win-
dows 2000.

Important
❒ Installing a printer driver requires Administrator permission. Log on using

an account that has Administrator permission.
When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

C Select the [Specify location] check box, and then click [Next >].

D Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Cancel], and then [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

E Specify the location where the source files of the printer driver are stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN2K_XP\(Language)DISK1
• PostScript 3

D:\DRIVERS\PS\WIN2K_XP\(Language)DISK1

F Check the printer driver location, and then click [OK].

G Click [Next >].

H Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
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Windows XP, Windows Server 2003/2003 R2- USB

The following explains how to install the printer driver using USB under Win-
dows Server 2003/2003 R2.

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
The printer drivers can be installed from the supplied CD-ROM provided with
this machine.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

A Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Install the software auto-
matically (Recommended)], and then click [Next >].

C Insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].
To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN2K_XP\(Language)DISK1
• PostScript 3

D:\DRIVERS\PS\WIN2K_XP\(Language)DISK1

D Select the machine model you want to use in the Found New Hardware
Wizard display, and then click [Next >].

E Click [Continue Anyway].

F Click [Finish].
If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
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Having Problems Installing the Printer 
Driver from the CD-ROM

If Quick Install fails, refer to “Using the SmartDeviceMonitor for Client” and
proceed with the installation.
If the installation procedures explained in “Installing RPCS Printer Drivers” or
“Installing PostScript 3 Printer Driver” fails, follow the procedure below.

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].

B Double-click the Add Printer icon.

C Follow the instructions in Add Printer Wizard.
If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is either DRIVERSRPCSWIN9X_ME, or DRIVERSRPCSWIN2K_XP. If the in-
staller starts, click [Cancel] to quit.

D Change the port settings.
Refer to the port description for the procedure.

For Windows XP Professional and Windows Server 2003/2003 R2:

A On the [Start] menu, click [Printers and Faxes].

B Click [Add a printer].

C Follow the instructions in Add Printer Wizard.
If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is DRIVERSRPCS WIN2K_XP. If the installer starts, click [Cancel] to quit.

D Change the port settings.
Refer to the port description for the procedure.
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For Windows XP Home Editions:

A On the [Start] menu, click [Control Panel].

B Click [Printers and Other Hardware].

C Click [Printers and Faxes].

D Click [Install Printer].

E Follow the instructions in Add Printer Wizard.
If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is DRIVERSRPCSWIN2K_XP. If the installer starts, click [Cancel] to quit.

F Change the port settings.
Refer to the port description for the procedure.

Note
❒ Available ports may change depending on the combination of Windows

operating system version and the interface. For details about how to find
an available port, see “Confirming the Connection Method”.

Reference
p.3 “Confirming the Connection Method”
p.7 “Using the SmartDeviceMonitor Port”
p.26 “Using the Standard TCP/IP Port”
p.32 “Using the LPR Port”
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Making Option Settings for the Printer

Make option settings for the printer using the printer driver when bidirectional
communication is disabled.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check printer sta-
tus from your computer.
• Bidirectional communication is supported by Windows 95/98/Me/2000/XP,

Windows Server 2003/2003 R2, and Windows NT 4.0.
• If you use the RPCS printer driver and bidirectional communication is en-

abled under Windows 2000, the [Change Accessories] tab is unavailable.

Note
❒ The RPCS printer driver supports bidirectional communications and updates

the printer status automatically.
❒ The PostScript 3 printer driver does not support bidirectional communica-

tions.
To support bidirectional communication, the following conditions must be met:

❖ When connected with the network
• DeskTopBinder Lite must be installed, or the Standard TCP/IP port must

be used.
• Under Windows 2000/XP, Windows Server 2003, [Enable bidirectional sup-

port] must be selected, and [Enable printer pooling] must not be selected on
the [Ports] tab with the RPCS printer driver.

If the Standard TCP/IP port is not being used, one of the following conditions
must be met in addition to the two above:
• The SmartDeviceMonitor for Client port and the TCP/IP protocol must be

used.
• The standard TCP/IP port must be used without changing the default port

name (for Windows 2000 / XP and Windows Server 2003).
• Microsoft TCP/IP print IP address must be specified for use (for Windows

NT 4.0).

❖ When connected with USB
The printer must be connected to the computer’s USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

Note
❒ Install SmartDeviceMonitor for Client from the CD-ROM provided.
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If Bidirectional Communication is Disabled

Configure the option settings as follows when bidirectional communication is
disabled.

Important
❒ Under Windows 2000/XP and Windows Server 2003/2003 R2, Manage Print-

ers permission is required to change the printer properties in the [Printers]
folder. Log on as an Administrators or Power Users group member to acquire
this permission.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Power
Users group member to acquire this permission.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Change Accessories] tab.
If the options in the [Change Accessories] tab are disabled, bidirectional con-
nection is enabled. If this is the case, you do not need to make any changes to
the option settings.
If you are using the RPCS printer driver, click the [Change Accessories] tab.
If you are using the PostScript 3 printer driver, click the [Device Settings] tab.

E In the Option area, select the options that are installed, and then make the
necessary settings.
If you are using the RPCS printer driver: in the [Select printer options:] box, se-
lect the options that are installed.
If you are using the PostScript 3 printer driver: in the [Installable Options] box,
change the status of the options that are installed.

F In [Total memory:], select the total amount of memory, when the optional
SDRAM module is added.

G Click the icon of the installed printer, then select [Printing Preferences...] on
the [File] menu.

H Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from automatic tray
selection.

I Click [OK] to close the printer properties dialog box.
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Memory Capacity and Paper Size

Additional memory other than the standard memory may be required depend-
ing on a job's paper size and data type.

Important
❒ Available paper sizes change depending on the selection you made for [Mem-

ory Usage] in the System menu.
❒ The default SDRAM module (512 MB) must be installed.

❖ Only single-sided printing (600 × 600 dpi)
• Font Priority:

Complex images might fail to print out properly on 914.4 × 15000 mm,
914.4 × 2000 mm, and 36” × 48” sized paper.
Other paper sizes can be printed on.

• Frame Priority:
Complex images might fail to print out properly on 914.4 × 15000 mm sized
paper.
Other paper sizes can be printed on.
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RPCS - Accessing the Printer Properties

There are two dialog box types of the [Printer Properties] dialog box. “Multi-tab”
is used as an example in this manual. For details about changing the dialog box
types, see the printer driver Help.

❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Windows 95/98/Me - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making printer default settings

To make the printer default settings, open the [Printer Properties] dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
When you open the [Printer Properties] dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
[Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application’s own default settings are applied.
❒ For details about settings, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printer Properties] dialog box from that appli-
cation. The following explains how to make settings for the WordPad applica-
tion provided with Windows 95/98/Me.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name:] list, and then click [Proper-
ties...].
The [Printer Properties] dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the [Printer Properties] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application’s own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver’s properties.

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.
When you open the [Printer Properties] dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
[Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
❒ For details about settings, see the printer driver Help.
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Making printer default settings - printing preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ For details about settings, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printing Preferences] dialog box from that ap-
plication. The following explains how to make settings for the WordPad appli-
cation provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Windows XP, Windows Server 2003/2003 R2 - Accessing the 
Printer Properties

This describes how to launch printer driver's properties.

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.
When you open the [Printer Properties] dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
[Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
❒ For details about settings, see the printer driver Help.
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Making printer default settings - printing preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ For details about settings, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printing Preferences] dialog box from that ap-
plication. The following explains how to make settings for the WordPad appli-
cation provided with Windows XP, Windows Server 2003/2003 R2

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
[Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
❒ For details about settings, see the printer driver Help.

Making printer default settings - default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.
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A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ For details about settings, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printer Properties] dialog box from that appli-
cation. The following explains how to make settings for the WordPad applica-
tion provided with Windows NT 4.0.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The [Printer Properties] dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the [Printer Properties] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application’s own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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PostScript 3 - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making printer default settings

To make the printer default settings, open the [Printer Properties] dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
The [Printer Properties] dialog box appears.

C On the [File] menu, click [Properties].

DMake the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application’s own default settings are applied.
❒ For details about settings, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printer Properties] dialog box from that appli-
cation. The following explains how to make settings for the WordPad applica-
tion provided with Windows 95/98/Me.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name...] list, and then click [Proper-
ties...].
The [Printer Properties] dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the [Printer Properties] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application’s own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
❒ For details about settings, see the printer driver Help.

Making printer default settings - printing preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ For details about settings, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printing Preferences] dialog box from that ap-
plication. The following explains how to make settings for the WordPad appli-
cation provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Windows XP, Windows Server 2003/2003 R2 - Accessing the 
Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
❒ For details about settings, see the printer driver Help.

Making printer default settings - printing preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ For details about settings, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printing Preferences] dialog box from that ap-
plication. The following explains how to make settings for the WordPad appli-
cation provided with Windows XP, Windows Server 2003/2003 R2.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
❒ For details about settings, see the printer driver Help.

Making printer default settings - default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the [Printer Properties] dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
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C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ For details about settings, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application. To make printer settings
for a specific application, open the [Printer Properties] dialog box from that appli-
cation. The following explains how to make settings for the WordPad applica-
tion provided with Windows NT 4.0.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name:] list, and then click [Properties].
The [Printer Properties] dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the [Printer Properties] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application’s own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

❒ For details about settings, see the printer driver Help.
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Mac OS - Setting Up for Printing

Making paper settings from an application

A Open the file you want to print.

B On the [File] menu, click [Page Setup].

C Check that the printer you want to use is displayed in [Printer:], and then se-
lect the paper size you want to use in [Paper:].
Under Mac OS X, select the paper size in [Paper Size].
If the printer you want to use is not displayed in [Printer:], select the printer
you want to use.

D Configure the settings, and then click [OK].

Note
❒ The [Page Setup] dialog box varies depending on the application you use.

For details, see the manuals provided with the Mac OS.

Setting up for printing from an application

A Open the file you want to print.

B On the [File] menu, click [Print].

C Check that the printer is selected in the [Printer] list, and then make the
printer settings.

D Configure the settings, and then click [OK].
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Printing a PDF File Directly

You can send PDF files directly to this printer for printing, without having to
open a PDF application.

Important
❒ The function can be used with genuine Adobe PDF files only.
❒ This function supports version 1.3, 1.4, and 1.5 PDF files.
❒ PDF files created using Crypt Filter and/or the 16 bit color image function of

PDF version 1.5 cannot be printed.
❒ PDF version 1.6 (Acrobat 7.0) files created without any functions that are ex-

clusive to PDF version 1.6 can be printed.
❒ Some types of High Compression PDF files may not be printed.

Note
❒ Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - us-
ing DeskTopBinder Lite or by entering commands.
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Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work under certain operating system settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

C Click [DeskTopBinder - SmartDeviceMonitor for Client].
The [DeskTopBinder Lite Setup] dialog box appears.

D Click [DeskTopBinder] , and then click [Yes].

E Follow the instructions on the display to install DeskTopBinder Lite.
If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.

DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files directly.

A On the [Start] menu, point to [Programs], [DeskTopBinder], and then click [Ex-
tended Features Wizard].
The [Extended Features Wizard] dialog box appears.

B Click [Start], and then click [Next>] repeatedly until the [Printing Function2] di-
alog box appears.

C In the [Printing Function2] dialog box, click [Add...].
The [PDF Direct Print Properties] dialog box appears.

D Select the driver for this machine, and then click [OK].
The [PDF Direct Print Properties] dialog box closes.

E Click [Next>] repeatedly until [Finish] appears.

F Click [Finish].
The [Extended Features Wizard] dialog box closes.
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Function Palette

The Function Palette contains buttons for functions that have already been con-
figured using DeskTopBinder Lite enhancement. You can use these buttons, to
point Windows files, preview printouts, convert images, and register scanners
for documents, without having to open DeskTopBinder Lite. To use these func-
tions, simply drag a target file to the button for the required function and drop
it there.

A On the [Start] menu, point to [Programs], [DeskTopBinder], and then click
[Function Palette].
An icon for the Function Palette is added to the task tray displayed at the bot-
tom right of the screen.

B Right-click the new icon that has been added to the task tray, and then click
[Properties...].
The [Properties] dialog box appears.

C Click the [Contents] tab, select the [PDF Direct Print] check box at the center,
and then click [OK].
The [Properties] dialog box closes and the [PDF Direct Print] icon is added to the
Function Palette.

PDF Direct Printing

Use the following method to print PDF files directly.

A Drag the PDF file you want to print to the PDF Direct Printing icon on the
Function Palette and drop it there.
The [Output File List - PDF Direct Print] dialog box appears.

B Highlight the PDF file you want to print, and then click [OK].
The PDF file is printed.
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Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

A On the [Start] menu, point to [Programs], [DeskTopBinder], and the click [Ex-
tended Features Wizard].
The [Extended Features Wizard] dialog box appears.

B Click [Start], and then click [Next>] repeatedly until the [Printing Function2] di-
alog box appears.

C In the [Printing Function2] dialog box, click [Properties].
The [PDF Direct Print Properties] dialog box appears.

D Select the [Use PDF Password] check box at the bottom right of the dialog box,
and then click [OK].
The [PDF Direct Print Properties] dialog box closes.

E Click [Next>] repeatedly until [Finish] appears.

F Click [Finish].
The [Extended Features Wizard] dialog box closes.

G Drag the PDF file you want to print over the PDF Direct Printing icon on
the Function Palette and drop it there.
The [Output File List - PDF Direct Print] dialog box appears.

H Click on the PDF file you want to print, making it appear highlighted, and
then click [OK].
The [PDF Direct Print Properties] dialog box appears.

I In the [PDF password:] box at the bottom right of the dialog box, enter the
password for the PDF file you want to print, and then click [OK].
The password-protected PDF file is printed.

Note
❒ Before printing a password-protected PDF file, you must do one of the fol-

lowing:
• In the [PDF Direct Print Properties] dialog box, enter the password for the

PDF file you want to print.
• Specify a password for the PDF file by selecting [Change PDF Password]

in the [PDF Menu] on the machine's control panel.
❒ If a [PDF Group Password] for the [PDF Menu] has been specified using Desk-

TopBinder Lite or the machine's control panel, the same group password
must be set on the other also.
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PDF Direct Print Properties

1. Setting name:
Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...
Changes the icon displayed on the tool
bar.

3. Printer:
Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex (not selectable on this
printer)
Prints on both sides of sheets.

5. Layout
Prints multiple pages on a single sheet.

6. Punch (not selectable on this
printer)
Punches holes in printed output.

7. Staple (not selectable on this
printer)
Staples printed output together.

8. Display this dialog box before
printing
Appears in PDF direct printing mode if
this check box is selected.

9. Orientation:
Specify the original's orientation.

10. Number of copies
Specify the number of copies to print.

11. Collate
Use to sort prints.

12. Range:
Specifies which paper to print.

13. Printout paper size:
Specify the paper size you want copies to
be printed onto.

14. Color/Black and White: (not se-
lectable on this printer)
Specify color or black-and-white print-
ing.

15. Resolution:
Specify a print resolution.

16. PDF password:
Enter the password for password-pro-
tected PDF files. A password-protected
PDF file cannot be printed unless its pass-
word is entered here.

17. Group password:
If a group password is assigned to Desk-
TopBinder Lite and this machine, enter
the group password in this field. The
group password must be entered for
printing to start.

ATU400S
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Using Commands

Under Windows and UNIX, you can print PDF files directly, using commands
such as “ftp” “sftp” and “lpr”.

Reference
p.291 “Printing Files Directly from Windows”.
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Using the Print Job Function

This describes how to print or delete files stored in the printer. There are follow-
ing types of print files: Sample Print, Locked Print, Hold Print, and Stored Print.
Print files sent from computers can be stored in the hard disk of the printer. Us-
ing the Print Job function, you can print or delete the print files.

Print Job Screen

When the printer is turned on, the following screen appears.

If you press [Prt.Jobs] on the initial screen, a screen prompting to select the type
of print job appears.

After selecting a type, you can select print files in the list by pressing:
• [Job List]

Displays the Job List screen.
• [User ID]

Displays the User ID screen.
If you select Sample Print, Locked Print, and Hold Print, the print files saved in
the printer are deleted after printing is complete. If you select Stored Print, the
files remain in the printer even after printing is finished.
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❖ Job List Screen

1. The type of print jobs
Displays the type of the print job you
select.

2. Page number
Displays the current page number.
Each time pressing the {U} or {T}
key, the screen switches.

3. User ID, Date/Time, and File
Name display

• User ID shows the user’s ID set by
the printer driver.

• Date and Time show the time at
which the print job was stored in
the printer.

• File name shows the name of the
file. However, “****” is shown in-
stead of the file name for a Locked
Print file.

4. [Print]
Prints a selected file.

5. [Change]
Changes or clears the password of a
file if a password is set. To change the
password of a Locked/Stored Print
job, press [Change], enter the current
password, and then enter the new
password on the confirmation screen.
To clear the password, press [Change],
leave the entering/confirming a new
password box blank, and then press
the {OK} key.
You can also set passwords to the
Stored Print files that do not currently
have passwords.

6. [Delete]
Deletes a selected file.

Note
❒ When you press [Change] to change or clear a password, you must first enter

the existing password. If the password you entered is incorrect, you cannot
change or clear any current passwords.

❒ You can use [Change] to set or clear passwords only Stored Print files are
saved in the printer.

AQC501S
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❖ User ID Screen

1. The type of print jobs
Displays the type of the print job you
select.

2. Page number
Displays the current page number.
Each time pressing the {U} or {T}
key, the screen switches.

3. User ID
• User ID shows the ID of the user

who stored the selected type of
files.

• User ID set by the printer driver is
shown.

4. [PrintAll]
Prints all files stored by the user
whose user ID has been selected.

5. [Job List]
Switches the screen to the Job List
screen.
Displays the print jobs of the selected
user only.

Note
❒ To cancel selecting a file, press the {Job Reset} key.
❒ The display is not updated if a new file is stored while the list of stored files

is displayed. To update the display, press the {Menu} key to return to the ini-
tial screen, and then press [Prt.Jobs] again.

❒ If a large number of print jobs are stored in the printer, processing may slow
temporarily, depending on which functions are used.

Reference
For details about printing each type of print job, see the followings:
p.82 “Sample Print”
p.86 “Locked Print”
p.90 “Hold Print”
p.93 “Stored Print”

AQC502S
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Printing from the Print Job Screen

This section gives instruction about Sample Print, Locked Print, Hold Print, and
Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you
have checked the result, remaining sets can be printed or canceled using the print-
er’s control panel. This can reduce misprints due to mistakes in content or settings.

Important
❒ A Sample Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 3,000 pages in total.

Note
❒ If a Sample Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents in the printer remain.

However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings
are applied first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Sample Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application’s [Print] dia-
log box, more prints than intended may be produced.

❒ If the first set of the Sample Print files is not as you expected and you do not
want to print remaining sets, delete the Sample Print file using the display
panel. If you print the remaining sets of the Sample Print file, the job in the
printer is deleted automatically.

❒ Sample Print files printed or deleted using Web Image Monitor, after you se-
lect [Sample Print Jobs] using the control panel will appear on the display pan-
el. However, an error message will appear if you try to print or delete those
Sample Print files.

❒ If stored files have similar and long file names, recognizing the file you want
to print on the display panel may be difficult. Print the file you want to print
either by checking the user ID or the time the file is sent, or by changing the
file name to something that can be recognized easily.

Reference
For details about the error log on the display panel, see p.103 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
see p.125 “HD Management”.
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Printing a Sample Print file

The following procedure describes how to print a Sample Print file with the
RPCS and PostScript 3 printer driver.

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A From an application, select a command to print.
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

C In the [Job type:] box, click [Sample Print].
When printing with the PostScript 3 printer driver, click [Sample Print] in the
[Job Type:] box on the [Job Log] tab.

D Click [Details...], and then enter a User ID in the [User ID:] box.
This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

E Execute a command to print.
Make sure to set more than two copies.
The Sample Print job is sent to the printer, and the first set is printed.

F On the printer's control panel, press [Prt.Jobs].

G Select [Sample Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Sample Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
You can print files also by pressing [User ID].
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H Select the file you want to print using the {U} or {T} key, and then press
[Print].

Enter the new number of sets using the scroll keys. You can enter up to 999
sets.
Press the {Escape} key to correct any entry mistakes.

I Press [Print].
The remaining sets are printed.
Press [Cancel] to cancel printing.

Note
❒ When the number of set quantity is changed, the changed quantity is ap-

plied to all selected files. When printing is completed, the stored file will
be deleted.

❒ To stop printing after printing has started, press the {Job Reset} key. The
file will be deleted.

Reference
For details about [User ID], see p.97 “Printing from the User ID Screen”.
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Deleting Sample Print files

If you are not satisfied with the sample printout, you can delete the Sample Print
file, revise it and print it again until the settings are suitable.

A Press [Prt.Jobs].

B Select [Sample Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Sample Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete using the {U} or {T} key, and then press
[Delete].

The delete confirmation screen will appear.

D Press [Delete].
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Locked Print

Use this function to maintain privacy when printing confidential documents on
the printer over a shared network. Usually, it is possible to print data using the
display panel once it is stored in this printer. When using Locked Print, it is not
possible to print unless a password is entered on the printer’s display panel.
Your confidential documents will be safe from being viewed by other people.

Important
❒ A Locked Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 3,000 pages in total.

Note
❒ If a Locked Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents remain. However, the

[Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied
first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. Locked Print jobs are automatically collated by the printer
driver as default. If a collate option is selected in the application [Print] dialog
box, more sets than intended may be printed.

❒ After the Locked Print file is printed, the job is automatically deleted.
❒ Locked Print files printed or deleted using Web Image Monitor, after you se-

lect [Locked Print Jobs] using the control panel will appear on the display pan-
el. However, an error message will appear if you try to print or delete those
Locked Print files.

Reference
For details about the error log on the display panel, see p.103 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
p.125 “HD Management”.
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Printing a Locked Print file

The following procedure describes how to print a Locked Print file with the
RPCS and PostScript 3 printer driver

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A Configure the Locked Print in the printer driver’s properties.
For details about configuring the printer drivers, see the corresponding Help
files.

B Start printing from the application’s [Print] dialog box.
The Locked Print job is sent to the printer.

C On the printer's control panel, press [Prt.Jobs].

D Select [Locked Print Jobs] using the {U} or {T} key, and then press [Job List.]

A list of Locked Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
You can print files also by pressing [User ID].

E Select the file you want to print using the {U} or {T} key, and then press
[Print].

The password screen appears.
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F Enter the password using the {U}, {T}, {W} or {V} key, and then press the
{OK} key.

The print confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Clear] to enter the password again.
If you forget your password, ask your network administrator for help.

G Press [Print].
The remaining sets are printed.
Press [Cancel] to cancel printing.

Note
❒ When printing is completed, the stored file will be deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.

Reference
For details about [User ID], see p.97 “Printing from the User ID Screen”.
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Deleting Locked Print files

A Press [Prt.Jobs].

B Select [Locked Print Jobs] using the {U}, {T} key, and then press [Job List].

A list of Locked Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete using the {U}, {T} key, and then press
[Delete].

The password screen appears.

D Enter the password using the {U}, {T}, {W} or {V} key, and then press the
{OK} key.

The delete confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Clear] to enter the password again.
If you forget your password, ask your network administrator for help.

E Press [Delete].
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Hold Print

Use this function to temporarily hold a file in the printer, and print it from the
computer or the printer’s control panel later.

Important
❒ A Hold Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 3,000 pages in total.

Note
❒ If a Hold Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents in the printer remain.

However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings
are applied first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Hold Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application’s [Print] dia-
log box, more prints than intended may be produced.

❒ Hold Print files printed or deleted using Web Image Monitor, after you select
[Hold Print Jobs] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those Hold
Print files.

❒ If stored files have similar and long file names, recognizing the file you want
to print on the display panel may be difficult. Print the file you want to print
either by checking the user ID or the time the file is sent, or by changing the
file name to something that can be recognized easily. If you enter the docu-
ment name on the printer driver’s [Details...], that name appears on the display
panel.

❒ It is possible, but not required, to set a file name or a password to a Hold Print
file.

Reference
For details about the error log on the display panel, see p.103 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
p.125 “HD Management”.
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Printing a Hold Print file

The following procedure describes how to print a Hold Print file with the RPCS
printer driver. For information about how to print a Hold Print file with the
PostScript 3 printer driver, see Postscript 3 Supplement.

Note
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A Configure Hold Print in the printer driver's properties.
For details about configuring the printer drivers, see the relevant Help files.

B Click [Details...], and then enter a user ID in the [User ID:] box.
You can also set a file name. The file name you set will be displayed on the
printer’s Job List screen.

C Start printing from the application’s [Print] dialog box.
The Hold Print job is sent to the printer and stored.

D On the printer's control panel, press [Prt.Jobs].

E Select [Hold Print Jobs] using the {U}, {T} key, and then press [Job List].

A list of Hold Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
You can print files also by pressing [User ID].

F Select the file you want to print using the {U}, {T} key, and then press [Print].

The confirmation screen appears.
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G Press [Print].
The Hold Print file is printed.
Press [Cancel] to cancel printing.

Note
❒ When printing is completed, the stored file will be deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.
❒ For details about setting printer drivers, see the printer driver Help. You

can also print or delete a Hold Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.

❒ For details about [User ID], see p.97 “Printing from the User ID Screen”.

Deleting Hold Print files

A Press [Prt.Jobs].

B Select [Hold Print Jobs] using the {U}, {T} key, and then press [Job List].

A list of Hold Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete using the {U}, {T} key, and then press
[Delete].

The confirmation screen appears.

D Press [Delete].
The selected file is deleted.
If you do not want to delete the file, press [Cancel].



Printing from the Print Job Screen

93

3

Stored Print

Use this function to store a file in the printer, and then print it from the computer
or the printer’s control panel later.
Jobs are not deleted after they are printed, so the same job need not be resent in
order to print multiple copies.

Important
❒ A Stored Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 3,000 pages in total.

Note
❒ If a Stored Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents in the printer remain.

However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings
are applied first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Stored Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application’s [Print] dia-
log box, more prints than intended may be produced.

❒ Stored Print files printed or deleted using Web Image Monitor, after you se-
lect [Stored Print Jobs] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those
Stored Print files.

❒ If stored files have similar and long file names, recognizing the file you want
to print on the display panel may be difficult. Print the file you want to print
either by checking the user ID or the time the file is sent, or by changing the
file name to something that can be recognized easily.

❒ If you enter the document name on the printer driver’s [Details...], that name
appears on the display panel.

Reference
For details about the error log on the display panel, see p.103 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
see p.125 “HD Management”.
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Printing a Stored Print file

The following procedure describes how to print a Stored Print file with the RPCS
printer driver. For information about how to print a Stored Print file with the
PostScript 3 printer driver, see Postscript 3 Supplement.

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A Configure the Stored Print in the printer driver's properties.
You can select two ways for Stored Print:
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Normal Print] (or [Store and Print])

Prints the file at once and also stores the file in the printer.
For details about configuring the printer drivers, see the relevant Help files.

B Click [Details...], and then enter a User ID in the [User ID:] box.
You can also set a password. The same password must be entered when print-
ing or deleting.
You can also set a file name. The file name you set will be displayed on the
printer’s Job List screen.

C Start printing from the application's [Print] dialog box.
The Stored Print job is sent to the printer.

D On the printer's control panel, press [Prt.Jobs].

E Select [Stored Print Jobs] using the {U}, {T} key, and then press [Job List].

A list of Stored Print files stored in the printer appears.
You can print files also by pressing [User ID].
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F Select the file you want to print using the {U}, {T} key, and then press
[Print].

The confirmation screen appears.
If you set a password in the printer driver, a password confirmation screen
appears. Enter the password.

G Press [Print].
The Stored Print file is printed.
Press [Cancel] to cancel printing.

Note
❒ When multiple files are selected without setting a quantity, one set less

than the minimum number of all settings is applied. If the least number of
settings is one set, all selected files will be printed at one set.

❒ When the number of set quantity is changed, the changed quantity is ap-
plied to all selected files.

❒ To stop printing after printing has started, press the {Job Reset} key. A
Stored Print file is not deleted even if [JobReset] is pressed.

❒ The Stored Print file that sent to the printer is not deleted unless you delete
a file or select [Auto Delete Stored Jobs].

❒ You can set or delete a password after sending files to the printer. Select
the file and press [Change] in the Print Job List screen. To set a password,
enter the new password. To delete the password, leave the password box
blank on entering or confirming the new password, and press the {OK}
key.

❒ For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Stored Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.

Reference
For details about the [Auto Delete Stored Jobs], see p.125 “HD Management”.
For details about [User ID], see p.97 “Printing from the User ID Screen”.
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Deleting Stored Print files

A Press [Prt.Jobs].

B Select [Stored Print Jobs] using the {U}, {T} key, and then press [Job List].

A list of Stored Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete using the {U}, {T} key, and then press
[Delete].

The delete confirmation screen will appear.
If you set the password in the printer driver, enter the password to delete.
If you forget your password, ask your network administrator for help.

D Press [Delete].
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Printing from the User ID Screen

This describes how to print the files saved in the printer from the User ID screen.

Printing the Selected Print Job

Important
❒ If you print a Sample, Locked, or Hold Print file, the print file saved in the

printer is deleted after printing is complete.

A On the initial screen, press [Prt.Jobs].

B Press [User ID].

A list of user IDs whose files are stored in the printer appears.

C Select the user ID whose file you want to print using the {U}, {T} key, and
then press [Job List].

The print job list of the selected user ID appears.

D Select the file you want to print using the {U}, {T} key, and then press
[Print].

The confirmation screen appears.
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E Press [Print].
The selected file is printed.
Press [Cancel] to cancel printing.

Reference
For details about printing each type of print job, see the followings:
p.82 “Sample Print”
p.86 “Locked Print”
p.90 “Hold Print”
p.93 “Stored Print”

Printing All Print Jobs

A On the initial screen, press [Prt.Jobs].

B Select a type of print jobs you want to print using the {U}, {T} key, and
then press [User ID].

A list of user IDs whose files are stored in the printer appears.

C Select the user ID whose file you want to print using the {U}, {T} key, and
then press [PrintAll].

The confirmation screen appears.

D Press [Print].
The selected files are printed.
To cancel printing, press [Cancel].
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Note
❒ After printing is completed, Sample Print, Locked Print, and Hold Print

files are deleted.
❒ You cannot select a print job that is not stored under the selected user ID.
❒ When printing multiple Sample Print files without specifying the number

of sets on the confirmation screen, one set less than the least number of set
specified on the computer is applied for every selected document. If the
number of sets specified on the computer is “1”, one set each is printed for
every document.

❒ When printing multiple Stored Print files without specifying the number
of sets on the confirmation screen, the least number of set specified on the
computer is applied for every selected document.

❒ If you select [Locked Print Jobs], enter the correct password. If there are mul-
tiple passwords, the printer prints only files that correspond to the entered
password.

❒ If you select Stored Print files, and some of these require a password, the
printer prints files that correspond to the entered password and files that
do not require a password.

Reference
For details about printing each type of print job, see the followings:
p.82 “Sample Print”
p.86 “Locked Print”
p.90 “Hold Print”
p.93 “Stored Print”
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Canceling a Print Job

You can cancel printing from either the printer or a client computer. Since can-
celing procedures vary depending on the print job status, check the job status
and cancel printing according to the following procedure.

Canceling a Print Job Using the Control Panel

A Press the {Job Reset} key.
A confirmation message appears.

B Press [Current].

To resume printing jobs, press [Resume].

C Press [Yes] to cancel the print job.

Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not com-
pleted.

A Double-click the printer icon on the Windows task tray.
A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing].

Note
❒ If the printer is shared by multiple computers, be careful not to accidental-

ly cancel someone else’s print job.
❒ If the printer is connected to the computer using a parallel cable, sent print

jobs may be canceled if [JobReset] is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

❒ In Windows XP, Windows Server 2003/2003 R2, and Windows NT 4.0,
click [Cancel] on the [Document] menu.

❒ In Windows 95/98/Me/2000 or Windows NT 4.0, you can also open the
print job queue window by double-clicking the printer icon in the [Printers]
printer window (the [Printers and Faxes] window under Windows XP and
Windows Server 2003/2003 R2).

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.
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Mac OS - Canceling a Print Job from the computer

A Double-click the printer icon on the desktop.
A window appears showing all print jobs that are currently queuing to be
printed. Check the current status of the job you want to cancel.
Under Mac OS X, start Print Center.

B Select the name of the job you want to cancel.

C Click the pause icon, and then click the trash icon.

Note
❒ If the printer is shared by multiple computers, be careful not to accidental-

ly cancel someone else’s print job.
❒ If the printer is connected to the computer using a parallel cable, sent print

jobs may be canceled if [JobReset] is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

Important
❒ The most recent 30 errors are stored in the error log. If a new error is added

when there are 30 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.
The error is stored separately until the number of those errors reaches 30. You
can check any of these print jobs for error log information.
• Sample Print
• Locked Print
• Hold Print
• Stored Print

❒ If the main power switch is turned off, the log is deleted.

A Press [Option].

B Select [Error Log] using the {U}, {T} key, and then press the {OK} key.

C Select a type of print jobs using the {U}, {T} key, and then press the {OK}
key.
If you select [All], all error logs appears.
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D Select the error log you want to check using the {U}, {T} key.

Note
❒ Press the {Menu} key until the initial screen appears after checking the log.
❒ To print files that appear in the error log, resend them after stored files

have been printed or deleted.



Collate

05

3

1

Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer in the printer's memory or hard disk drive. The fol-
lowing explains the two types of Collate:

Important
❒ Up to 1,000 pages can be sorted.

❖ Collate
Printed output is assembled as sets in sequential order.

❖ Rotating Collate
Every other print set is rotated by 90 degrees.
The Rotating Collate function requires two paper trays containing paper that
is of the same size but set in different orientations.

❖ When Rotate Collate is cancelled
If the following functions are selected, Collate will be applied even if Rotating
Collate is selected:
• If jobs containing pages of various sizes are set.
• If an output tray is specified.
• If custom size paper is set.

AEU017S
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Note
❒ Set Collate and Rotating Collate when using the RPCS printer driver.
❒ If Auto Continue occurs while the first set is being printed, Collate will be

cancelled.
❒ If forced printing occurs while the first set is being printed, Collate will be

cancelled.
❒ When specifying Collate in the printer driver settings, make sure a collate op-

tion is not selected in the application's print settings. If a collate option is se-
lected, printing will not be as intended.

❒ If Rotating Collate is selected, printing is slower than with the other collate
functions.

❒ For details about printing methods, see the printer driver Help.
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Spool Printing

With Spool Printing, the print data is saved in the hard disk before printing. To
use this function, set it from the menu. See p.217 “Remote Maintenance by tel-
net”.

Important
❒ Use the “spoolsw clear job” telnet command to clear a spooled print job. Do

not turn off the printer or computer while a print job is being spooled and the
Data In is flashing. Print jobs that are interrupted in this way remain on the
printer’s hard disk and will finish printing out when the printer is turned
back on.

❒ The Spool Printing function is available for data received using diprint, lpr,
ipp, ftp, and sftp (TCP/IP (IPv6)).

❒ When using diprint, the Spool Printing function cannot be used with bidirec-
tional communication.

❒ The domain reserved for spool printing is about 1 GB.
❒ When Spool Printing is on, the size of a single print job cannot exceed 500 MB.
❒ When receiving jobs from multiple computers, the printer can spool a maxi-

mum of ten lpr jobs, and only one diprint, ipp, ftp, sftp, or smb job. If the
printer’s spooling capacity is exceeded, newer jobs cannot be printed. You
must wait before sending further jobs.

Note
❒ Printing the first page with Spool Printing will be slow.
❒ The computer requires less print processing time when large amounts of data

are spooled.
❒ Stored spool jobs can be viewed or deleted using Web Image Monitor.
❒ The list of spool jobs cannot be viewed from the printer’s control panel.

Reference
For information about the “spoolsw clear job” command on the telnet, see
p.217 “Remote Maintenance by telnet”.
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Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.
• Using Web Image Monitor

In [System] on the [Configuration] menu, click [Active] in [Spool Printing].
• Using telnet

Enter “spoolsw spool on”.

Note
❒ For details about Web Image Monitor, see Web Image Monitor Help.

Reference
For details about “spoolsw spool on”, see p.217 “Remote Maintenance by tel-
net”.

Viewing or Deleting Spooled Jobs Using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image
Monitor.

A Open a Web browser.

B Enter “http://(printer's address)/” in the address bar to access the printer
whose settings you want to change.
Top Page of Web Image Monitor appears.

C Click [Login].
The window for entering the login user name and password appears.

D Enter the login user name and password, and then click [Login].
Contact your administrator for information about the settings.

E In the menu area, click [Job].
A submenu will appear.

F On the [Printer] menu, click [Spool Printing].
A list of spooled jobs appears.

G To delete a job, select the check box of the job you want to delete, and then
click [Delete].
The selected job is deleted.

H Click [Logout].

I Quit Web Image Monitor.

Note
❒ For details, see Web Image Monitor Help.
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Printing with the Folding Finisher

You can fold printed paper by installing the optional folding finisher. Be sure to
observe the following precautions when using the optional folding finisher.

Important
❒ Make option settings for the machine using the printer driver when bidirec-

tional communication is disabled.
❒ Be sure to set the paper size and paper orientation in the printer driver when

using combined printing (layout).
❒ If you are feeding paper from the bypass tray, you cannot use the folding fin-

isher function.

❖ Connecting to the optional folding finisher unit
You cannot use the optional folding finisher unit under the following condi-
tions or settings:
• The optional folding finisher unit is not attached to this machine.
• The bypass tray is selected for the feeding tray.
• The paper size and orientation is not properly set.
• [Translucent] and [Film] is selected for the paper type.
• The Folding Finisher Tray is not selected as the paper output tray.
• The [Normal Print] is not selected as the printing method.

Note
❒ Depending on the application, print settings may not be enabled and printed

output may not be as expected.
❒ When setting Collate in the printer driver, make sure that the Collate check

box is cleared in the application's [Print] dialog box. If Collate is enabled in the
application, printing will not be as intended.

❒ When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.
• If the paper jam occurred in the optional finisher, printing will restart from

the top page of the data currently being printed, or from the page where
the paper jam occurred.

• If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

• Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

Reference
p.53 “If Bidirectional Communication is Disabled”
“Removing Misfed Paper”, Hardware Guide
The printer driver Help
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Fold Types

This section explains fold types to take when using the folding finisher.
You can select [Fan Fold] and [Do not fold] on. Types of fold are as follows:

❖ Fan Fold
Alternating folds are applied horizontally relative to the paper direction.
You can select one of the following widths for the fold: 140, 170, 210, or 297
mm (81/2, 9, 11, or 12 inches).

: Fold width
When [Fan Fold with Margin] is selected, paper is folded so as to have a binding
margin. You can specify the following widths for the margin: 35 to 40 mm
(1.38 to 1.58 inch).

: Margin

❖ No Fold (Straight output)
No folding is applied to sheets that are output from the Folding Finisher Tray.

ATW006S
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Folding Finisher Cautions

This section explains about the fold precautions.

❖ Folding type and orientation

❖ When the folding is cancelled
• When the output is from the bypass tray
• When the folding type and orientation is not properly set.
• When a paper type that cannot be folded is selected.
• When the Folding Finisher Tray is not selected for the paper output tray.
• When [Normal Print] is not selected for the printing method.
• When less than 320 mm is specified for the length of the fan fold paper.

Note
❒ If the optional folding finisher is connected but the fold settings are incorrect,

you might not be able to make settings for the optional device using the printer
driver.

❒ Printing starts only after jobs from other functions (such as the copier) that are
using the folding finisher have finished.

❒ Depending on the application you are using, printer settings might not be
applied and printing might not be as required.

Fold Type Paper Size

Fan Fold A0K, B1K, A1KL, B2KL, A2KL, B3KL, A3K, B4K, 36” × 
48”K, 34” × 44”K, 30” × 42”K, 24” × 36”KL, 22” × 34”KL, 21” × 
30”L, 18” × 24”KL, 17” × 22”KL, 12” × 18”K, 11” × 17”K, 81/2” 
× 14”K, 81/2” × 13”K

Custom Size:

• Less than 594 mm (23.4”) in width, and between 320 to 2000 mm 
(12.6” to 78.8”) in length.
The number of folded surfaces cannot exceed 10 (i.e., 9 folds).

• Greater than 594 mm (23.4”) and less than 841 mm (33.2”) in 
width, and between 320 to 3600 mm (12.6” to 141.8”) in length.
The number of folded surfaces cannot exceed 30 (i.e., 29 folds).

• Greater than 841 mm (33.2”) in width, and between 320 to 6000 
mm (12.6” to 236.3”) in length.
The number of folded surfaces cannot exceed 30 (i.e., 29 folds).

Not Fold A0K, B1K, A1KL, B2KL, A2KL, B3KL, A3KL, B4KL, 
A4K, 36” × 48”K, 34” × 44”K, 30” × 42”K, 24” × 36”KL, 22” × 
34”KL, 21” × 30”L, 18” × 24”KL, 17” × 22”KL, 12” × 18”KL, 
11” × 17”KL, 9” × 12”K, 81/2” × 14”K, 81/2” × 13”K, 81/2” × 11”K

Custom Size: between 210 to 914.4 mm (8.27” to 36”) in width, and 
between 257 to 15000 mm (10.2” to 590.6”) in length.
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4. Making Printer Settings
Using the Control Panel
13
1

Menu Chart

This section explains how to change the default settings of the printer and pro-
vides information about the parameters included in each menu.

❖ Counter
Displays the amount of paper remaining on the paper roll.

❖ Memory Erase Status
Displays data status inside the memory.

Note
❒ This menu can be selected only when the optional security card is installed.

❖ Paper Input

❖ Maintenance

Menu

Paper Size:Bypass

Paper Size:Tray 1

Paper Size:Tray 2

Paper Size:Tray 3

Paper Type:Bypass Tray

Paper Type:Tray 1

Paper Type:Tray 2

Paper Type:Tray 3

Auto Tray Select

Tray Priority

Menu

General Settings

Timer Settings

HD Management
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❖ List/Test Print

❖ System

❖ Print Settings

Menu

Multiple Lists

Config. Page

Error Log

Network Summary

Menu List

PS Config./Font Page

PDF Config./Font Page

Hex Dump

Menu

Print Error Report

Auto Continue

Memory Overflow

Printer Language

Sub Paper Size

Default Printer Lang.

Energy Saver 1

Energy Saver 2

Memory Usage

Spool Printing

Auto Email Notify

Menu

Machine Modes

PS Menu

PDF Menu
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❖ Security Options

Note
❒ [Service Mode Lock] may not appear depending on the setting of the printer.
❒ [Auto Erase Memory Setting] and [Erase All Memory] appear when the optional

security card is installed.

❖ Host Interface

Note
❒ [IEEE 802.11b] appears when the optional IEEE 802.11b interface unit is in-

stalled.

❖ Language

Menu

Extend Auth. Management

Extended Security

Service Mode Lock

Firmware Version

Network Security Level

Auto Erase Memory Setting

Erase All Memory

Transfer Log Setting

Menu

I/O Buffer

I/O Timeout

Network

IEEE 802.11b

USB Settings

Menu

English
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Paper Input Menu

This section explains about paper settings on the Paper Input menu such as pa-
per sizes and types on each tray.

Changing the Paper Input Menu

Automatic tray selection

Follow the procedure below to change the automatic tray selection setting.

A Press the {Menu} key.

B Press the {U} or {T} key to select [Paper Input], and then press the {OK} key.

C Press the {U} or {T} key to select [Auto Tray Select], and then press the {OK}
key.

D Press the {U} or {T} key to select the tray you want to use, and then press
the {OK} key.

E Press the {U} or {T} key to select [On], and then press the {OK} key.
Wait for one second. The Auto Tray Select screen appears.

F Press the {Menu} key.
The initial screen appears.

BAL051S
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Tray Priority

Follow the procedure below to change the tray priority.

A Press the {Menu} key.

B Press the {U} or {T} key to select [Paper Input], and then press the {OK} key.

C Press the {U} or {T} key to select [Tray Priority], and then press the {OK} key.

D Press the {U} or {T} key to select a tray you want to use, and then press the
{OK} key.
Wait for one second. The Paper Input screen appears.

E Press the {Menu} key.
The initial screen appears.

BAL051S
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Paper Input Menu Parameters

This section explains about parameters that can be set on the Paper Input menu.

❖ Paper Size:Bypass
You can specify the paper size for bypass tray.

A0K, A1KL, A2KL, A3KL, A4K, B1 JISK, B2 JISKL, B3 JISKL, B4
JISKL, 36 × 48K, 34 × 44K, 30 × 42K, 24 × 36KL, 22 × 34KL, 18 × 24KL,
17 × 22KL, 12 × 18KL, 11 × 17KL, 9 × 12K, 81/2 × 14K, 81/2 × 11K, Cus-
tom Size

36 × 48K, 34 × 44K, 30 × 42K, 24 × 36KL, 22 × 34KL, 18 × 24KL, 17 ×
22KL, 12 × 18KL, 11 × 17KL, 9 × 12K, 81/2 × 14K, 81/2 × 11K, A0K,
A1KL, A2KL, A3KL, A4K, B1 JISK, B2 JISKL, B3 JISKL, B4 JISKL,
Custom Size

Note
❒  Default: A4K
❒  Default: 81/2 × 11K

❖ Paper Size:Tray 1, Paper Size:Tray 2
Specify the paper roll width for Tray 1 and 2.

841 mm, 594 mm, 420 mm, 297 mm, 210 mm, 728 mm, 515 mm, 364 mm, 257
mm, 880 mm, 800 mm, 707 mm, 680 mm, 660 mm, 625 mm, 620 mm, 490 mm,
440 mm, 34 inch, 22 inch, 17 inch, 11 inch, 8.5 inch, 36 inch, 24 inch, 18 inch,
12 inch, 9 inch, 30 inch

34 inch, 22 inch, 17 inch, 11 inch, 8.5 inch, 36 inch, 24 inch, 18 inch, 12 inch, 9
inch, 30 inch, 841 mm, 594 mm, 420 mm, 297 mm, 210 mm, 728 mm, 515 mm,
364 mm, 257 mm, 880 mm, 800 mm, 707 mm, 680 mm, 660 mm, 625 mm, 620
mm, 490 mm, 440 mm

Note
❒  Default: 841 mm (Tray 1), 420 mm (Tray 2)
❒  Default: 36 inch (Tray 1), 18 inch (Tray 2)
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❖ Paper Size:Tray 3
You can specify the paper size for Tray 3.

A3K, A4K, B4JISK, 12 × 18K, 11 × 17K, 81/2 × 14K, 81/2 × 13K, 81/2 × 11K

12 × 18K, 11 × 17K, 81/2 × 14K, 81/2 × 13K, 81/2 × 11K, A3K, A4K, B4JISK

Note
❒  Default: A4K
❒  Default: 12 × 18K
❒ This menu appears when the optional cut paper tray is installed.

❖ Paper Type:Bypass Tray
No Display (Plain Paper), Recycled Paper, Translucent Paper, Film

Note
❒ Default : No Display (Plain Paper)
❒ For details about the types of paper that can be loaded in the bypass tray,

see Hardware Guide.
❒ Be sure to set a paper type using the control panel. If you do not set it, the

printing result might not be proper.

❖ Paper Type:Tray 1, Paper Type:Tray 2
No Display (Plain Paper), Recycled Paper, Translucent Paper, Film

Note
❒ Default : No Display (Plain Paper)
❒ For details about the types of paper that can be loaded in each tray, see

Hardware Guide.
❒ Be sure to set a paper type using the control panel. If you do not set it, the

printing result might not be proper.

❖ Paper Type:Tray 3
No Display (Plain Paper), Recycled Paper

Note
❒ Default: No Display (Plain Paper)
❒ For details about the types of paper that can be loaded in the bypass tray,

see Hardware Guide.
❒ Be sure to set a paper type using the control panel. If you do not set it, the

printing result might not be proper.
❒ This menu appears when the optional cut paper tray is installed.
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❖ Auto Tray Select
You can select whether to assign each tray to automatically print the paper
size and type set by printer driver.

Note
❒ Default : On
❒ When using custom size paper, if automatic tray selection is enabled, the

size selected on the control panel has priority. If this setting is disabled, the
size selected from the printer driver has priority.

❒ Only installed trays appear on the display panel.
❒ You can select multiple trays.
❒ If you need to have a tray locked, you must select the tray using both printer

driver and control panel.

❖ Tray Priority
You can set a tray to be checked first when automatic tray selection is enabled
from the printer driver. The tray selected here is used when no tray is selected
for a print job.

Note
❒ Default : Tray 1
❒ Only installed trays appear on the display panel.
❒ It is recommended that you load paper of the size and orientation you use

most frequently in the tray selected in this setting.

Note
❒ JIS stands for “Japanese Industrial Standard”.
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Maintenance Menu

You can set printing conditions such as density and calibration, and printer
management such as deleting temporary print jobs from the hard disk.

Changing the Maintenance Menu

This section explains changing the Maintenance menu using examples.

Automatic deletion of temporary jobs in the hard disk

Follow the procedure below to set automatic deletion of temporary jobs stored
in the hard disk.

A Press the {Menu} key.

B Press the {T} or {U} key to select [Maintenance], and then press the {OK} key.

C Press the {T} or {U} key to select [HD Management], and then press the {OK}
key.

D Press the {T} or {U} key to select [Auto Delete Temporary Jobs], and then press
the {OK} key.

E Press the {T} or {U} key to select [On], and then press the {OK} key.

F Press the {T} or {U} key to set automatic deletion timer in hours between
1 through 200.

G Press the {OK} key.
Wait for one second. The hard disk management screen appears.

H Press the {Menu} key.
The initial screen appears.

BAL051S
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Maintenance Menu Parameters

This section explains about parameters that can be set on the Maintenance menu.

General Settings

❖ Paper Thickness:Paper Tray, Paper Thickness:Bypass
You can use this setting to specify one of five paper thicknesses for plain pa-
per, recycled paper, translucent paper, and film.

Note
❒ Default: level 3 (medium)

❖ Menu Protect
You can select whether or not to protect menu. When you enable this setting,
specify protection level.
• Level 1
• Level 2
• Off

Note
❒ Default: Level 2
❒ If you would like to lower the protection level, disable this setting or select

Level 1.
❒ You may not be able to change this setting depending on the setting of the

printer.

❖ List/Test Print Lock
You can select whether or not to prohibit List/Test printing.
• On
• Off

Note
❒ Default: Off
❒ You may not be able to change this setting depending on the setting of the

printer.



Maintenance Menu

23

4

1

❖ Unit of Measure
You can select whether to use “mm” or “inch” when specifying the size of
custom sized paper.
• mm
• inch

Note
❒  Default: mm
❒  Default: inch

❖ Panel Key Sound
You can select whether or not to sound the beeper when the control panel is
pressed.
• On
• Off

Note
❒ Default: On

❖ Warm-up Beeper
You can select whether or not to sound the beeper when the printer has com-
pleted a warm-up process.
• On
• Off

Note
❒ Default: On

❖ Display Contrast
You can specify the density of the display.

❖ Key Repeat
You can specify whether or not to scroll the display panel when the {U} or
{T} key is held down. When you enable this setting, specify the scroll speed.
(If repeat time is set to “Long”, scroll speed becomes slow.)
• Do not Repeat
• Normal
• Repeat Time: Medium
• Repeat Time: Long

Note
❒ Default: Normal
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❖ Fine Ratio Adjustment
When using the folding finisher, you can use this setting to specify a paper
type and fine ratio.
• -1.0 to +1.0 %

Note
❒ Default: 0.0 %

❖ Fold Width Fine Adjustment
When the folding function is enabled, you can use this setting to specify the
folding width when the folding function is enabled.
• -6.0 to +6.0 mm (-0.24 to +0.24 inch)

Note
❒ Default: 0.0 mm
❒ This menu is available only when the optional folding finisher is installed.

❖ Margin Fold Margin Adjust.
When the folding function is available, you can use this setting to adjust the
margin fold offset value.
• 35 to 40 mm (1.38 to 1.58 inch)

Note
❒ Default: 40 mm (1.58 inch)
❒ This menu is available only when the optional folding finisher is installed.

Timer Settings

❖ Auto Reset Timer
Specify whether or not to cancel settings made if no operation has been per-
formed for a certain period of time while changing configuration using the
control panel. When set to on, specify how long the printer is to wait before
resetting configuration.
• On
• Off

Note
❒ Default: On

❖ Set Date
You can set the date of the printer’s internal clock using the {U} or {T} key.

❖ Set Time
You can set the time of the printer’s internal clock using the {U} or {T} key.
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HD Management

Specify the settings related to deletion of data saved on the hard disk.

❖ Delete All Temporary Jobs
Use this function to delete all temporary documents saved on the hard disk
(Sample Print, Locked Print and Hold Print data) at once.

❖ Delete All Stored Jobs
Use this function to delete all Stored Print data saved on the hard disk at once.

❖ Auto Delete Temporary Jobs
Specify whether or not to automatically delete temporary documents saved
on the hard disk (Sample Print, Locked Print and Hold Print data). When set
to on, specify how long the printer is to wait before deleting the documents.
• On
• Off

Note
❒ Default: Off
❒ If you enable this setting, specify the timer in hours. (Default: 8 hours)

❖ Auto Delete Stored Jobs
Specify whether or not to automatically delete Stored Print data saved on the
hard disk. When set to on, specify how long the printer is to wait before de-
leting the documents.
• On
• Off

Note
❒ Default: On
❒ If you enable this setting, specify the timer in days. (Default: 3 days)
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List/Test Print Menu

You can print lists showing configurations on printer or the paper printings.
Also, you can check the types and characters of all the printable fonts.

Printing a Configuration Page

Follow the procedure below to print the configuration page.

Important
❒ The configuration page is printed on A4 or Letter (81/2”×11”) size paper, so

load them in the same paper tray.

A Press the {Menu} key.

B Press the {T} or {U} key to select [List/Test Print], and then press the {OK}
key.

C Press the {T} or {U} key to select [Config. Page], and then press the {OK} key.
After the configuration page is printed out, the screen returns to List/Test
Print menu.

D Press the {Menu} key.
The initial screen appears.

BAL051S



List/Test Print Menu

27

4

1

Interpreting the Configuration Page

❖ System Reference

❖ Unit Number
Shows the serial number assigned to the board by its manufacturer.

❖ Total Memory
The total amount of SDRAM installed on the printer is displayed.

❖ Total Counter
The total number of pages printed by the printer to date is displayed.

❖ Firmware Version
• Printer

Shows the version number of the printer controller firmware.
• Engine

Shows the version number of the printer engine firmware.
• NIB

Shows the version number of the network interface board.

❖ Device Connection
Shows the names of device options installed in the printer.

❖ HDD: Font / Macro Download
Shows the hard disk status

❖ Printer Language
Shows the version number of the printer language.

❖ Connection Equipment
Shows the options attached to the printer.

❖ Paper Input
Shows the current Paper Input settings.

Reference
For details, see p.116 “Paper Input Menu”.

❖ Maintenance
Shows the current Maintenance settings.

Reference
For details, see p.121 “Maintenance Menu”.
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❖ System
Shows the current System settings.

Reference
For details, see p.130 “System Menu”.

❖ Machine Modes
Shows the current Machine Modes settings.

Reference
For details, see p.134 “Print Settings Menu”.

❖ PS Menu
Shows the current PS settings.

Reference
For details, see p.134 “Print Settings Menu”.

❖ PDF Menu
Shows the current PDF settings.

Reference
For details, see p.134 “Print Settings Menu”.

❖ Host Interface
Shows the current Host Interface settings.
When DHCP is active on the network, the IPv4 address, subnet mask and
gateway address appear in parentheses.

Reference
For details, see p.143 “Host Interface Menu”.

❖ Interface Information
Interface information is displayed.
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List/Test Print Menu Parameters

This section explains about parameters that can be set on the List/Test Print
menu.

❖ Multiple Lists
You can print the configuration page and error log, network summary and
supply list.

❖ Config. Page
You can print the current configuration of the printer.

❖ Error Log
You can print an error report.

❖ Network Summary
You can print the network device status.

❖ Menu List
You can print a menu list showing all available menus.

❖ PS Config./Font Page
You can print the current configuration and installed PostScript font list.

❖ PDF Config./Font Page
You can print the current configuration and installed PDF font list.

❖ Hex Dump
You can print the data sent by the computer using Hex Dump.
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System Menu

The System menu allows you to set the printer’s basic functions. Although you
can operate the printer using the default settings, you can also change its settings
to better suit your printing needs. Changes made to settings remain effective af-
ter power off.

Changing the System Menu

Follow the procedure below to change the settings for Energy Saver Timer.

A Press the {Menu} key.

B Press the {U} or {T} key to select [System], and then press the {OK} key.

C Press the {U} or {T} key to select [Energy Saver 2], and then press the {OK}
key.

D Press the {U} or {T} key to select [Energy Saver Timer], and then enter the
{OK} key.

E Press the {U} or {T} key to select the lead time needed to switch to the En-
ergy Saver mode.

F Press the {OK} key.
Wait for one second. The Energy Saver 2 screen appears.

G Press the {Menu} key.
The initial screen appears.
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System Menu Parameters

This section explains about parameters that can be set on the System menu.

❖ Print Error Report
Select whether or not to print an error report when a printer error or memory
error occurs.
• On
• Off

Note
❒ Default: Off

❖ Auto Continue
Specify whether or not to continue printing after a system error. When you
enable this setting, specify how long the printer is to display error before re-
suming print.
• Off
• Immediate
• 1 minute
• 5 minutes
• 10 minutes
• 15 minutes

Note
❒ Default: Off
❒ When this setting is set to on, and a certain error occurs in the printer while

printing out, the job might be cancelled. When a job is cancelled due to er-
ror, the printer automatically begins the next job in the queue.

❖ Memory Overflow
You can specify whether or not to print a memory overflow error report.
• Do not Print
• Error Information

Note
❒ Default: Do not Print
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❖ Printer Language
You can specify the printer language.
• Auto
• PS
• PDF

Note
❒ Default: Auto

❖ Sub Paper Size
Specify whether or not to use paper of the alternate size automatically, if pa-
per of the specified size is not loaded. When this setting is set to off, the print-
er uses paper of any size loaded in the specified tray.
• Auto
• Off

Note
❒ Default: Off

❖ Default Printer Lang.
Select the printer language to use when the printer fails to detect the printer
language.
• PS
• PDF

Note
❒ Default: PS

❖ Energy Saver 1
Select whether or not to switch to Energy Saver 1 mode.
• On
• Off

Note
❒ Default: Off
❒ When set to on, the printer switches to Energy Saver 1 mode after printing

is complete. Electric power consumption is greater than in Energy Saver 2
mode, but the printer returns to Ready mode after a while.
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❖ Energy Saver 2
In Energy Saver mode, electric power consumption is reduced.

❖ Energy Saver Timer
Specify the lead time needed to switch to Energy Saver mode.
• 1 minute
• 5 minutes
• 15 minutes
• 30 minutes
• 45 minutes
• 60 minutes

Note
❒ Default: 15 minutes

❖ Memory Usage
Select memory to be used from Font Priority or Frame Priority.
• Font Priority
• Frame Priority

Note
❒ Default : Font Priority

❖ Spool Printing
Specify whether or not to complete spooling before starting to print.
• On
• Off

Note
❒ Default: Off
❒ Spooling stores a sent print job temporarily in the printer, and then prints

it.

❖ Auto Email Notify
Specify whether or not to send an error message to a preset e-mail address
when an error occurs in the printer.
• On
• Off

Important
❒ After changing the setting, turn off the power of the printer briefly, and

then turn it on again.

Note
❒ Default: On
❒ For information, see Web Image Monitor Help.



Making Printer Settings Using the Control Panel

134

4

Print Settings Menu

You can set conditions for printing.

Changing the Print Settings Menu

Follow the procedure below to change the Bypass Tray Priority.

A Press the {Menu} key.

B Press the {U} or {T} key to select [Print Settings], and then press the {OK}
key.

C Press the {U} or {T} key to select [Machine Modes], and then press the {OK}
key.

D Press the {U} or {T} key to select [Bypass Tray Priority], and then enter the
{OK} key.

E Press the {U} or {T} key to select the desired setting item, and then press
the {OK} key.
Wait for one second. The Machine Modes screen appears.

F Press the {Menu} key.
The initial screen appears.
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Print Settings Menu Parameters

This section explains about parameters that can be set on the Print Settings
menu.

❖ Machine Modes

❖ Copies
Specify the number of copies to print.
If the number of copies to print is specified by command or the printer
driver, this setting is overridden.
• 1 to 999

❖ Edge to Edge Print
Select to whether or not to print using the whole area of paper, leaving no
edge borders.
• On
• Off

Note
❒ Default: Off

❖ Output Tray
Specify output tray to be used when the output tray is not specified in the
print data.
• Upper Paper Exit
• Lower Paper Exit

Note
❒ Default: Upper Paper Exit

❖ Rotate by 180 Degrees
Select whether or not to rotate image by 180 degrees when printing.
• On
• Off

Note
❒ Default : Off

❖ Blank Page Print
Select whether or not to print blank pages.
• On
• Off

Note
❒ Default: On
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❖ Bypass Tray Priority
When paper size/type setting does not match between the printer driver
and the printer, you can select which setting is used.
• Driver/Command
• Machine Settings

Note
❒ Default: Driver/Command

❖ Tray Switching
Select whether or not to automatically switch to a suitable tray, when the
setting of the current tray does not match the paper size/type specified by
the printer driver.
• On
• Off

Note
❒ Default: Off

❖ Collate Type
You can select the Collate Type that is automatically applied when the Col-
late function is enabled
• Collate
• Rotating Collate

Note
❒ Default: Collate
❒ If you want to using this function, contact your service representative.

❖ PS Menu
You can set conditions when using PostScript for printing.

❖ Data Format
Select the data format from Binary Data or TBCP.
This setting is effective when using a parallel, USB, or EtherTalk connec-
tion.
When using a parallel or USB connection, the print job is canceled if binary
data is sent from the printer driver.
When using an Ethernet connection, the print job is canceled if:
• The printer driver data format is TBCP and the data format selected us-

ing the control panel is Binary Data.
• The printer driver data format is binary and the data format selected us-

ing the control panel is TBCP.

Note
❒ Default: TBCP
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❖ Resolution
Select the resolution.
• 300 dpi
• 600 dpi

Note
❒ Default: 600 dpi

❖ PDF Menu
You can set conditions when using PDF for printing.

❖ Change PDF Password
Specify the password for the PDF file executing PDF Direct Print.

Important
❒ If you do not set a PDF password, this menu does not appear.
❒ The password can be set using Web Image Monitor, but must be sent

through the network. For increased security, use this menu on the con-
trol panel to set the password directly.

❖ PDF Group Password
Specify a group password specified using DeskTopBinder Lite.

Important
❒ If you do not set a PDF group password, this menu does not appear.
❒ When you use a group password, the optional data protection unit must

be installed.
❒ The password can be set using Web Image Monitor, but must be sent

through the network. For increased security, use this menu on the con-
trol panel to set the password directly.

❒ Default: no password set

❖ Resolution
Specify the resolution for the PDF file executing PDF Direct Print.
• 300 dpi
• 600 dpi

Note
❒ Default: 600 dpi
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Security Options Menu

You can specify security settings. Depending on the security settings, certain
items may not be displayed.

Changing the Security Options Menu

Follow the procedure below to erase data inside memory.

Important
❒ This setting appears only when the optional security card is installed.

A Press the {Menu} key.

B Press the {U} or {T} key to select [Security Options], and then press the {OK}
key.

C Press the {U} or {T} key to select [Erase All Memory], and then enter the {OK}
key.

D Press the {U} or {T} key to select the erase method, and then press the {OK}
key.
When you select [Random Numbers], enter overwrite times.
All memories will be erased.

EWhen the confirmation screen appears, press [Exit] key.

F Turn off the power of the printer.
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Security Options Menu Parameters

This section explains about parameters that can be set on the Security Options
menu.

❖ Extend Auth. Management
This menu is available only when the optional authentification module is in-
stalled. You can use it to select whether or not to apply Extended Authoriza-
tion Management.
• On
• Off

Note
❒ Default: Off

❖ Extended Security
Depending on the setting of the printer, some of the settings listed below may
not appear.

❖ Driver Encryption Key
Specify the driver encryption key.

❖ Encrypt Address Book
Select whether or not to encrypt the printer’s address book data.
• On
• Off

Note
❒ Default: Off

❖ Restrict User Info.Display
Select whether or not to display user information as “********” when checking
job information without being authenticated through user authentication.
• On
• Off

Note
❒ Default: Off

❖ Enhance File Protection
Select whether or not to automatically lock password-protected print files
if an invalid password is entered ten times. When a file is locked, you can-
not select them even if the correct password is entered.
• On
• Off

Note
❒ Default: Off
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❖ Settings by SNMPv1 and v2
Select whether or not to prohibit changes to the printer settings through ac-
cess using SNMPv1, v2 protocol.
• Prohibit
• Do not prohibit

Note
❒ Default: Do not prohibit

❖ Simple Encryption
Select whether or not to use simple, or restricted, encryption when en-
hanced encryption cannot be used.
• Restrict
• Do not Restrict

Note
❒ Default: Do not Restrict

❖ Authenticate Current Job
Select whether or not authentication is required for operations such as can-
celing jobs. If set to Login Privilege, only authorized users or machine ad-
ministrator can operate the printer. If set to Access Privilege, users who
sent a print job or the machine administrator can operate the printer.
• Login Privilege
• Access Privilege
• Off

Note
❒ Default: Off

❖ Password Policy
Specify the format of passwords: types of characters to be used and mini-
mum length.
Valid characters for passwords are upper-case letters, lower-case letters,
decimal numbers, and symbols such as #. If complexity is set to Level 1, pass-
words must use two types of these characters; if set to Level 2, three types.
• Complexity Setting

Level 1, Level 2, Do not Restrict

Note
❒ Default: Do not Restrict

• Minimum Character No.
Between 0 to 32

Note
❒ Default: 0
❒ If set to 0, minimum length is not specified.
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❖ @Remote Service
Select whether or not to prohibit @Remote service.
• Prohibit
• Do not prohibit

Note
❒ Default: Do not prohibit
❒ If you would like to set to Prohibit, contact your service representative.

❖ Service Mode Lock
Select whether or not to prohibit entering Service mode.
• On
• Off

Note
❒ Default: Off
❒ This setting may not appear depending on the setting of the printer.

❖ Firmware Version
Displays the firmware version of the printer.

❖ Network Security Level
Specify the network security level.
• Level 0
• Level 1
• Level 2

Note
❒ Default: Level 0

❖ Auto Erase Memory Setting
Select whether or not to automatically delete memory. When set to on, select
the deletion method. If the deletion method is Random Numbers, also specify
the overwrite times.
• On

HD Erase Method: NSA, DoD, Random Numbers
No. of Overwrites: Between 1 to 9

• Off

Note
❒ Default: Off
❒ This setting appears only when the optional security card is installed.
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❖ Erase All Memory
Select to delete all data inside the memory. When deleting memory, select the
deletion method. If the deletion method is Random Numbers, also specify the
overwrite times.
• HD Erase Method

NSA, DoD, Random Numbers
• No. of Overwrites

Between 1 to 9

Note
❒ This setting appears only when the optional security card is installed.

❖ Transfer Log Setting
You can select whether or not to send log information to the log collection
server.
• On (Only available from the log collection server.)
• Off

Note
❒ Default: Off
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Host Interface Menu

You can set configurations about network connections and communication
when using parallel connection between the printer and the computer. The
changed configuration holds even if the printer is turned off.

Changing the Host Interface Menu

Follow the procedure below to change the I/O Timeout setting.

A Press the {Menu} key.

B Press the {T} or {U} key to select [Host Interface], and then press the {OK} key.

C Press the {T} or {U} key to select [I/O Timeout], and then press the {OK} key.

D Press the {T} or {U} key to select the lead time needed to end a printing
operation, and then press the {OK} key.
Wait for one second. The Host Interface menu appears.

E Press the {Menu} key.
The initial screen appears.
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Host Interface Menu Parameters

This section explains parameters that can be set on the Host Interface menu.

❖ I/O Buffer
Select the size of I/O Buffer. Normally it is not necessary to change this set-
ting.
• 128 KB
• 256 KB

Note
❒ Default: 128 KB

❖ I/O Timeout
Specify how many seconds the printer should wait before ending a print job.
If printing operation is frequently interrupted by data from other ports, you
can increase the timeout period.
• 10 seconds
• 15 seconds
• 20 seconds
• 25 seconds
• 60 seconds

Note
❒ Default: 15 seconds

❖ Network
You can make network-related settings.

Note
❒ This menu appears only when the optional IEEE 802.11b interface unit is

installed.
❒ For details, see Hardware Guide.
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❖ Machine IPv4 Address
Select whether to set the IPv4 address automatically or manually.
• Auto-Obtain (DHCP)/Specify (Default: Auto-Obtain (DHCP))

When DHCP is set to on, the IPv4 address, subnet mask address, and
gateway address cannot be changed. To change them, set DHCP to off.
Contact your administrator for information about the network configu-
ration.

• IP Add.
Manually specify the IPv4 address.

Note
❒ Default: 011.022.033.044

• Subnet M
Manually specify the subnet mask.

Note
❒ Default: 0.0.0.0

• Gateway
Manually specify the gateway address.

Note
❒ Default: 0.0.0.0

❖ IPv6 Stateless Setting
Select whether to enable or disable IPv6.
• Active
• Inactive

Note
❒ Default: Active

❖ NW Frame Type
Specify the frame type for NetWare.
• Auto Select
• Ethernet II
• Ethernet 802.2
• Ethernet 802.3
• Ethernet SNAP

Note
❒ Default: Auto Select
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❖ Effective Protocol
Specify the effective protocol.
• IPv4

Active, Inactive

Note
❒ Default: Active

• IPv6
Active, Inactive

Note
❒ Default: Inactive

• NetWare
Active, Inactive

Note
❒ Default: Active

• SMB
Active, Inactive

Note
❒ Default: Active

• AppleTalk
Active, Inactive

Note
❒ Default: Active

❖ Ethernet Speed
Specify the network speed to operate the printer.
• Auto Select
• 10Mbps Half Duplex
• 10Mbps Full Duplex
• 100Mbps Half Duplex
• 100Mbps Full Duplex

Note
❒ Default: Auto Select

❖ LAN Type
Select Ethernet or IEEE 802.11b wireless LAN.
• Ethernet
• IEEE 802.11b

Note
❒ Default: Ethernet
❒ This menu appears only when the optional IEEE 802.11b interface unit

is installed.
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❖ IEEE 802.11b
Configure settings for wireless LAN. This menu appears only when the op-
tional 802.11b interface unit is installed.

❖ Communication Mode
Specify the transmission mode for IEEE 802.11b.
• 802.11 Ad hoc
• Infrastructure
• Ad hoc

Note
❒ Default: 802.11 Ad hoc
❒ Transmission mode can also be set using a Web Image Monitor. For de-

tails, see Web Image Monitor Help.

❖ SSID Setting
Specify the SSID in the infrastructure mode and the 802.11 Ad hoc modes.

Note
❒ Default: blank (ASSID)
❒ Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the

configuration page, read it as [/].
❒ Characters used are ASCII 0x20-0x7e (32 bytes).
❒ An SSID is set automatically to the nearest access point if no SSID has

been set.
❒ If no SSID has been set for the 802.11 Ad hoc mode, an SSID is set auto-

matically and the same SSID is used for the 802.11 Ad hoc mode and the
infrastructure mode.

❒ If blank is specified in SSID for 802.11b Ad hoc mode or Ad hoc mode,
“ASSID” appears.

❒ An SSID can also be set using Web Image Monitor. For details, see Web
Image Monitor Help.

❖ Channel
Select channels:

 1-13
 1-11

Note
❒  Default: 11
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❖ Security Type
Select whether to enable or disable encryption. When encryption is en-
abled, specify the security type.
• Off
• WEP

• Hex: Enter the WEP key using a hexadecimal number sequence.
When using 64 bit WEP, enter 10 ASCII characters. When using 128
bit WEP, enter 26 ASCII characters.

• ASCII: Enter the WEP key using an ASCII character sequence. When
using 64 bit WEP, enter 5 ASCII characters. When using 128 bit WEP,
enter 13 ASCII characters.

• WPA 
Encryption Method
• TKIP
• CCMP(AES)
Authentication Method
• WPA-PSK: From 8 to 63 ASCII characters can be entered.
• WPA : When selecting this method, obtain a certificate using Web

Image Monitor.
• WPA2-PSK: Same as WPA-PSK, 8 to 63 ASCII characters can be en-

tered.
• WPA2: A supplemental specification of WPA. Fully compatible with

IEEE802.11i.

Note
❒ Default: Off
❒ The WEP key can also be set using Web Image Monitor. For details, see

Web Image Monitor Help.

❖ Wireless LAN Signal
You can check the signal strength when using wireless LAN.

❖ Communication Speed
You can select the transmission speed for IEEE 802.11b.
• Auto
• 11Mbps Fixed
• 5.5Mbps Fixed
• 2Mbps Fixed
• 1Mbps Fixed

Note
❒ Default: Auto

❖ Restore Defaults
Reset the wireless LAN to default.
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❖ USB Settings

❖ USB Speed
Select speed for USB interface.
• Auto Select
• Full Speed

Note
❒ Default: Auto Select

❖ Fixed USB Port
• On
• Off

Note
❒ Default: Off
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Language Menu

You can set language displayed on the menu.

Changing the Language Menu

Follow the procedure below to change the interface language.

A Press the {Menu} key.

B Press the {T} or {U} key to select [Language], and then press the {OK} key.

C Press the {T} or {U} key to select the language, and then press the {OK}
key.
Wait for one second. The Language menu screen appears.

D Press the {Menu} key.
The initial screen appears.

Language Menu Parameters

You can select the language you use. Available languages are as follows:
English, French, German, Italian, Spanish, Dutch, Portuguese, Russian

Note
❒ Default: English
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Printable Files

This machine can print GL/2 and TIFF/CALS files.

❖ GL/2
Complies with the Pen Plotter command set HP-GL (Hewlett Packard's
Graphics Language), the Raster Plotter command set HP-GL/2 (Hewlett
Packard's Graphics Language Standard), and HP-RTL (HP's Raster Transfer
Language) developed by HP (Hewlett Packard).
HP-GL emulates the HP-GL commands of HP7550A.
HP-GL/2 and HP-RTL emulate the HP-GL/2 commands of HP DesignJet
600.
You can print from CAD applications that use HP-GL and HP-GL/2 com-
mands.

Note
❒ For details about specification of printable files, see “Printable GL/2 Files”.

Reference
p.169 “Printable GL/2 Files”

❖ TIFF/CALS
Print TIFF (Tagged Image File Format) format bitmap files from UNIX work-
stations and DOS/V computers.
TIFF/CALS files are rastorized by the machine. “Rastorization” refers to the
process of printing dot by dot from the bitmap image. This process does not
require a printer driver so printing can be set from either the machine or the
Web browser.

Note
❒ You can print GL/2 and TIFF/CALS files using PostScript 3.
❒ For details about specification of printable files, see “Printable TIFF Files”,

or “Printable CALS Files”.

Reference
p.179 “Printable TIFF Files”
p.183 “Printable CALS Files”
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To Print

The print settings made by other supplier's GL/2 and HDI drivers cannot be in-
herited.
When printing from GL/2 & TIFF, “Auto Paper Select” becomes disabled, and a
paper size different to that specified in the data might be requested.
If you print a black and white (monochrome) image at a resolution that the ma-
chine does not support, the print image might contain streaks or moiré patterns.
Follow the procedures below to print GL/2 and TIFF/CALS files from the ma-
chine.
• Using Web Printing Tool

GL/2 and TIFF/CALS files
• Using HDI Driver

GL/2 files
• Using the printing commands

GL/2 and TIFF/CALS files

Using Web Printing Tool

About Web Printing Tool

Web Printing Tool allows you to print files, make print settings, and acquire sys-
tem logs, via a Web browser.
Recommended Web browsers are as follows:
• Windows:

Microsoft Internet Explorer 6.0.28 or a later version
FireFox 1.5.0 or a later version

• Macintosh:
Safari 2.0 or a later version
FireFox 1.5.0 or a later version
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❖ Java applet
Web Printing Tool requires Java Runtime Environment. Download it from
the following web site:
http://www.java.com/

• About the certificate
• If you start Web Printing Tool, a dialog box about issuing the certificate ap-

pears. Click [Run].
• Select the [Always trust content from this publisher.] check box. No warning

will be shown after starting Web Printing Tool.
• If you click [Cancel], Web Printing Tool will not start. Close the Web brows-

er, and then restart Web Printing Tool.
• The certificate becomes effective after the [Security] setting under [Advanced]

on the Java control panel is set as follows:
• Allow user to grant permissions to signed content
• Allow user to grant permissions to content from an untrusted authority

• The default Java Runtime setting is effective.
• Compatible languages:

Web Printing Tool does not change the language settings of this machine. If
necessary, change the language using the Web browser.

Note
❒ Make the JavaScript, and Java applet following settings (required):

• Enable JavaScript.
• Install Java Runtime Environment (JRE 1.5 or later version.) and enable ap-

plet.
• Pop up blocking may not be set, depending on the Web browser you are

using. If this is the case, the Help file will not be properly displayed.
❒ If you are using a proxy server, change the Web browser settings. Contact

your administrator for information about the settings.
❒ We recommend using Web Printing Tool in the same network.
❒ You cannot access to the machine from outside the firewall.
❒ When using the machine under DHCP, the IP address may be automatically

changed by the DHCP server settings. Enable DDNS setting on the machine,
and then connect using the machine's host name. 

❒ Alternatively, set a static IP address to the DHCP server.
❒ When you are using Firefox, fonts and colors may be different, or tables may

be out of shape.
❒ When using a host name under Windows Server 2003/2003 R2 with IPv6 pro-

tocol, perform host name resolution using an external DNS server. The host
file cannot be used.
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Displaying top page

This section explains the how to display Web Printing Tool.

A Start your Web browser.

B Enter “http://(machine's address)/webprint/” in the address bar of a Web
browser.
Top Page of Web Printing Tool appears.
If the machine's host name has been registered on the DNS or WINS server,
you can enter it.

1. Header area
The area at the top of the Web Printing
Tool page is called the header area.
The following items appear in the
header area.

[Help] button
Click to display Help.

[Version Information] button
Click to display Web Printing Tool
version information.

[GL/2 & TIFF Initial Configuration] button
Click to display the [GL/2 & TIFF Initial
Configuration] page.

[System Log] button
Click to display the [System Log] page.

2. GL/2 & TIFF Print Settings
The area at the top of the Web Printing
Tool page is the GL/2 & TIFF Print
Settings area.

Note
❒ To open the [GL/2 & TIFF Initial Configuration] or [System Log] page, you must

enter the administrator password.
❒ For details, see Web Printing Tool's Help.

Reference
p.155 “How to use help”

ATW010S
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Basic operations of Web Printing Tool

A In the menu area to the left, click the menu item corresponding to the func-
tion you want to know about.
The page for the selected menu item appears in the work area to the right.

B Use the displayed page to make settings for printing.

About password authentication

• The password authentication is required to display the [GL/2 & TIFF Initial Con-
figuration] page or [System Log] page.

• Click the link in the header area. Enter the password in the authentication di-
alog box that appears.

• If you enter an invalid password, authentication fails and an error message
appears. Click [OK] in the message box, and then enter the password again. If
you enter an invalid password three times, the top page of Web Printing Tool
appears. Click the link in the header area to attempt authentication again.

• Password authentication is effective until the [GL/2 & TIFF Initial Configuration]
page or [System Log] page is closed.

• You can use either Web Printing Tool or the control panel to set GL/2 & TIFF
Initial Configuration. The settings are the same for both Web Printing Tool
and the control panel.

Note
❒ For details about the login password, see Notes to Administrator.

How to use help

While using Web Printing Tool, you can view explanations about operations of
the currently displayed page and the meaning of individual settings and items.
• To view Help top page: click the  button in the header area.
• To view Web Printing Tool Help page: click the  button in GL/2 & TIFF

Print Settings area.
• To close Help: click the [Close] button inside the Help window.
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Using From HDI Driver

Reference
p.165 “Using the HDI Driver for AutoCAD”

Using From the Printing Commands

The following explains printing operations using the “lpr”, “rcp”, and “ftp”
commands.

Note
❒ Match the data format of the file to be printed with the emulation mode of the

printer.
❒ If the message “print requests full” appears, no print jobs can be accepted. Try

again when sessions end. For each command, the amount of possible sessions
is indicated as follows:
• lpr: 5 (When the spool printing function is available: 10)
• rcp, rsh: 5
• ftp: 3

❒ Enter the file name in a format including the path from the directory execut-
ing commands.

lpr

❖ When specifying a printer by IP address
c:> lpr -Sprinter's IP address [-ol] \pass name\file name

❖ When using a host name instead of an IP address
c:> lpr -Sprinter's host name [-ol] \pass name\file name
When printing a binary file, add the “-ol” option (lowercase O, and lowercase L).

When using a printer with the host name “host” to print a PostScript file named
“file 1” located in the “C:PRINT” directory, the command line is as follows:
c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1
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rcp

First, register the printer's host name in the hosts file.
c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:

When using a printer with the host name “host” to print a file named “file 1” or
“file 2” located in the “C:PRINT” directory, the command line is as follows:
c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:

Note
❒ In file names, “*” and “?” can be used as wild cards.
❒ When printing a binary file, add the “-b” option.
❒ For details about a host name instead of an IPv4 address, see Network Guide.

ftp

Use the “put” or “mput” command according to the number of files to be printed.

❖ When one file is printed
ftp> put \pass name\file name

❖ When multiple files are printed
ftp> mput \pass name\file name [\pass name\file name...]

Follow the procedure below to print using the “ftp” command.

A Formulate the printer's IP address or the host name of the hosts file printer
as an argument and use the “ftp” command.
% ftp printer's IP address

B Enter the user name and password, and then press the {Enter} key.
For details about the user name and password, consult your network admin-
istrator.
User:

Password:

When user authentication is set, enter a login user name and password.

CWhen printing a binary file, set the file mode to binary.
ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.
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D Specify files to be printed.
The following shows the examples of printing a file named “file 1” in the
“C:PRINT” directory and printing file 1 and file 2.
ftp> put C:\PRINT\file1

ftp> mput C:\PRINT\file1 C:\PRINT\file2

E Quit ftp.
ftp> bye

Note
❒  “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read

as option strings.
❒ For “mput” command, option can not be defined.
❒ For “mput” command, “*” and “?” can be used as wild cards in file names.
❒ When printing a binary file in ASCII mode, print may not come out cor-

rectly.
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Print Settings for GL/2 & TIFF

This section explains the GL/2 & TIFF settings that you can set using the control
panel. GL/2 & TIFF settings are applied to GL/2 and TIFF files printed from
Web Printing Tool and the printing commands.

❖ Priority of Settings
• Settings changed using the control panel take priority.
• You cannot change GL/2 & TIFF initial configuration made using Web

Printing Tool, if the setting was changed using the control panel and is cur-
rently in effect.

• GL/2 & TIFF is ineffective during the printing of GL/2 files using the HDI
driver. Settings made using an application have priority over GL/2 & TIFF
settings.

Note
❒ The settings are the same for both Web Printing Tool and the control panel.
❒ For details about making settings using Web Printing Tool, see Web Print-

ing Tool Help.

Adjusting the Print Settings for GL/2 & TIFF

A Press the {Menu} key.

B Press the {U} or {T} key to select [Extended Features], and then.press the
{OK} key.

C Check [GL/2 & TIFF] is selected, and then press the {OK} key.

BAL051S
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D Press the {U} or {T} key to select the setting you want to make, and then
press the {OK} key.
• General Settings

Can be applied regardless of data format.
• GL/2 Print Settings

Can be applied to GL/GL2 data only.
• TIFF/CALS Print Settings

Can be applied to TIFF/CALS data only.

E Configure the settings.

FWhen you have finished making settings, press the {Menu} key.
The initial screen appears.
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General Settings

Specify basic print settings.

❖ Paper Tray Setting
Select which input tray to use for printing. If you select “Auto Paper Select”
the machine automatically selects an input tray based on the paper size and
type specified by the job.

❖ Margin Tolerance
Specify an area of allowance for the gap between the print area and the paper
size when using “Auto Paper Select”.

❖ Output Exit
Specify the output tray for printed paper.

❖ Auto Tray Switching
Enables the machine to switch automatically from an emptied paper tray to
another tray that contains the same size, orientation, and type of paper, with-
out interrupting the job.

❖ Paper Type
Select a paper type.

❖ Cut Method
Select the paper cut method. When roll paper is selected for input tray, the cut
method is enabled.
• Preset Cut

Cuts the roll paper to a standard size that fits the width of the print area. If
there is no appropriate standard size (for data such as long plots, etc.), Syn-
chro Cut is applied.

• Synchro Cut
Cuts the roll paper to the length of the print area.

❖ Reduce / Enlarge
Specify a scaling mode to reduce or enlarge the print size of documents.

❖ Magnification Ratio
Specify the ratio when Magnification Ratio is selected for “Reduce / En-
large”.

❖ Direct. Mag. mm (Directional Magnification mm)
Specify the vertical and horizontal value when Magnification Ratio is selected
for “Reduce / Enlarge”.
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❖ Margin Adjustment
Specify the inside margin around the originals (0 to 100 mm in 1 mm incre-
ments).

❖ Extraction
Specify whether to uncompress and extract compressed job data before print-
ing it. Selecting this option reduces print errors due to corrupted archives, but
slows the print process slightly.

❖ Mirror Image
Prints images with left and right reversed.

❖ Positive / Negative
Prints images with black and white inverted.

❖ Dithering
Select a dither pattern appropriate for the print image.

Note
❒ If you select [Auto], [DTP], or [Photograph] for this setting, the image is print-

ed using [Photograph].

❖ Adjust: Horizontal
Adjusts the horizontal size difference between original data and printed im-
age for scaled drawings that must be accurately printed. The ratio range is
99.0-101.0%, which you can adjust in increments of 0.01%.

❖ Adjust: Vertical
Adjusts the vertical size difference between original data and printed image
for scaled drawings that must be accurately printed. The ratio range is 99.0-
101.0%, which you can adjust in increments of 0.01%.

❖ Paper Folding
If the folding finisher is installed, select a paper folding method.
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GL/2 Print Settings

Specify print settings of HP-GL and HP-GL/2 data.

❖ Hard Clip
Enables and disables output hard clip limits given by PS commands. If “Off”
is selected, the actual drawing area will be the printed area.

❖ Centring
Print images at the centre of the hard clip area.

❖ SP Command
Specify whether to eject paper at receipt of “SP;” and “SP0;” command.

❖ Transparency Mode
Specify the transparent processing mode by MC command and TR command.
• Always Active

Always activates MC/TR commands in HP-GL2 data come into effect.
• Use File Defaults

Follows MC/TR commands in HP-GL2 data.
• Always Inactive

Ignores MC/TR commands in HP-GL2 data forcibly.

❖ Source Transparency Mode
Specify the transparent processing method by “Source Transparency Mode
(ESC*v#N)”.
• Always Active

Always activates ESC*v#N commands in RTL data come into effect.
• Use File Defaults

Follows ESC*v#N commands in RTL data.
• Always Inactive

Ignores ESC*v#N commands in RTL data forcibly.

❖ Adjust X Offset
Specify X-axis offset for origin of the drawing area in 1 mm increments within
the range between -199 and 199 mm.

❖ Adjust Y Offset
Specify Y-axis offset for origin of the drawing area in 1 mm increments within
the range between -199 and 199 mm.

❖ Brightness
Adjust brightness for RGB-color and grayscale image data. Higher brightness
value lightens the entire image while lower brightness value darkens the im-
age.
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❖ Pen Width
Select whether to use file defaults settings, or to specify width for each pen.

❖ Pen Density
Select whether to use file defaults settings, or to specify density for each pen.

❖ Pen 0 Custom Settings - Pen 15 Custom Settings
Specify width and/or density for each pen when the “Use File Defaults” op-
tion is selected. Pen Width can be selected from the list of 0.00 - 12.00 mm in
0.01 mm increments, however actual width of printed image could be slightly
different from the specified width because lines are printed in dots. Pen Den-
sity can be specified in 10% increments within the range between 0 and 100%.

TIFF/CALS Print Settings

Specify print settings of TIFF and CALS data.

❖ Centring
Print drawing area at the centre of the paper.

❖ Adjust X Offset
Specify X-axis offset for origin of the drawing area in 1 mm increments within
the range between -199 and 199 mm.

❖ Adjust Y Offset
Specify Y-axis offset for origin of the drawing area in 1 mm increments within
the range between -199 and 199 mm.

❖ Brightness
Adjust brightness for RGB-color and grayscale image data. Higher bright-
ness value lightens the entire image while lower brightness value darkens
the image.
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Using the HDI Driver for AutoCAD

You cannot use the HDI driver to select the orientation (portrait or landscape) of
paper on the bypass tray.
If you use the HDI driver to print onto standard size paper, alert messages will
not appear, even if the paper orientation set in the print data does not match the
orientation of the paper in the tray.

Setup CD-ROM

The HDI driver for the AutoCAD 2000 series is provided to work specifically
with the AutoCAD 2000 series of CAD applications.
Using the HDI driver reduces data size during print out, enabling faster print
out.
Also, the HDI driver is specially designed for use in environments where Au-
toCAD 2000 applications are running.

Important
❒ If you are already using a printer of the same maker, you cannot use different

HDI drivers simultaneously. 
❒ If you still want to install the HDI driver, delete the older HDI driver. To use

the HDI driver, you must install it beforehand. The HDI driver is stored on
the CD-ROM provided with the machine.

Note
❒ The Installation CD-ROM contains a Readme file that you must read. It con-

tains important information about the HDI driver and notes on using the ap-
plication.

❒ The Readme file is in the “Installation Disk” folder on the Installation CD-
ROM.

❒ This section assumes the user has full knowledge of Windows functions and
procedures. For details about Windows, see the Windows manual.

❒ This section assumes the machine is connected to the single computer. The
screens you see on your machine might not be the same as those shown in this
manual, depending on the environment you are using.

❒ The “Driver” folder contains folders other than the “HDI” folders. This emula-
tion can only use HDI and printer drivers that are stored in the “HDI” folders.
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CD-ROM Folders

The CD-ROM contains following folders and files:

Contains HDI drivers for AutoCAD applications and the Readme files.

DRIVERS HDI AC2000

AC2000i

AC2002

AC2004

AC2007
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Installing the HDI Driver

The following explains how to install the HDI driver under Windows 2000. All
the procedures are the same for Windows 95/98/Me, Windows XP, Windows
Server 2003/2003 R2, and Windows NT 4.0.

Important
❒ AutoCAD applications must be installed before you install the HDI driver.
❒ This section explains installation using AutoCAD 2007.
❒ Quit all applications currently running before beginning the HDI driver in-

stallation.

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B On the [Start] menu, point to [Settings], and then click [Control Panel].

C Double-click [Autodesk Plotter Manager].
[Autodesk Plotter Manager] appears only if there is the AutoCAD 2000 series ap-
plication already installed.

D Double-click [Add-A-Plotter Wizard].

E Click [Next >].

F Click [Next >].

G Click [Have Disk].

H Select [CD-ROM] in [My Computer].
Check that the CD-ROM provided with the machine is shown.

I Double-click [DRIVERS], and then double-click [HDI].

J Click the file that matches the AutoCAD application you want to use.
AC2000: AutoCAD 2000/AutoCAD LT2000
AC2000i: AutoCAD 2000i/AutoCAD LT2000i
AC2002: AutoCAD 2002/AutoCAD LT2002
AC2004: AutoCAD 2004/AutoCAD LT2004/AutoCAD 2005/

AutoCAD LT2005/AutoCAD 2006/AutoCAD LT2006
AC2007: AutoCAD 2007/AutoCAD LT2007
Check the driver you selected matches the AutoCAD version you want to use.
If they do not match, an error screen appears. See the HDI driver's Readme if
this occurs.
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K Select the driver you want to install, and then click [Open].

L In “Manufacturers”, select the manufacturer. Then, in “Models”, select the
printer driver. Then click [Next >].

M Click [Next >].

N Select [Port], then select the port you want to use, and then click [Next >].

O Confirm the plotter name you want to use is selected, and then click [Next >].
Installation is complete. If the installation is successful, the HDI driver is add-
ed to the [AutoDesk Plotter Settings (Plotter window)] window, and it can be se-
lected from [Printing Devices] during printing. For details about screens and
printing procedures, see the online Help. To display the online Help, click
[Help] on the printer driver screen.

P Click [Finish].

Displaying and Printing Help

Displaying Help

This section explains installation using AutoCAD 2007.

A On the [File] menu, click [Plot...].
The [Plot...] dialog box appears.

B Check the HDI driver you want to use appears in the [Name:] list in the
“Printer/plotter” area, and then click [Properties...].

C Click [Custom Properties] on the [Device and Document Settings] tab.
The [Custom Properties] button appears under the screen.

D Click [Custom Properties...].

E The Help screen appears if you click [Help].

Printing Help

❖ Printing by Book
If you select the book icon, you can print several topics at once.
Select the book icon in the [Help Topics] dialog box, and then click [Print...].

❖ Printing by Topic
There are two methods of printing by topic:
• Select the topic icon in the [Help Topics] dialog box, and then click [Print...].
• Display the topic you want to print, and then click [Print...].
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Printable GL/2 Files

HP-GL Specifications

The GL/2 and TIFF filter modules that are included in GL/2 and TIFF filter
products emulate the HP-GL commands of HP7550A. However, the command
syntax differs (as shown below) according to the settings of the GL/2 and TIFF
modules.

HP-GL command syntax

The syntax of HP-GL commands is as follows: a section containing two alpha-
betical characters, a parameter section (certain commands only), and a termina-
tor section.
If you specify multiple parameters at the end, a separator must be inserted be-
tween each parameter.
The HP-GL/2 filter can use the separators and terminators shown below.

Plotter setup commands

The HP-GL/2 filter does not support the following plotter setup command and
will ignore it if it is included:

Commands for plotting Circles, Ovals, and Multiple Shapes

The HP-GL/2 filter does not support the following Circles/Ovals/Multiple
Shapes plotting commands and will ignore them if they are included:

Syntax Elements Format and Range

Separator comma or space

Terminator ; or LF or another command

Integer parameter 999999999 to 999999999

Real number parameter 999999999. 999999999 to 999999999.999999999

Command Description

GM Changes buffer sizes, but not the size of the input or output 
buffer.

Command Description

UF Specifies the fill pattern at parallel interval.

PT Specifies the overprint interval.
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Commands for plotting basic characters

The HP-GL/2 filter does not support the following basic character plotting com-
mands and will ignore them if they are included:

Commands for extended character sets

The HP-GL/2 filter supports the following character sets: Standard ASCII (0);
kanji (101); and 8, 18, and 43 (katakana). The HP-GL/2 filter does not support the
commands for multiple character sets and making optional characters:

Commands for changing the plotting domain

The HP-GL/2 filter does not support the following commands for changing the
plotting domain according to the HP plotter and will ignore them if they are in-
cluded:

Command Description

DU Uses the user unit to specify the character plotting direction.

SU Uses the user unit to specify the character size.

BL Stores character strings for labeling in the label buffer.

OL Obtains information from output capable character strings in 
the buffer.

IC Obtains the location of certain ASCII character inside the NCP 
cell.

OB Outputs the co-ordinates of the upper right and lower left cor-
ners around the character on receipt of this command.

LE Uses the 7240/7245 plotter to underline or change the charac-
ter width under character set 20 to 28.

PB Plots the content of the label buffer.

Command Description

CM Specifies modes for selecting the character set and using it.

DS Specifies the character set selected by parameter at the charac-
ter slot.

IV Calls up the character slot (G0 - G3) on the right half (GR) or 
left half (GL) of the code table.

CC Specifies smoothness of characters when a character set be-
tween 10 to 19 and 40 to 49 is selected.

UC Plots symbols not defined in the character set.

Command Description

OW Enables the left down and right down coordinates of the win-
dow to be output.
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Plotter control commands

The HP-GL/2 filter does not support the following commands for plotter control
according to the HP plotter and will ignore them if they are included:

Command Description

AP Specifies the automatic pen function.

FS Specifies the pen pressure.

AS Specifies the pen acceleration.

VS Specifies the maximum speed when the pen is lowered.

VA Automatically adjusts the speed of the pen when it is lowered 
to the speed at which the computer sends the coordinates.

VN Used when disabling the VA command.

GP Used when collecting pens of the same type and color into one 
group.

SG Selects the group specified by the GP command.

CV Controls the curve line generator.

AF Feeds paper only when something is being plotted on the cur-
rent paper.

AH Feeds half of the paper only when something is being plotted 
on the current paper.

EC Controls the paper cut function.

NR Puts the plotter into the “NOT READY” state.

BF Stores the HP-GL command following this command to the re-
plot buffer until the RP command is received.

RP Re-plots data using the data in the re-plot buffer.

WD Displays messages on the plotter's front panel LCD, and ap-
plies the plotter's keyboard mode.

KY Assigns the programmed status to the plotter's front panel 
function key.

OK Enables the number of the first pressed front panel function 
key to be output.

GC Specifies the group count number used in response to the OG 
command.

OG Enables the current group account information to be output. 

BP Sounds the plotter's beeper.
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Digitization commands

The HP-GL/2 filter does not support the following digitization related com-
mands and will ignore them if they are included:

Commands for obtaining plotter information

The HP-GL/2 filter does not support the following commands for obtaining in-
formation from the plotter and will ignore them if they are included:

Line attribute commands

The HP-GL/2 filter does not support the following attributes for the line at-
tribute setting commands and will ignore them if they are included:

Command Description

DP Sets the plotter to digitize mode.

OD Enables the last co-ordinates of digitized positions and the pen 
state preceding this command to be output.

DC Cancels digitize mode.

Commands Description

IM Sets conditions for notifying the host computer of HP-GL er-
rors.

OA Enables the pen's coordinates to be output.

OC Enables the co-ordinates and condition of the pen during the 
last effective command to be output.

RC Enables the cursor's coordinates and status to be output.

OE Enables the value of the initial error made before this com-
mand was executed to be output.

OF Enables the value of the plotter unit by 1 mm at each coordi-
nate to be output.

OI Enables the character strings that distinguish each plotter to be 
output.

OO Enables the eight option parameters to be output.

OS Enables the plotter's status to be output in decimal form.

OT Enables the carousel's shape and operating conditions of the 
stool to be output.

Attribute Specification

End of the line 

Triangle (Value: 3)

Makes the ends of lines rounded.

Line joint (Type: 2)

Triangle Joint (Value: 3)

Makes joints circular.
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HP-GL/2 filter coordinates

Like other HP plotters, the HP-GL/2 plots using single 0.025 mm units. When
plotting on paper however, the printer's or plotter's resolution determines the
plot units.
The following explanation covers the HP-GL/2 filter's start coordinates, plotting
origin, and scaling point.

The HP-GL/2 filter uses the initial coordinates, plotting origin, and scaling point
to begin processing input data. Input data that has minus coordinates and orig-
inates from other than the bottom left area (P1) or the hard clip limit (the PS com-
mand-specified area) is shifted by the minimum value of each last drawn
coordinate to the plotting origin (where X and Y intersect, in the minus direc-
tion).
Likewise, the coordinates of images that are drawn in the plus direction are shift-
ed similarly. Images that exceed the hard clip limit are not output.
If the HP-GL/2 filter's clipping option is enabled (overriding the hard clip limit
of the PS command), the data is output with the hard clip limit reset to the im-
age's minimum and maximum value for each co-ordinate, and independent of
the original position and the hard clip limit.

P2

P1

+X

+Y

Hard Clip
Limit

ATW011S

Base
Position

(0,0)
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HP-GL/2 Specifications

The GL/2 and TIFF filter modules that are included in GL/2 and TIFF filter
products emulate the HP-GL commands of the HP DesignJet 600 but differ ac-
cording to the settings of the GL/2 and TIFF modules. The following commands
are also different:

Character group commands

This section explains limitations to commands that belong to the character group
shown in the HP-GL/2 reference manual.

Label default status

The table below shows the HP-GL/2 filter's label default status.

Character codes that can be used with LB commands

The HP-GL/2 filter supports three character codes for specifying LB command
parameters: ASCII (Roman 8), JIS, and Shift JIS. If other codes are included in
HP-GL data, unwanted characters might be output.

Font specification and selection

As with other HP-GL/2 products, procedures for font selection at HP-GL/2 fil-
ter are based on SD and AD command parameters.

Label Attribute Status

Character set ASCII code (Roman8)

Label terminator ASCII code end of text command character 
ETX (Decimal code 3)

Label's starting point Current pen position

Character size Character width 2.83 mm, Character height 
3.75 mm (Below A0 size) Character width 4.23 
mm, Character height 5.21 mm (Above A0 size)

Label orientation Horizontal

Margins between characters and lines Normal (no extra margins added)

Character tilt No tilt

Character overprint mode Solid (total overprint)

Font Courier
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Parameters that can be used with SD and AD commands

The standard and substitute character sets (SD and AD commands respectively)
define each character set's attributes, such as font, font spacing, pitch height, and
character width. The table below shows which of the attributes shown in the HP-
GL/2 manual can be used with HP-GL/2.

❖ Character Set
Character set attributes define the character sets used as the standard and
substitute character set. The table below shows the character sets that the HP-
GL/2 filter can use. If an unusable character set is specified, the default set is
applied.

Types and attributes Default value Description

1 Character set 277 Roman8

2 Font spacing 0 Fixed spacing

3 Pitch Depends on paper size Characters per inch

4 Height Depends on paper size Font point

5 Character tilt 0 Upright

6 Line width 0 Normal

7 Font 3 Courier

Character set Description Note

0 and 277 Roman8

11 JIS ASCII

22 Arabic

43 Katakana If you select this font, the dis-
play might not be as intend-
ed, depending on the area 
you want to use.

101 Shift JIS

278 Arabic-8

300 Ventura ITC Zapf Dingbats

332 PS ITC Zapf Dingbats

364 ITC Zapf Dingbats 100

396 ITC Zapf Dingbats 200

428 ITC Zapf Dingbats 300

531 HP-GL Download

numbers higher than 1000 Kanji code If you select this font, the dis-
play might not be as intend-
ed, depending on the area 
you want to use.
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❖ Font
The font attribute selects the font that determines the rendering style. The ta-
ble below shows the character sets that the HP-GL/2 filter can use. If an un-
usable font is specified, the default font is applied.

Font Selection condition Note

Courie The character set is 0, 277 or 
the font is 3

Symbol The character set is 22, 278

Zaps Dingbats The character set is 300, 332, 
364, 396, 428

User font The character set is 531 Fonts downloaded using the 
DL command.

Mincho / Gothic The character set is 101, 43, 
1000 or a higher number; or 
the font is 81, 152, 153, 154, 
155, 156

Conditions of usage by Min-
cho / Gothic depends upon 
the command parameter.

Stick font The font is 48, 49, 50

Helvetica The font is 4

Times Roman The font is 5 and the line 
width is other than 3, 7

Times Bold The font is 5 and the line 
width is 3 or 7

Times Italic The font is 5, the tilt is 1, and 
the line width is other than 3, 7

Times Bold Italic The font is 5, the tilt is 1, and 
the line width is 3, 7

Palatino-Roman The font is 15 and the line 
width is other than 3, 7

Palatino-Bold The font is 5 and the line 
width is 3, 7

Palatino-Italic The font is 15 and the tilt is 1

Palatino-Bold-Italic The font is 15 and the tilt is 1 
and the line width is 3 , 7

NewCenturySchlBk The font is 23 and the line 
width is other than 3 , 7

NewCenturySchlBk-Bold The font is 23 and the line 
width is 3, 7

NewCenturySchlBk-Italic The font is 15, the tilt is 1, and 
the line width is other than 3, 7

NewCenturySchlBk-Bold-
Italic

The font is 23 , the tilt is 1, 
and the line width is 3, 7

AvantGarde-Book The font is 31
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AvantGarde-Book-Oblique The font is 31 and the tilt is 1

Zapfchancery-midium-italic The font is 43

Bookman-Light The font is 47 and the line 
width is other than 3, 7

Bookman-DemiLight The font is 47 and the line 
width is 3, 7

Bookman-LightItalic The font is 47, the tilt is 1, and 
the line width is other than 3, 7

Bookman-DemiItalic The font is 47, the tilt is 1, and 
the line width is 3, 7

Font Selection condition Note
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HP-RTL Specifications

This section explains limitations to commands that are explained in the HP-
GL/2 and HP-RTL reference manuals.

Logical Operation (ESC*|#o|ESC*|#o)

The table below shows the specifications of the parameters used by the HP-
GL/2 filter's Logical Operation command.

Parameter Specification

252 (Default) OVERWRITE procedure

136 AND procedure

168 TRANSPARENT procedure

204 TRANSPARENT procedure

238 OR procedure

Values other than the above TRANSPARENT procedure
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Printable TIFF Files

TIFF Data Specifications

TIFF files that can be processed

This section explains the TIFF filter's file processing limitations. The TIFF filter
can process only TIFF files that are compliant with “TIFF Revision 6.0” (Adobe
Developers Association, June 1992).

Note
❒ The TIFF filter might be able to process non-compliant TIFF files, but the out-

put is likely to be incorrect, depending on the size of the image.

TIFF header

TIFF data requires the header values shown in the table below.

TIFF directory

If the data is multi-page TIFF:
• Both the directory and data must be divided by page.
• The last four bytes of each directory must contain a pointer to the subsequent

page, and the pointer value must increase in keeping with the page order.

Note
❒ The pointer value for both single page TIFF data and the last page of multi-

page TIFF data must be “0x00000000”.
• The page order must be the same as the intended output order.

Field Values

Byte order 0x4d4d or 0x4949

Version number 42
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TIFF tags

The table below shows the types and values of tags that can be included in the
TIFF directory. If included, other tags or unacceptable values are normally ig-
nored, but might occasionally cause processing to stop.

Tag values must be entered in byte, ASCII, short, long, or rational data format.
If the value of the tag is a pointer to data that is stored outside the tag entry, that
pointer must be at the back of the directory that contains the tag, pointing either
to the subsequent directory or the data domain preceding the end of the data,
not to the data domain of the subsequent page.

Tag name (number) Value

ImageWidth (256) 0 - 65535

ImageHeight (257) 0 - 65535

BitsPerSample (258) 1, 4, or 8

Compression (259) 1, 3, or 4

PhotometricInterpretation (262) 0

FillOrder (266) 1

StripOffsets (273) 0 - 2**32 - 1

SamplesPerPixel (277) 1

RowsPerStrip (278) 1 - ImageLength

StripByteCounts (279) One of the following:

ImageWidth × ImageLength / 8

ImageWidth × ImageLength / 2

ImageWidth × ImageLength

size of compressed image in bytes

MinSampleValue (280) 0

MaxSampleValue (281) 2**BitsPerSample-1

XResolution (282) 50 - 1200

YResolution (283) 50 - 1200

T4Options (292) 0 or 1

ResolutionUnit (296) 2
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Bitmap images

For reference, the top position of the strip data must be contained in the value of
the StripeOffsets (273) tag. The data size (byte) after it is coded must also be spec-
ified by the value of StripeByteCounts (279) tag.
The byte at the end of the last page's strip data must be the same as the byte at
the end of the TIFF data.
The bitmap data must be one of the following types:

The bitmap image data must be coded using one of the following compression
methods.

Bitmap image type Limitations

Monochrome: one sample, one bit (two colors) 
per pixel.

The value of the BitsPerSample (256) tag must 
be set to 1. Each pixel must be white when the 
sample value is 0, and black when the sample 
value is 1.

Gray scale: one sample, four bit (16 colors) per 
pixel.

The value of the BitsPerSample (256) tag must 
be set to be at 4. Each pixel must be white 
when the sample value is 0, and black when 
the sample value is 15.

Gray scale: one sample, eight bit (256 colors) 
per pixel.

The value of the BitsPerSample (256) tag must 
be set to be at 8. Each pixel must be white 
when the sample value is 0, and black when 
the sample value is 255.

Compression method Limitations Notes

Uncompressed method The image is not compressed. 
Data for each pixel is stored in 
the order it is created or 
scanned. Extra data is added 
to the end of each line as a pad 
in place of unused bytes.

The value of the Compression 
(259) tag must be set to 1 and 
the T4Options (292) tag cannot 
be included. Also, the value of 
the StripByteCounts (279) tag 
must be set as follows:

• 2 color monochrome image 
ImageWidth × 
ImageLength / 8 

• 16 color gray scale image
ImageWidth × 
ImageLength / 2

• 256 color gray scale image
ImageWidth × ImageLengt 
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MH (Modified Huffman) 
method

This compression method is 
the same as the one-dimen-
sional coding method of the 
CCITT Group 3 Fax.

This compression method is 
used for two color mono-
chrome images only.

The value of the Compression 
(259) must be set to 3 and the 
T4Options (292) tag must be 
set to 1. Also, the value of the 
StripByteCounts (279) tag 
must be set to the size (in 
bytes) of the compressed data.

MMR (Modified Modified 
Read) method

This compression method is 
the same as the CCITT Group 
4 Fax coding method.

This compression is used for 
two color monochrome imag-
es only.

The value of the Compression 
(259) tag must be set to 4 and 
the T4Options (292) tag can-
not be included. Also, the val-
ue of the StripByteCounts 
(279) tag must be set to the 
size (in bytes) of the com-
pressed data.

LZW (Lempel, Ziv, Welch) 
method

The value of the Compression 
(259) tag must be set to 5. Also, 
the value of the StripByte-
Counts (279) tag must be set to 
the size (in bytes) of the com-
pressed data.

This method uses the data 
compression algorithm origi-
nally devised by Terry Welch 
of Sperry (currently Unisys), 
and later used as a dictionary 
“LZ77” algorithm by Abra-
ham Lempel and Jacob Ziv.

Compression method Limitations Notes
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Printable CALS Files

CALS Data Specifications

CALS files that can be processed

The TIFF filter can process only CALS files that are “CALS Raster (Type1)” com-
patible and compliant with the following file format and raster drawing method:
“MIL-STD-1840A” (US Department of Defense, December 1987)

Note
❒ The TIFF filter might be able to process non-compliant CALS files, but the

output is likely to be incorrect, depending on the size of the image.

CALS headers

CALS data must include a header block that is compliant with the conditions
listed after the table below. The header block requires the following eleven head-
er records to be entered at the top in the order shown.

Byte offset Record ID and configurable value 
(all ASCII characters)

0000 srcdocid: optional

0128 (0x80) dstdocid: optional

0258 (0x102) txtfilid: optional

0348 (0x15C) Figid: optional

0512 (0x200) srcgph: optional

0640 (0x280) doccls: optional

0768 (0x300) Rtype: 1

0896 (0x380) rorient: 000, 270

1024 (0x400) rpelcnt: appropriate value

1152 (0x480) rdensty: appropriate value

1280 (0x500) notes: optional

1408 (0x580) 0x20 × 128 bytes

1530 (0x5FA) 0x20 × 128 bytes

1664 (0x680) 0x20 × 128 bytes

1792 (0x700) 0x20 × 128 bytes

1920 (0x780) 0x20 × 128 bytes

2048 (0x800) Bitmap data
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Header Block Conditions
• The header must be 2048 bytes (fixed length).
• Header records must be 128 bytes (fixed length).
• Header records must start with a record ID.
• Specified values for header record IDs must be entered in the separator's two

character spaces: Colon (0x3a) and Space (0x20).
• Header records that contain no directive value must be given “NONE” as

their value.
• Empty bytes in the header record and header block must be padded with

spaces (0x20).

Bitmap image data

Bitmap image data must follow immediately after the header block's final byte
and be of the following format:
ITU-T T.6 monochrome raster (Group 4 Fax).

Note
❒ The same compression format as MMR (Modified Modified Read).
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Using Web Image Monitor

Using Web Image Monitor, you can check the printer status and change settings.

❖ Available operations
The following operations can be remotely performed using Web Image Mon-
itor from a client computer.
• Displaying printer status or settings
• Checking the print job status or history
• Interrupting currently printing jobs
• Resetting the printer
• Managing the Address Book
• Making printer settings
• Making e-mail notification settings
• Making network protocol settings
• Making security settings

❖ Configuring the printer
To perform the operations from Web Image Monitor, TCP/IP is required. Af-
ter the printer is configured to use TCP/IP, operations from Web Image Mon-
itor become available.

❖ Recommended Web browser
• Windows:

Internet Explorer 5.5 SP2 or higher
Firefox 1.0 or higher

• Mac OS:
Firefox 1.0 or higher
Safari 1.0, 1.2, 2.0(412.2) or higher

• Web Image Monitor supports screen reader software
We recommend JAWS 7.0 or a later version.
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Note
❒ Safari cannot be used on Mac OS X 10.4.1.
❒ Display and operation problems can occur if you do not enable JavaScript and

cookies, or if you are using a non-recommended Web Browser.
❒ If you are using a proxy server, change the Web browser settings. Contact

your administrator for information about the settings.
❒ If you click your browser’s back button but the previous page does not ap-

pear, click the browser’s refresh button and try again.
❒ Printer information is not automatically updated. To perform an update, click

[Refresh] in the display area.
❒ We recommend using Web Image Monitor in the same network.
❒ You cannot access to the printer from outside the firewall.
❒ When using the printer under DHCP, the IPv4 address may be automatically

changed by the DHCP server settings. Enable DDNS setting on the printer,
and then connect using the printer’s host name. Alternatively, set a static IPv4
address to the DHCP server.

❒ If the HTTP port is disabled, connection to the printer using the printer’s URL
cannot be established. SSL setting must be enabled on this printer. For details,
consult your administrator.

❒ When using the SSL encryption protocol, enter “https://(printer’s ad-
dress)/”. Internet Explorer must be installed on your computer. Use the most
recent available version. We recommend Internet Explorer 6.0 or later.

❒ When you are using Firefox, fonts and colors may be different, or tables may
be out of shape.

❒ To use JAWS 7.0 under Web Image Monitor, you must be running Windows
OS and Microsoft Internet Explorer 5.5 SP2, or a later version.
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Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

A Start your Web browser.

B Enter “http://(printer’s address)/” in the address bar of a Web browser.
Top Page of Web Image Monitor appears.
If the printer’s host name has been registered on the DNS or WINS server, you
can enter it.
When setting SSL, a protocol for encrypted communication, under environment
which server authentification is issued , enter “https://(printer’s address)/”.
Every Web Image Monitor page is divided into the following areas:

1. Menu area
If you select menu, it’s content will be
shown on the work area, or the sub area.

2. Tab area
Details about each menu appears.

3. Header area
The dialog box for switching to the
user mode and administrator mode
appears, and each mode’s menu will
be displayed.
The link to help and dialog box for
keyword search appears.

4. Help
Use Help to view or download Help
file contents.

5. Display area
Displays the contents of the item se-
lected in the menu area.
Machine information in the display
area is not automatically updated.
Click [Refresh] at the upper right in the
display area to update the machine in-
formation. Click the Web browser’s
[Refresh] button to refresh the entire
browser screen.

Note
❒ For details the printer's host name has been registered on the DNS or

WINS server, see “Cautions to Take When Using in a Network”.

Reference
 p.342 “Cautions to Take When Using in a network”

BAL202S
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When User Authentication is Set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

A Click [Login].

B Enter a login user name and pass word, and then click [Login].
For details about the login user name and password, consult your network
administrator.

Note
❒ For user code authentication, enter a user code in [User Name], and then

click [OK].
❒ The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.
Click [Logout] to log off.

Note
❒ After you log on and change configurations, make sure to always log off.
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About Menu and Mode

There are two modes available with Web Image Monitor: guest mode and ad-
ministrator mode.
Displayed items may differ depending on the printers.

❖ About Guest Mode
In the guest mode, printer status, settings, and print job status can be viewed,
but the printer settings cannot be changed.

1. Home
The [Status], [Device Info], and [Counter]
tab are displayed. Details of the tab
menu are displayed on the work area.

2. Printer: Print Jobs
Allows you to display list of Sample
Print, Locked Print, Hold Print, and
Stored Print jobs.

3. Job
Display all print files.

4. Configuration
Display current printer and network
settings.

BAL203S
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❖ Administrator Mode
In the administrator mode, you can configure various printer settings.

1. Home
The [Status], [Device Info], and [Counter]
tab are displayed. Details of the tab
menu are displayed on the work area.

2. Printer: Print Jobs
Allows you to display list of Sample
Print, Locked Print, Hold Print, and
Stored Print jobs.

3. Job
Display all print files.

4. Address Book
User information can be registered,
displayed, changed, and deleted.

5. Configuration
Make system settings for the printer,
interface settings, and security.

6. Reset Device
Click to reset the printer. If a print job
is being processed, the printer will be
reset after the print job is completed.
This button is located on Top Page.

7. Reset Printer Job
Click to reset current print jobs and
print jobs in queue. This button is lo-
cated on Top Page.

BAL204S
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Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

A On Top Page, click [Login].
The dialog box for entering the user name and password appears.

B Enter your login user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.

Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked “?” in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

❖ Viewing Help on our Web site
Downloading Help to your computer

❖ Downloading and Checking Help
You can download Help to your computer. To view Help without connecting
to the Internet, enter the path to your local Help files in your browser’s URL
bar.

Note
❒ By clicking [Help] in the header area, the contents of Help appear. You can

view Help for a setting by clicking “?”, the Help icon, in the display area.

Downloading Help

A In the [OS] list, select the operating system.

B In the [Language] list, select the language.

C Click [Download].

D Download Help by following the instructions on the screen.

E Store the downloaded compressed file in a location, and then decompress
the file.
To view the downloaded Web Image Monitor Help, set the path to the loca-
tion of the decompressed file.
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Linking the URL of the Help File to the Help Button

You can link the URL of the help file on a computer or Web server to the [Help]
button.

A Log on to Web Image Monitor in the administrator mode.

B In the menu area, click [Configuration].

C Click [Webpage].

D In the [URL] box, enter the URL of the help file.
For example, if you saved the file to a Web server, and the URL of the index file
is “http://a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.

E Click [OK].
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers.
Also, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

Important
❒ IPv6 cannot be used on this function.

❖ Protocol stack provided with Operating System
• Windows 95/98/Me

TCP/IP
IPX/SPX
NetWare
NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98/Me

• Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT/2000/XP

• Windows Server 2003/2003 R2
TCP/IP
IPX/SPX

• Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT/2000/XP

• Windows NT 4.0
TCP/IP
IPX/SPX
Client Service for NetWare
NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT/2000/XP

❖ Available operations
The following functions are available:
• Printer Information function

• Display the network settings and detailed information of the printer.
• Display the number of pages printed under each user code.
• Display the status of print jobs sent from computers.
• Change the printer network settings.
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• Device Settings function
• Lock some of the setting items on the control panel so that they cannot

be changed using the control panel.
• Select type of paper loaded in the paper trays.

• Energy Saver function
• Enable or disable the Energy Saver mode.

• System Status function
• Display the information such as when paper is depleted during printing

on a computer.
• Groups function

• Monitor multiple printers at the same time. When there are multiple
printers to manage, you can create groups and classify the printers to fa-
cilitate management.

• You can customize printer status according to groups, and send status
notification e-mail to a computer.



Using SmartDeviceMonitor for Admin

95

6

1

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [SmartDeviceMonitor for Admin] installation, and then click [Next >].

E The software [License Agreement] appears in the License Agreement dialog
box.
After reading through its contents, click [Yes] if you agree, and then click [Next >].

F Follow the instructions on the screen.
A message appears when the installation is complete.

G Click [OK].

Note
❒ Auto Run may not work under certain operating system settings. In this

case, launch “Setup.exe” located on the CD-ROM root directory.
❒ If you are required to restart the computer after installing SmartDevice-

Monitor for Admin, restart the computer and continue the configuration.
❒ SmartDeviceMonitor for Admin supports following languages: Czech,

Danish, German, English, Spanish, French, Italian, Hungarian, Dutch,
Norwegian, Polish, Portuguese , Finnish, Swedish, Chinese Simple and
Chinese Traditional.
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Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configura-
tion using SmartDeviceMonitor for Admin.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].
A Web browser opens and the dialog box for entering the user name and
password for the Web Image Monitor administrator appears.
NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.

F Configure settings using Web Image Monitor.

G Click [Logout].

H Quit Web Image Monitor.

I Quit SmartDeviceMonitor for Admin.

Reference
p.185 “Using Web Image Monitor”.
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Locking the Menus on the Printer’s Control Panel

Follow the procedure below to lock the menus on the printer’s control panel.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

C Select a printer.

D On the [Tools] menu, point to [Device Settings], and then click [System].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

E Enter the user name and password, and then click [Login].
For details about the user name and password, consult your administrator.
The [System] page of Web Image Monitor appears.

F Select [Level 1] or [Level 2] on [Protect Printer Display Panel] in “General Set-
tings”.

G Click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J  Quit SmartDeviceMonitor for Admin.

Note
❒ For details about setting items, see Help in the [Device Settings] on [Configu-

ration] page.
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Changing the Paper Type

Follow the procedure below to change the paper type.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, point to [Device Settings], and then click [Paper].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

E Enter the user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.
The [Paper] page of Web Image Monitor appears.

F Enter required setting items, and then click [OK].

G Click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Note
❒ For details about setting items, see Help in the [Device Settings] on [Configu-

ration] page.
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Managing User Information

Follow the procedure below to manage the user’s information using SmartDe-
viceMonitor for Admin.
Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a printer you want to manage.

D On the [Tools] menu, click [User Management Tool].
The dialog box for entering the user name and password appears.

E Enter the user name and password, and then click [OK].
For details about the user name and password, consult your administrator.
User Management Tool starts.

Note
❒ For details about User Management Tool, see SmartDeviceMonitor for Ad-

min Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tool.
The number of pages printed under each user code appears.

C Click [Exit] on the [File] menu to quit User Management Tool.
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Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a “.csv” file.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tool.

C On the [File] menu, click [Export User Statistics List].

D Specify the save location and file name, and then click [Save].

E Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0

Follow the procedure below to reset the number of pages printed under each
user code to 0.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tool.

C Click the user whose information you want to reset.

D On the [Edit] menu, click [Reset User Counters].

E Select the check box of the items you want to reset, and then click [OK].
A confirmation message appears.

F Click [OK].

G On the [Edit] menu, click [Apply Settings].
Changes are applied to information on the [User Counter Information] tab.

H Click [Exit] on the [File] menu to quit User Management Tool.
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Restricting Functions

Follow the procedure below to restrict use of individual functions.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tool.

C On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

D Select the check box of the functions you want to restrict.

E Click [OK].
A confirmation message appears.

F Click [Yes].
The settings are applied.
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Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

A Start SmartDeviceMonitor for Admin.

B Click the [Access Control List] tab of [User Management Tool].

C On the [Edit] menu, click [Add New User].

D Enter the user code and user name.

E Select the check box of the functions applicable to the new user.
If the check boxes are unavailable, there is no restriction to use that function.
For details, see SmartDeviceMonitor for Admin Help.

F Click [OK].
The new user is added.

G On the [Edit] menu, click [Apply Settings].
The settings are applied.

H Click [Exit] on the [File] menu to quit User Management Tool.

Note
❒ For details about setting restrictions, see SmartDeviceMonitor for Admin

Help.
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

C Select the printer whose settings you want to make.
To make settings for all printers in the selected group, select no printer.

D On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected printer or point to [Set By Group] to
make the settings for all printers in the selected group, and then click [On]
or [Off].

E Quit SmartDeviceMonitor for Admin.

Note
❒ For details about the setting value for Energy Saver mode, see SmartDe-

viceMonitor for Admin Help.
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Setting a Password

Follow the procedure below to set a password.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.
NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter the login user name and password, and then click [Login].
For details about the user name and password, consult your administrator.
Top Page of Web Image Monitor appears.

F Click [Configuration].

G On the [Device Settings], click [Program/Change Administrator], and then change
the settings.

H Click [OK].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.
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Checking the Printer Status

Follow the procedure below to check printer status.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
The status of printers is indicated by icons in the list.
If you are using IPv4 SNMPv3, enter the user authentication.

C To obtain status details, click the printer in the list, and then click [Open] on
the [Device] menu.
The printer status appears in the dialog box.

D Click [System] or [Printer].
The printer status appears in the dialog box.

E Quit SmartDeviceMonitor for Admin.

Note
❒ For details about status icons and items in the dialog box, see SmartDevice-

Monitor for Admin Help.
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Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3]. A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
The status of printers is indicated by icons in the list.
If you are using IPv4 SNMPv3, enter the user authentication.

C Select a printer in the list.

D On the [Tools] menu, click [NIB Setup Tool].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.
NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter the user name and password, and then click [Login].
Top Page of Web Image Monitor appears.
For details about the login user name and password, consult your adminis-
trator.

F Click [Configuration].

G Click [System] on the [Device Settings] area, and then change the settings.

H Click [OK].
• In the [Device Name] box, enter a device name on the printer using up to 31

characters.
• In the [Comment] box, enter a comment on the printer using up to 31 char-

acters.

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.



Viewing and Deleting Spool Print Jobs

07

6

2

Viewing and Deleting Spool Print Jobs

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].
A list of printer using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using IPv4 SNMP v3, enter the user authentication.

C Select a printer in the list, and then click [Spool Printing Job List(Printer)] on the
[Tools] menu.
A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.

D Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.
[Spool Printing Job List] appears in the Web Image Monitor.
To delete the Spool Printing Job, select the document you want to delete and
then click [Delete].

Note
❒ To display [Spool Printing Job List], spool must be set to [Active] on Web Im-

age Monitor in advance.
❒ For details, see Help in the [Spool Printing Job List] area.
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Using SmartDeviceMonitor for Client

To view the status of printers using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor
for Client.

A Right-click the SmartDeviceMonitor for Client icon, point to [Properties],
and then click [Option...].
The [SmartDeviceMonitor for Client - Options] dialog box appears.

B Select the printer you want to monitor, and then select the [To be Monitored]
check box in the Monitoring Information Settings area.
To display the printer status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

C Click [OK].
The dialog box closes and the configured printer is monitored.

Note
❒ For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor
for Client.

A Start SmartDeviceMonitor for Client.

B For status details, right-click the SmartDeviceMonitor for Client icon, and
then click the printer.
The printer status appears in the dialog box.

Note
❒ For details about items in the dialog box, see SmartDeviceMonitor for Cli-

ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:
• The network printer can only receive one print job from SmartDeviceMonitor

for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the
paused status from the print queue window. SmartDeviceMonitor for Client
will resume access to the network printer. You can delete the print job from
the print queue window, but canceling a print job printed by the network
printer might cause the next job sent from another user to be incorrectly print-
ed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the
print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued, enter “https://(printer’s ad-
dress)/”. Internet Explorer must be installed on your computer. Use the
highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the printer using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard,
click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].
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Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper jams, a notification e-mail is
sent to the registered addresses.
You can make the timing and content settings for notification e-mail.
• Call Service
• Out of Toner
• Toner Almost Empty
• Replacement Required: Maintenance Kit
• Paper Misfeed
• Cover Open
• Out of Paper
• Almost Out of Paper
• Paper Tray Error
• Output Tray Full
• Unit Connection Error
• Duplex Unit Error
• Waste Toner Bottle is Full
• Waste Toner Bottle is Almost Full
• Replace Cleaning Web Soon
• File Storage Memory Full Soon
• Log Error

A Open a Web browser, and then enter “http://(printer’s address)/” in the ad-
dress bar.
Top Page of Web Image Monitor appears.
When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued, enter “https://(printer's ad-
dress)/”.

B Click [Login] on Top Page of Web Image Monitor.
The window for entering the login user name and password appears.

C Enter the user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.
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D In the menu area, click [Configuration].

E Click [E-mail] in “Device Settings”.

FMake the following settings:
• Items in the Reception column: Make the necessary settings for sending

and receiving e-mail.
• Items in the SMTP column: Configure the SMTP server. Check your mail-

ing environment, and then specify the necessary items. You can also per-
form mail authentication for the SMTP server.

• Items in the [POP before SMTP] column: Configure the POP server. Check
your mailing environment, and then specify the necessary items. You can
also perform mail authentication for the POP server.

• Items in the [POP3/IMAP4] column: Configure the POP3 or IMAP4 server.
Check your mailing environment, and then specify the necessary items.

• Items in the [E-mail Communication Port] column: Configure the port to be
used for access to the mail server.

• Items in the [E-mail Notification Account] column: Specify these items if you
want to use on-demand e-mail notification.

G Click [OK].
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Auto E-mail Notification

A In the menu area, click [Configuration], and then click [Auto E-mail Notification]
in “Device Settings”.
The dialog box for making notification settings appears.

BMake the following settings:
• Items in the [Notification Message] column: You can set this according to

your needs, for example, the printer’s location, service representative con-
tact information.

• Items in the [Groups to Notify] column: E-mail notification addresses can be
grouped as required.

• Items in the [Select Groups/Items to Notify] column: Select groups for each no-
tification type, such as printer status and error.
To make detailed settings for these items, [Edit] next to [Detailed Settings of
Each Item].

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.

On-demand E-mail Notification

A In the menu area, click [Configuration], and then click [On-demand E-mail Notifi-
cation] in “Device Settings”.
The dialog box for making notification settings appears.

BMake the following settings:
• [Notification Subject]: Enter a text string to be added to the subject line of re-

turn e-mails.
• Items in [Notification Message] column: You can set this according to your

needs, for example, the printer’s location, service representative contact in-
formation.

• Items in the [Access Restriction to Information] column: Select whether to re-
strict accesses based on a specific category of information.

• Items in the [Receivable E-mail Address/Domain Name Settings] column: Enter
an e-mail address or domain name to use for requesting information by e-
mail and to receive its return e-mail.

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.
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Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

❖ SMTP Authentication
Specify SMTP authentication.
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user
name and password. This prevents illegal use of the SMTP server.
A In the menu area, click [Configuration], and then click [E-mail] in “Device Set-

tings”.
B Make the following settings:

• SMTP Authentication: Enable or disable SMTP authentication.
• SMTP Auth. E-mail Address: Enter the e-mail address.
• SMTP Auth. User Name: Enter the SMTP account name.
• SMTP Auth. Password: To set or change the password for SMTP AUTH.
• SMTP Auth. Encryption: Select whether to encrypt the password or not.

[Auto Select]: If the authentication method is PLAIN, LOGIN, CRAM-
MD5, or DIGEST-MD5.
[Active]: If the authentication method is CRAM-MD5 or DIGEST-MD5.
[Inactive]: If the authentication method is PLAIN or LOGIN.

C Click [OK].
D Click [Logout].
E Quit Web Image Monitor.

❖ POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.
A In the menu area, click [Configuration], and then click [E-mail] in “Device Set-

tings”.
B Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.
• POP E-mail Address: Enter the e-mail address.
• POP User Name: Enter the POP account name.
• POP Password: To set or change the POP password.
• Timeout setting after POP Auth.: Enter the time available before con-

necting to the SMTP server after logging on to the POP server.
C Click [OK].
D Click [Logout].
E Quit Web Image Monitor.
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Sending On-demand E-mail

To use on-demand e-mail notification, perform the following configuration
tasks in Web Image Monitor.

A In the menu area, click [Configuration], and then click [E-mail] in “Device
Settings”.

BMake the following settings:
• E-mail Notification E-mail Address: Enter the address using alphanumeric

characters.
• Receive E-mail Notification: Specify whether to use on-demand e-mail no-

tification.
• E-mail Notification User Name: Enter the administrator’s user name as the

mail originator name.
• E-mail Notification Password: Enter the password of the mail notification

user.

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.

❖ Format of on-demand e-mail messages
To use mail notification, you need to send an on-demand e-mail message
to this printer. Using your mail software, enter the following:

Note
❒ A mail message must be within 10 KB in size.
❒ E-mail may be incomplete if sent immediately after power on.

❖ Subject field
Format: devicestatus?parametername=parameter[&=parameter][& =parame-
ter]...

Note
❒ The Subject field is case-insensitive.
❒ Parameter names can be written in any order.

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For 
details, see the table below.

From (Referred to as From) Specify a valid mail address. The device in-
formation will be sent to the address speci-
fied here.
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❖ Subject field coding examples

❖ Parameters

❖ Parameters specifying the information to be obtained

❖ Parameters specifying the mail format

Note
❒ HTML and XML can be selected for subject field, but output is text only.

Item Description

devicestatus?request=sysconfig& for-
mat=text& lang=en

The device’s system configuration infor-
mation will be sent in an English text for-
mat.

devicestatus?request=sysconfig The device’s system configuration infor-
mation will be sent in a preset format and 
language.

Item Meaning Description

request Information to be obtained Mandatory

format Mail format Mail will be sent in the for-
mat preset for each mail 
address.

lang Language for mail body Mail will be sent in the lan-
guage preset for each mail 
address.

Information to be obtained Parameter

System configuration information ysconfi

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Mail format Parameter

Text text

HTML html

XML xml
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❖ Parameters specifying the language for mail body

Language for mail body Parameter

English en

French fr

German de

Italian it

Spanish es

Dutch nl

Russian ru

Portuguese pt



Remote Maintenance by telnet

17

6

2

Remote Maintenance by telnet

Important
❒ Remote Maintenance should be password-protected so that access is allowed

to administrators only.
❒ The password is the same as the one of Web Image Monitor administrator.

When the password is changed using “mshell”, other passwords change also.
❒ Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

Important
❒ Only one user at a time can log on to perform remote maintenance.

A Use the IP address or the host name of the printer to start telnet.
% telnet "IP_address"

B Enter your user name and password.
Contact your administrator for information about the settings.

C Enter a command.

D Quit telnet.
msh> logout

The configuration message about saving the changes appears.

E Enter “yes” to save the changes, and then press the {OK} key.
If you do not want to save the changes, enter “no”, and then press the {OK}
key. To make further changes, enter “return” at the command line, and then
press the {OK} key.

Note
❒ If the message “Can not write NVRAM information” appears, the changes

are not saved. Repeat the procedure above.
❒ When the changes are saved, the network interface board is reset automat-

ically with that changes.
❒ When the network interface board resets, the print job in print process will

be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

❖ View settings
msh> access

❖ IPv4 Configuration
msh> access [×] range "start-address end-address"
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv4 addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range6 192.168.0.10 192.168.0.20

❖ IPv6 Configuration
msh> access [×] range6 "start-address end-address"
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv6 addresses between 2001:DB8::100 and
2001:DB8::200.
msh> access 1 range6 2001:DB8::100 2001:DB8::200

❖ IPv6 access mask Configuration
msh> access [×] mask6 "base-address prefixlen"
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv6 addresses to 2001:DB8::/32
msh> access 1 mask6 2001:DB8:: 32

❖ Access control initialization
msh> access flush

• Use the “flush” command to restore the default settings so that all access
ranges become “0.0.0.0” for IPv4, and “::” for IPv6.



Remote Maintenance by telnet

19

6

2

Note
❒ The access range restricts computers from use of the machine by IP address.

If you do not need to restrict printing, make the setting “0.0.0.0” for IPv4, and
“::” for IPv6.

❒ Valid ranges must be from lower (start address) to higher (end address).
❒ If you are running IPv4 or IPv6, up to five access ranges can be registered and

selected.
❒ IPv6 can register and select the range and the mask for each access ranges.
❒ IPv6 mask ranges between 1 - 128 can be selected.
❒ Up to five access ranges can be specified. The entry is invalid if the target

number is omitted.
❒ You cannot send print jobs, or access Web Image Monitor and diprint from a

restricted IP address.

autonet

Use the “autonet” command to view and configure AutoNet parameters.

❖ View settings
The following command displays the current AutoNet settings:
msh> autonet

❖ Configuration
You can configure AutoNet settings.
msh> autonet {on|off}

• {on} means “active” and {off} means “inactive”.

❖ Current interface priority configuration display
msh> autonet priority

❖ Interface priority configuration
msh> autonet priority "interface_name"

• You can give interface’s AutoNet parameter priority.
• Priority settings are available when multiple interfaces are installed.
• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Note
❒ If an interface is not selected, the current interface connection settings

remain in effect.
❒ For details about AutoNet, refer to autonet parameters.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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bonjour (rendezvous)

Use the “bonjour (rendezvous)” command to display bonjour (rendezvous)-re-
lated settings.

❖ View settings
Bonjour settings are displayed.
msh> bonjour

❖ Bonjour service name setting
You can specify the bonjour service name.
msh> bonjour cname "computer name"

• The computer name can be entered using up to 63 alphanumeric characters.

❖ Bonjour Installation location information setting
You can enter information about the location where the printer is installed.
msh> bonjour location "location"

• Information about location can be entered using up to 32 alphanumeric
characters.

❖ Setting order of priority for each protocol
• diprint

msh> bonjour diprint [0-99]
• lpr

msh> bonjour lpr [0-99]
• ipp

msh> bonjour ipp [0-99]
You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller
numbers indicate higher priority.

❖ IP TTL setting
msh> bonjour ip ttl {1-255}
You can specify the IP TTL (the number of routers a packet can pass through).

Note
❒ The default is 255.

❖ Resetting the computer name and location information
You can reset the computer name and location information.
msh> bonjour clear {cname | location}

• cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

• location
Reset the location information. The previous location information will be
deleted.
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❖ Interface configuration
msh> bonjour linklocal "interface_name"

• If many types of interface are installed, configure the interface that com-
municates with linklocal address.

• If the connected computer's IP address is a link local address specified by
the DHCP's Autonet, and multiple interfaces are connected to the printer,
you can select an interface to communicate through.

• If you do not specify an interface, the Ethernet interface is automatically se-
lected.

• wlan can be specified only when the IEEE 802.11b interface unit is in-
stalled.

❖ Selecting the IPP port number
msh> bonjour ippport {ipp | ssl}

• Appears when SSL is enabled.
• If the “ipp” is selected, the port number is set to “631”. If the “ssl” is select-

ed, the port number is set to “443”.

devicename

Use the “devicename” command to display and change the printer name.

❖ View settings
msh> devicename

❖ Printer name configuration
msh> devicename name "string"

• Enter a printer name using up to 31 alphanumeric characters.
• Set single names for each printer.

❖ Printer name initialization
msh> device name clearname

• Reset the printer name to its default.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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dhcp

Use the “dhcp” command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.
msh> dhcp

❖ Configuration
You can configure DHCP.
msh> dhcp "interface_name" {on|off}

• Click {on} to enable DHCP. Click {off} to disable DHCP.
• If the DNS server address and domain name are obtained from DHCP, be

sure to click {on}.
• wlan can be specified only when the IEEE 802.11b interface unit is in-

stalled.

❖ Current interface priority configuration display
msh> dhcp priority

❖ Interface priority configuration
msh> dhcp priority "interface_name"

• You can select which interface has DHCP parameter priority.
• Priority settings are available when multiple interfaces are installed.

❖ DNS server address selection
msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user.

• To obtain the DNS server address from the DHCP server, specify “dhcp”.
To use the address set by a user, specify “static”.

❖ Domain name selection
msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

• To obtain the domain name from the DHCP server, specify “dhcp”. To use
the domain name set by a user, specify “static”.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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diprint

The direct printing port enables direct printing from a network-connected com-
puter. Use the “diprint” command to change direct printing port settings.

❖ View settings
The following command displays the current direct printing port settings:
msh> diprint
Example output:
port 9100

timeout=300(sec)

bidirect on

con multi

apl async

• The “port” specifies the port number of the direct printing port.
• The “bidirect” setting indicates whether the direct printing port is bidirec-

tional or not.

❖ Setting timeout
msh> diprint timeout [30~65535]
• You can specify the timeout interval to use when the printer is expecting

data from the network.
• The default is 300 seconds.

❖ Specifying the number of concurrent connections
msh> diprint conn {multi | single}

• The above command specifies the number of concurrent diprint connec-
tions. Specify “multi” for multiple connections or “single” for a single con-
nection.

• The default is “multi”.
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dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

❖ View settings
The following command displays current DNS settings:
msh> dns

❖ IPv4 DNS server configuration
The following command enables or disables the IPv4 DNS server address:
msh> dns "number" server "server address"
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:
msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.
• You can register up to three IPv4 DNS server numbers.
• You cannot use “255.255.255.255” as the DNS server address.

❖ IPv6 DNS server configuration
The following command enables or disables the IPv6 DNS server address:
msh> dns "number" server6 "server address"

• You can register IPv6 DNS Server address.
• You can register up to three IPv6 DNS server numbers.

❖ Dynamic DNS function setting
msh> dns "interface_name" ddns {on|off}

• You can set the dynamic DNS function “active” or “inactive”.
• {on} means “active” and {off} means “inactive”.
• wlan can be specified only when the IEEE 802.11b interface unit is in-

stalled.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Specifying the record overlap operation
msh> dns overlap {update|add}

• You can specify operations performed when records overlap.
• update

To delete old records and register new records.
• add

To add new records and store the old records.
• When CNAME overlaps, it is always changed, irrespective of settings.

❖ CNAME registration
msh> dns cname {on|off}

• You can specify whether to register CNAME.
• {on} means “active” and {off} means “inactive”.
• The CNAME registered is the default name beginning with rnp. CNAME

cannot be changed

❖ A records registration
msh> dns arecord {dhcp|own}

• dhcp
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

• own
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

❖ Record updating interval settings
msh> dns interval "time"

• You can specify the interval after which records are updated when using
the dynamic DNS function.

• The updating interval is specified hourly. It can be entered between 1 and
255 hours.

• The default is 24 hours.
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domainname

Use the “domainname” command to display or configure the domain name set-
tings.
You can configure the Ethernet interface or IEEE 802.11b interface.

❖ View settings
The following command displays the current domain name:
msh> domainname

❖ Interface domain configuration
msh> domainname "interface_name"

❖ Setting the Domain Name
msh> domainname "interface_name" name "domain name"

• A domain name can be entered using up to 63 alphanumeric characters.
• The Ethernet interface and IEEE 802.11b interface will have the same do-

main name.
• wlan can be specified only when the IEEE 802.11b interface unit is in-

stalled.

❖ Deleting the Domain Name
msh> domainname "interface_name" clear "name"

help

Use the “help” command to display the available command list and the proce-
dures for using those commands.

❖ Command list display
msh> help

❖ Display of procedure for using commands
msh> help "command_name"

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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hostname

Use the “hostname” command to change the printer name.

❖ View settings
msh> hostname

❖ IPv4 Configuration
msh> hostname "interface_name" "printer_name"

• Enter the printer name using up to 63 alphanumeric characters.
• You cannot use a printer name starting with “RNP” or “rnp”
• The Ethernet interface and IEEE 802.11b interface will have the same print-

er name.
• wlan can be specified only when the IEEE 802.11b interface unit is in-

stalled.

❖ Initializing the printer name for each interface
msh>hostname "interface_name" clear "name"

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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ifconfig

Use the “ifconfig” command to view and configure TCP/IP (IP address, subnet
mask, broadcast address, default gateway address) for the printer.

❖ View settings
msh> ifconfig

❖ IPv4 Configuration
msh> ifconfig "interface_name" "parameter" "address"

• If you did not enter an interface name, it is automatically set to the Ethernet
interface.

• wlan can be specified only when the IEEE 802.11b interface unit is in-
stalled.

The following explains how to configure an IPv4 address 192.168.15.16 on
Ethernet interface.
msh> ifconfig ether 192.168.15.16

❖ IPv6 Configuration
msh> ifconfig ether inet6 "interface_name" "prefixlen"
The following explains how to configure a IPv6 address to 2001:DB8::100 with
prefix length 64 on the Ethernet interface.
msh> ifconfig ether inet6 2001:DB8::100 64

❖ Netmask configuration
msh> ifconfig "interface_name" netmask "address"
The following explains how to configure a subnet mask 255.255.255.0 on
Ethernet interface.
msh> ifconfig ether netmask 255.255.255.0

❖ Broadcast address configuration
msh> ifconfig "interface_name" broadcast "address"

❖ Changing the Interface
msh> ifconfig "interface" up
You can specify either the Ethernet interface or IEEE 802.11b interface when
using the optional IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b Interface
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Note
❒ To get the above addresses, contact your administrator.
❒ Use the default configuration if you cannot obtain setting addresses.
❒ The IP address, subnet mask and broadcast address are the same as that for

the ethernet interface and IEEE 802.11b interface.
❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface.

If interfaces are changed, the new interface inherits the configuration.
❒ Use “0x” as the initial two letters of a hexadecimal address.

info

Use the “info” command to display printer information such as paper tray, out-
put tray, and printer language.

❖ Printer information display
msh> info

Reference
p.254 “Getting Printer Information over the Network”.
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ipp

Use the “ipp” command to view and configure IPP settings.

❖ Viewing settings
The following command displays the current IPP settings:
msh> ipp

❖ IPP timeout configuration
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.
msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is
“off”.
msh> ipp auth {basic|digest|off}

• User authorization settings are “basic” and “digest”.
• Use “off” to remove a user’s authorization.
• If user authorization is specified, register a user name. You can register up

to 10 users.

❖ IPP user configuration
Configure IPP users according to the following messages:
msh> ipp user
The following message appears:
msh> Input user number (1 to 10):
Enter the number, user name, and password.
msh> IPP user name:user1

msh> IPP password:*******
After configuring the settings, the following message appears:
User configuration changed.
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ipv6

Use the “ipv6” command to display and configure IPv6 settings

❖ View Setting
msh> ipv6

❖ IPv6 stateless address
msh> ipv6 stateless {on|off}

• If “on” is selected, IPv6 requests information required for maintaining
stateful connection to the router for as long as the printer power is turned
on. This setting allows information from the router to be obtained con-
stantly, and periodically refreshes the effective period of the stateless ad-
dress.

lpr

Use the “lpr” command to view and configure LPR settings.

❖ View Setting
msh> lpr

❖ Checking host name when deleting the job
msh> lpr chkhost {on|off}

• If “on” is selected, you can delete print jobs only from the IP address of the
host that sent the print job. If LPR is disabled, you can also delete print jobs
sent from the IP addresses other than that of the host.



Monitoring and Configuring the Printer

232

6

netware

Use the “netware” command to configure the NetWare settings such as the print
server name or file server name.

❖ Netware Printer Server Names
msh> netware pname "character string"

• Enter the NetWare print server name using up to 47 characters.

❖ Netware File Server Names
msh> netware fname

• Enter the NetWare file server name using up to 47 characters.

❖ Encap type
msh> netware encap {802.3|802.2|snap|ethernet2|auto}

❖ Remote Printer Number
msh> netware rnum {0-254}

❖ Timeout
msh> netware timeout {3-255}

❖ Printer server mode
msh> netware mode pserver

msh> netware mode ps

❖ Remote printer mode
msh> netware mode rprinter

msh> netware mode rp

❖ NDS context name
msh> netware context "character string"

❖ SAP interval
msh> netware "sap_interval"

❖ Setting login mode for file server
msh> netware login server
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❖ Setting login mode for NDS tree
msh> netware login tree

❖ Setting login mode for NDS tree name
msh> netware tree "NDS name"

❖ File transfer protocol
msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}
If you do not specify the protocol, the current setting is displayed.

passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password
msh> passwd

• Enter the current password.
• Enter the new password.
• Renter the new password to confirm it.

❖ Changing the Password of the administrators using the Supervisor
msh> passwd {Administrator ID}

• You can delete the administrator password or set up a new one.
• Enter the new password.
• Renter the new password to confirm it.

Note
❒ Be sure not to forget or lose the password.
❒ The password can be entered using up to 32 alphanumeric characters. Pass-

words are case-sensitive. For example, “R” is not the same as “r”.

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX
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pathmtu

Use the “pathmtu” command to display and configure the PathMTU Discovery
service function.

❖ View Setting
msh> pathmtu

❖ Enabling / disabling the PathMTU Discovery service
msh> pathmtu{on|off}

• The default is “on”.
• If the MTU size of the sent data is larger than the router's MTU, the router

will declare it impassable, and communication fails. If this happens, select-
ing the “pathmtu” to “off” optimizes the MTU size and prevents data out-
put failure.

• Depending on the environment, information might not be obtained from
the router, and communication will fail. If this happens, select the “pathm-
tu” to “off”.

prnlog

Use the “prnlog” command to obtain printer log information.

❖ Print logs display
msh> prnlog

• Displays 16 previous print jobs.
msh> prnlog "ID Number"

• Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

Reference
p.254 “Getting Printer Information over the Network”.
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route

Use the “route” command to view and control the routing table.

❖ All route information display
msh> route get "destination"

• Specify the IPv4 address to destination.
“0.0.0.0” cannot be specified as destination address.

• If you do not specify a destination address, all the information about the
router is displayed.

❖ Enabling/disabling Specified IPv4 Destination
msh> route active {host|net} "destination" {on | off}

• You can turn the specified destination on or off. Host becomes the default
setting.

❖ Adding IPv4 Routing Table
msh> route add {host|net} "destination" "gateway"

• Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table.

• Specify the IPv4 address to destination and gateway.
• Host becomes the default setting.

❖ Setting Default IPv4 Gateway
msh> route add default gateway

❖ Deleting specified IPv4 destination from Routing Table
msh> route delete {host|net} "destination"

• Host becomes the default setting.
• IPv4 address of destination can be specified.

❖ Setting IPv6 Default Gateway
msh> route add6 default "gateway"

❖ Adding a specified IPv6 destination to Routing Table
msh> route add6 "destination" "prefixlen" "gateway"

• Specify the IPv6 address to destination and gateway.

❖ Deleting a specified IPv6 destination from Routing Table
msh> route delete6 "destination" "prefixlen"

• Specify the IPv6 address to destination and gateway.
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❖ Display information about a specified IPv6 route information
msh> route get6 "destination"

• Specify the IPv6 address to destination and gateway.

❖ Enabling/disabling a specified IPv6 destination
msh> route active6 "destination" "prefixlen" {on | off}

❖ Route initialization
msh> route flush

Note
❒ The maximum number of IPv4 routing tables is 16.
❒ The maximum number of IPv6 routing tables is 2.
❒ Set a gateway address when communicating with devices on an external net-

work.
❒ The same gateway address is shared by all interfaces.
❒ “Prefixlen” is a number between 1 and 128.
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set

Use the “set” command to set the protocol information display “active” or “in-
active”.

❖ View settings
The following command displays protocol information (active/inactive).
msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, Net-
ware, SCSI print, and SMB appears.

msh> set usb

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu

msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set nbt

msh> set ssdp

msh> set ssh
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msh> set sftp

msh> set sftp6

❖ Configuration
• Enter “up” enable protocol, and enter “down” to disable protocol.

You can set the protocol to “active” or “inactive”.
msh> set ipv4 {up | down}

• If you disable IPv4, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http,
bonjour, and sftp.
msh> set ipv6 {up | down}

• If you disable IPv6, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, and
sftp6.
msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set lpr {up | down}

msh> set lpr6 {up | down}

msh> set ftp {up | down}

msh> set ftp6 {up | down}

msh> set rsh {up | down}

msh> set rsh6 {up | down}

msh> set diprint {up | down}

msh> set diprint6 {up | down}

msh> set web {up | down}

msh> set snmp {up | down}

msh> set ssl {up | down}

msh> set ssl6 {up | down}
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• If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.
msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set rfu6 {up | down}

msh> set ipp {up | down}

msh> set ipp6 {up | down}

msh> set http {up | down}

msh> set http6 {up | down}

msh> set bonjour {up | down}

msh> set ssh {up | down}

msh> set ssdp {up | down}

msh> set nbt {up | down}

msh> set sftp {up | down}

msh> set sftp6 {up | down}

show

Use the “show” command to display network interface board configuration set-
tings.

❖ View settings
msh> show

• If “-p” is added, you can view settings one by one.

Reference
p.258 “Understanding the Displayed Information”.

slp

Use “slp” command to view and configure SLP settings.
msh> slp ttl "ttl_val"

• You can search the NetWare server using SLP in the PureIP environment of
NetWare 5/5.1 and Netware 6/6.5. Using the “slp” command, you can con-
figure the value of TTL which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.
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smb

Use the “smb” command to configure or delete the computer or workgroup
name for SMB.

❖ Computer Name settings
msh> smb comp "computer name"

• Set computer name using up to 15 characters. Names beginning with
“RNP” or “rnp” cannot be entered.

❖ Working Group Name settings
msh> smb group "work group name"

• Set workgroup name using up to 15 characters

❖ Comment settings
msh> smb comment "comment"

• Set comment using up to 31 characters

❖ Notify print job completion
msh> smb notif {on | off}

• To notify print job completion, specify “on”. Otherwise, specify “off

❖ Deleting Computer Nam
msh> smb clear comp

❖ Deleting Group Name
msh> smb clear group

❖ Deleting Comment
msh> smb clear comment

❖ View Protocol
msh> smb protocol
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snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

❖ View settings
msh> snmp

• Default access settings 1 is as follows:
Community name:public
IPv4 address:0.0.0.0
IPv6 address:::
IPX address:00000000:000000000000
Access type:read-only
Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:
Community name:admin
IPv4 address:0.0.0.0
IPv4 address:0.0.0.0
IPX address:00000000:000000000000
Access type:read-write
Effective Protocol:IPv4/IPv6/IPX

• If “-p” is added, you can view settings one by one.
• To display the current community, specify its registration number.

❖ Display
msh> snmp

❖ Community name configuration
msh> snmp "number" name "community_name"

• You can configure ten SNMP access settings numbered 1-10.
• The printer cannot be accessed from SmartDeviceMonitor for Admin or

SmartDeviceMonitor for Client if “public” is not registered in numbers 1-
10. When changing the community name, use SmartDeviceMonitor for
Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

❖ Deleting community name
msh> snmp "number" clear name
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❖ Access type configuration
msh> snmp "number" type "access_type"

❖ Protocol configuration
msh> snmp {ipv4|ipv6|ipx} {on|off}

• Use the following command to set protocols “active” or “inactive”: If you
set a protocol “inactive”, all access settings for that protocol are disabled.

• Specify “ipv4” for IPv4, “ipv6” for IPv6, or “ipx” for IPX/SPX.
• {on} means “active” and {off} means “inactive”.
• All protocols cannot be turned off concurrently.

❖ Configuration of protocol for each registration number
msh> snmp "number" active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, acti-
vating it here has no effect.

❖ Access configuration
msh> snmp "number" {ipv4|ipv6|ipx} "address"

• You can configure a host address according to the protocol used.
• The network interface board accepts requests only from hosts that have

IPv4, IPv6, and IPX addresses with access types of “read-only” or “read-
write”. Enter “0” to have network interface board accept requests from any
host without requiring a specific type of access.

• Enter a host address to deliver “trap” access type information to.
• To specify IPv4 or IPv6, enter “ipv4” or “ipv6” followed by a space, and

then the IPv4 or IPv6 address.
• To specify IPX/SPX, enter “ipx” followed by a space, the IPX address followed

by a decimal, and then the MAC address of the network interface board.

❖ sysLocation configuration
msh> snmp location

❖ Deleting sysLocation
msh> snmp clear location

❖ sysContact setting
msh> snmp contact

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trapmessages
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❖ Deleting sysContact
msh> snmp clear contact

❖ SNMP v1v2 function configuration
msh> snmp v1v2 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP v3 function configuration
msh> snmp v3 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP TRAP configuration
msh> snmp trap {v1|v2|v3} {on|off}

• Specify “on” to enable, and “off” to disable.

❖ Remote Configuration Authorization configuration
msh> snmp remote {on|off}

• Specify “on” to enable, and “off” to disable the SNMP v1v2 setting.

❖ SNMP v3 TRAP configuration display
msh> snmp v3trap

msh> snmp v3trap {1-5}
If a number from 1-5 is entered, settings are displayed for that number only.

❖ Configuring a sending address for SNMP v3 TRAP
msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} "address"

❖ Configuring a sending protocol for SNMP v3 TRAP
msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

❖ Configuring a user account for SNMP v3 TRAP
msh> snmp v3trap {1-5} account "account_name"
Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account
msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm
msh> snmp v3auth {md5|sha1}

❖ Configuring SNMP v3 encryption
msh> snmp v3priv {auto|on}
Set “auto” for automatic encryption configuration
Set “on” for mandatory encryption configuration.
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sntp

The printer clock can be synchronized with a NTP server clock using Simple
Network Time Protocol (SNTP). Use the “sntp” command to change SNTP set-
tings.

❖ View settings
msh> sntp

❖ NTP server address configuration
You can specify the IP address of the NTP server.
msh> sntp server "IP_address"

❖ Interval configuration
msh> sntp interval "polling_time"

• You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.
• If you set 0, the printer synchronizes with the NTP server only when you

turn the printer on. After that, the printer does not synchronize with the
NTP server.

❖ Time-zone configuration
msh> sntp timezone "+/-hour_time"

• You can specify the time difference between the printer clock and NTP
server clock. The values are between -12:00 and +13:00.
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spoolsw

Use the “spoolsw” command to view and configure Job Spool settings.
You can only specify diprint, lpr, ipp, ftp, smb and sftp protocol.

❖ View settings
The Job Spool setting appears.
msh> spoolsw

❖ Job Spool setting
msh> spoolsw spool {on | off}

Note
❒ Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting
msh> spoolsw clear job {on | off}

• When the printer power is cut during job spooling, this determines wheth-
er to reprint the spooled job.

❖ Protocol configuration
msh> spoolsw diprint {on | off}

msh> spoolsw lpr {on | off}

msh> spoolsw ipp {on | off}

msh> spoolsw smb {on | off}

msh> spoolsw ftp {on | off}

msh> spoolsw sftp {on | off}

• You can specify the settings for diprint, lpr, ipp, smb and sftp.

ssdp

Use the “ssdp” command to view and configure SSDP settings.

❖ View settings
msh> ssdp

❖ Setting effective time
msh> ssdp profile {1801-86400}
The default is 10800 seconds.

❖ Advertise packet TTL settings
msh> ssdp ttl {1-255}
The default is 4.
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ssh

Use the “ssh” command to view and configure SSH settings.

❖ View settings
msh> ssh

❖ Data compression communication settings
msh> ssh compression {on|off}
The default is “on”.

❖ SSH/SFTP communication port setting
msh> ssh port {22, 1024-65535}
The default is 22.

❖ SSH/SFTP communication timeout setting
msh> ssh timeout {0-65535}
The default is 300.

❖ SSH/SFTP communication login timeout setting
msh> ssh logintimeout {0-65535}
The default is 300.

❖ Setting an open key for SSH/SFTP
msh> ssh genkey {512|768|1024} "character string"
Create an open key for SSH/SFTP communication.
Usable characters are ASCII 0x20-0x7e (32 bytes) other than “0”.
The default key length is 1024, and the character string is blank.

❖ Deleting open key for ssh/sftp communication
msh> ssh delkey

Note
❒ If you do not specify a character string, current setting is displayed.
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status

Use the “status” command to display the printer status.

❖ Messages
msh> status

Reference
p.254 “Getting Printer Information over the Network”.

syslog

Use the “syslog” command to display the information stored in the printer’s sys-
tem log.

❖ View message
msh> syslog

Reference
p.267 “Message List”.

upnp

Use the “upnp” command to display and configure the universal plug and play.

❖ Public URL display
msh> upnp url

❖ Public URL configuration
Msh< upnp url "string"

• Enter the URL string in the character string.



Monitoring and Configuring the Printer

248

6

web

Use the “web” command to display and configure parameters on Web Image
Monitor.

❖ View Settings
msh> web

❖ URL Configuration
You can set URLs linked by clicking URL on Web Image Monitor.
msh> web url http://"The URL or IP address you want to
register"/

• Specify “1” or “2” for x as the number corresponding to the URL. Up to two
URLs can be registered and specified.

❖ Deleting URLs registered as link destinations
msh> web x clear url
Specify “1” or “2” for x as the corresponding number to the URL.

❖ Link name configuration
You can enter the name for URL that appears on Web Image Monitor.
msh> web name "Name you want to display"

• Specify “1” or “2” for x as the corresponding number to the link name.

❖ Resetting URL names registered as link destinations
msh> web x clear name

• Specify “1” or “2” for x as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.
msh> web help http://"Help URL or IP address"/help/

❖ Deleting Help URL
msh> web clear help
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wiconfig

Use the “wiconfig” command to make settings for IEEE 802.11b.

❖ View settings
msh> wiconfig

❖ View IEEE 802.11b settings
msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.

❖ Configuration
msh> wiconfig "parameter"

Parameter Value configured

mode {ap|ad-
hoc|802.11adhoc}

You can set the infrastructure mode (ap) , the 802.11 ad 
hoc mode (802.11adhoc), or the ad hoc mode (adhoc).

The default is ad hoc mode.

ssid "ID value" You can make settings for the SSID in the infrastructure 
mode.

Usable characters are ASCII 0x20-0x7e (32 bytes).

An SSID value is set automatically to the nearest access 
point if no setting is made.

If no setting is made for the ad hoc mode, the same value 
as for the infrastructure mode or an ASSID value is auto-
matically set. The default is blank.

channel frequency 
"channel no."

You can enable or disable the WEP function. To enable 
the WEP function, specify [on]; to disable it, specify [off].

To start the WEP function, enter the correct WEP key. The 
default is “11”.

key "key value" val 
{1|2|3|4}

You can specify the WEP key when entering in hexadeci-
mal.

With a 64-bit WEP, you can use 10 digit hexadecimals. 
With a 128-bit WEP, you can use 26 digit hexadecimals.

Up to four WEP keys can be registered. Specify the num-
ber to be registered with “val”.

When a WEP is specified by key, the WEP specified by 
key phrase is overwritten.

To use this function, set the same key number and WEP 
key for all ports that transmit data to each other. Put “0x” 
on the front of WEP key.

You can omit the numbers with “val”. The key number is 
set to 1 when making these omissions. The default is blank.
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keyphrase "phrase" 
val {1|2|3|4}

You can specify the WEP key when entering in ASCII.

With a 64-bit WEP, you can use 10 digit hexadecimals. 
With a 128-bit WEP, you can use 26 digit hexadecimals.

Up to four WEP keys can be registered. Specify the num-
ber to be registered with “val”.

When a WEP is specified by key phrase, the WEP speci-
fied by key is overwritten.

To use this function, set the same key number and WEP 
key for all ports that transmit data to each other.

You can omit the numbers with “val”. The key number is 
set to 1 when making these omissions.

encval {1|2|3|4} You can set an authorization mode when using WEP. The 
specified value and authorized mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [au-
to|11m|5.5m|2m|1m]

You can set the IEEE 802.11b transmitting speed.

The speed you specify here is the speed at which data is 
sent. You can receive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security 
{none|wep|wpa}

You can specify the security mode.

none: No encryption(default)S

wep: WEP encryption

wpa: WPA encryption

wpaenc  {tkip|ccmp} You can specify WPA encryption key when using WPA 
encryption.

tkip: TKIP (default)

ccmp: CCMP (AES)

wpaauth {wpapsk | 
wpa}

You can specify the WPA authentication mode when us-
ing WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA(802.1X) authentication

psk "character 
string"

You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63 bytes).

The default is blank.

Parameter Value configured
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Note
❒ You can use this command only when the IEEE 802.11b interface unit is in-

stalled.

eap 
{tls|ttls|leap|peap
} {chap|msc-
hap|mschapv2|pap|md
5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are settings for 
the phase 2 method, and must be set when using EAP-
TTLS or PEAP.

Do not make these settings when using other EAP au-
thentication types.

If you select EAP-TTLS, you can select chap, mschap, 
mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 or tls.

username "charac-
ter string"

You can specify the login user name for the Radius server.

Usable characters: ASCII 0x20-0x7e(31 bytes) other than 
“@”. The default is blank.

username2 "charac-
ter string"

You can specify the phase 2 username for EAP-
TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 bytes) other than 
“@”. The default is blank.

domain "character 
string"

You can specify the login domain name for the Radius 
server.

Usable characters: ASCII0x20-0x7e (31 bytes) other than 
“@”. The default is blank.

password "charac-
ter string"

You can specify the login password for the Radius server.

Usable characters: ASCII 0x20-0x7e(128 bytes). The de-
fault is blank.

srvcert {on | off} You can set the server certificate. The default is “off”.

imca {on | off} You can enable or disable the certificate when the inter-
mediate certificate authority is present. The default is 
“off”.

srvid "character 
string"

You can set the server ID and subdomain of the certificate 
server.

Parameter Value configured
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wins

Use the “wins” command to configure WINS server settings.

❖ Viewing settings
msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 ad-
dress, the DHCP address is the valid address.

❖ Configuration
msh> wins "interface_name" {on | off}

• {on} means “active” and {off} means “inactive”.
• Be sure to specify the interface.
• wlan can be specified only when the IEEE 802.11b interface unit is in-

stalled.

❖ Address configuration
Use the following command to configure a WINS server IP address:
msh> wins "interface_name" {primary|secondary} "IP ad-
dress"

• Use the “primary” command to configure a primary WINS server IPv4 ad-
dress.

• Use the “secondary” command to configure a secondary WINS server IPv4
address.

• Do not use “255.255.255.255” as the IPv4 address.

❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.
msh> wins "interface_name" scope "scope ID"

• The scope ID can be entered using up to 31 alphanumeric characters.
• Be sure to specify the interface.
• wlan can be specified only when the IEEE 802.11b interface unit is in-

stalled.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface



SNMP

53

6

2

SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in
Ethernet board and optional IEEE 802.11b interface unit of this printer.
Using the SNMP manager, you can get information about the printer.

Important
❒ If you changed the printer’s community name, change the configuration of

the connected computer accordingly, using SNMP Setup Tool bundled with
SmartDevice Monitor for Client. For details, see SNMP Setup Tool Help.

The default community names are [public] and [admin].

❖ Start SNMP Setup Tool
• Windows 95/98/Me, Windows 2000, Windows NT 4.0:

Click the [Start] button.
Point to SmartDeviceMonitor for Admin on the [Programs] menu.
Click [SNMP Setup Tool].

• Windows XP:
Click the [Start] button.
Point to SmartDeviceMonitor for Admin on the [All Programs] menu.
Click [SNMP Setup Tool].

❖ Supported MIBs(SNMPv1/v2)
• MIB-II
• PrinterMIB
• HostResourceMIB
• RicohPrivateMIB

❖ Supported MIBs(SNMPv3)
• MIB-II
• PrinterMIB
• HostResourceMIB
• RicohPrivateMIB
• SNMP-FRAMEWORK-MIB
• SNMP-TARGET-MIB
• SNMP-NOTIFICATION-MIB
• SNMP-USER-BASED-SM-MIB
• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the Network

This section explains details of each item displayed in the printer status and in-
formation.
• UNIX: Use the “lpq” command and “rsh”, “rcp”, “ftp” and “sftp” parameters.
• mshell: Use the “status” command.

Messages Description

Access Restricted The job was canceled because user have no au-
thority.

Adjusting... The printer is initializing or calibrating.

Call Service Center There is a malfunction in the printer.

Canceled The job is reset.

Canceling Job... The job is being reset.

Cannot multi-install: SD Card SD card you are trying to install has already 
been installed in a different machine.

Card/Counter not inserted The printer is waiting for prepaid card or key.

Coin or amount not inserted The printer is waiting for coin to be inserted.

Coin/Key Counter not inserted The printer is waiting for coin or key counter.

Configuring... Setting is being changed.

Cooling Down Fusing Unit... Fusing unit is cooling down.

Cover Open: Finisher The cover of Finisher is open.

Data Size Error The data size error occurred.

Empty: Black Toner The black toner cartridge is almost empty.

Energy Saver Mode The printer is in Energy Saver Mode.

Error An error has occurred.

Error: Address Book An error has occurred in the data of the ad-
dress book.

Error: Command Transmission An error has occurred in the printer.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Memory Switch A memory error occurred.

Error: Optional Font An error has occurred in the font file of the 
printer.

Error: PDL An error has occurred in the page description 
language.

Error: Rem. Certificate Renewal An error has occurred in the remote certificate 
renewal.
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Error: USB Interface An error has occurred in the USB interface.

Error: Wireless Board An error has occurred in the wireless board.

Error: Wireless Card Wireless card is not inserted during start up, 
or the IEEE 802.11b interface unit or the wire-
less card is taken out after start up.

In Use: Finisher Other functions is using Finisher.

In Use: Input Tray Other functions is using the input tray.

Key Card not inserted The printer is waiting for key card to be inserted.

Key Card/Counter not inserted The printer is waiting for key card or key 
counter to be inserted.

Key Counter not inserted The printer is waiting for key counter to be left 
in it.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or 
toner is almost running out.

Low: Toner The black toner cartridge is not set correctly, or 
toner is almost running out.

Malfunction: Finisher There is a problem with Finisher.

Malfunction: Output Tray There is a problem with output tray.

Memory Low: Data Storage Memory shortage has occurred while the doc-
ument was being accumulated.

Miscellaneous Error Other error has occurred.

Mismatch: Paper Size Indicated paper tray does not contain paper of 
selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of 
selected size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of 
selected type.

Near Replacing: Black PCU Prepare the new black photoconductor unit.

Near Replacing: Fusing Unit Prepare the new fusing unit.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

No Paper: Selected Tray There is no paper in specified tray.

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Offline Printer is offline.

Messages Description
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Note
❒ For details about UNIX commands, see UNIX Supplement.
❒ Check the error contents that may be printed in the configuration page.

Reference
For details about printing a configuration page, see p.126 “List/Test Print
Menu”.

Operating Thermo-range Error Exceeded appropriate thermo range.

Panel Off Mode The printer is in Panel-Off mode.

Paper in Finisher The paper remains in Finisher.

Prepaid Card not inserted The printer is waiting for prepaid card to be in-
serted.

Print Complete The print was completed.

Printing Printing is in progress.

Processing Data is being processed.

Proxy Address/Port Incorrect Proxy address or Port No. is incorrect.

Ready The printer is ready to print.

Renewing Remote Certificate Remote Certificate is Renewing.

Replace Black PCU It is time to replace the black photoconductor 
unit.

Replace Fusing Unit It is time to replace the fusing unit.

SD Card Authentication failed SD card authentication failed.

SD Card not inserted SD card is not inserted correctly.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed.

Waiting for Job Suspension All jobs are being suspended.

Warming Up... The printer is warming up.

Messages Description
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Printer configuration

You can check the printer configuration using telnet.
This section explains the checking procedure for input/output tray and printer
language.
• UNIX: Use the “info” command and “rsh”, “rcp”, “ftp” and “sftp” parameters.
• mshell: Use the “info” command.

❖ Input Tray

❖ Output Tray

❖ Printer Language

Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.

Reference
For details about mshell “info” commands, see p.217 “Remote Maintenance
by telnet”.

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

status Current status of the paper tray

• Normal: Normal

• NoInputTray: No tray

• PaperEnd: No paper

Item Description

No. ID number of the output tray

Name Name of the output tray

status Current status of the output tray

• Normal: Normal

• PaperExist: Paper exist

• OverFlow: Paper is full

• Error: Other errors

Item Description

No. ID number of the printer language used by 
the printer

Name Name of the printer language used in the 
printer

Version Version of the printer language
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Understanding the Displayed Information

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:
• UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters.
• mshell: Use the “info” command.

Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.

Reference
For details about mshell “info” commands, see p.217 “Remote Maintenance
by telnet”.

Item Description

Rank Print job status. 

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.
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Print Log Information

This is a record of the most recent 16 jobs printed.
Use the following command to display print log information:
• UNIX: Use the “prnlog” command and “rsh”, “rcp”, and “ftp” parameters.
• telnet : Use the “prnlog” command.

Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.

Reference
For details about mshell prnlog commands, see p.217 “Remote Maintenance
by telnet”.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result Print Request Result

Communication Result

• OK
Print was completed normally. However, 
the print result may not be as required due 
to printer problems.

• NG
Printing was not completed normally.

• Canceled
An “rcp”, “rsh”, or “lpr” command print 
request was canceled, possibly due to the 
printing application. Not applicable to the 
“ftp” or “rprinter” command.

Time Time the print requested was received.

Time of print request reception
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Configuring the Network Interface Board

Use the following command to display network interface board settings:
• telnet : Use the “show” command.

Item Description

Common

Mode

Protocol Up/Dow Protocol Settings

AppleTalk

IPv4

IPv6

NetWare

SMB

SCSI print

Device Up/Down Device Settings

USB

Ethernet interface

Syslog priority

NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk Settings

Mode

Net

Object

Type

Zone
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TCP/IP

Mode (IPv4)

Mode (IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

Bonjour

ssl

nrs

rfu

nbt

ssdp

ssh

sftp

IPv4 TCP/IP Settings

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless Address

Manual

Gateway

EncapType

Host name

DNS Domain

Item Description
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Access Control Access Control Settings

IPv4

Access Entry [X] X can be set between 1 and 5.

IPv6

Access Entry [X] X can be set between 1 and 5.

Time server Time Settings

Time Zone

Time server polling time

SYSLOG server Websys Settings

Home page URL1

Home page link name1 URL of home page

Home page URL2

Home page link name2

Help page URL

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Login Mode

Print job timeout

Protocol

SAP interval time

NDS Tree Name NDS tree name

Transfer Protocol

Item Description
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SMB SMB Settings

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name [1]

Protocol

IEEE 802.11b IEEE 802.11b Settings

Host name

Communication Mode

SSID

Channel range

Channel

TX Rate

Security

WEP Authentication

WEP Encryption key number

WEP Encryption keys [X] X can be set between 1 and 5.

WPA Encryption

WPA Authentication

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 user name

Phase 2 Method TTLS

Phase 2 Method PEAP

Server cert

Intermediate CA

Server ID

Item Description
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DNS DNS Settings

IPv4

Server [X] X can be set between 1 and 3.

Select IPv4 DNS Server

IPv6

Server [X] X can be set between 1 and 3.

Domain Name

ether

wlan

DDNS

ether

wlan

WINS WINS Settings

ether

Primary WINS

Secondary WINS

Wlan

Primary WINS

Secondary WINS

SSDP SSDP Settings

UUID

Profile

TTL

UPnP UPnP Settings

URL

Item Description
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Bonjour Bonjour Settings

Computer Name (cname)

Local Hostname (ether)

Local Hostname (wlan)

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route

for Multi I/F:

IPP Port

SNMP SNMP Settings

SMNPv1v2

SMNPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2

Remote Setting

SNMPv3 Privacy

ssh ssh Settings

Compression

Port

Timeout

LoginTimeOut

Item Description
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AuthFree Authfree Settings

IPv4

AuthFree Entry [X] X can be set between 1 and 5.

IPv6

AuthFree Entry [X] X can be set between 1 and 5.

USB

LPR

Iprm check host

lpr prnerrchk

Certificate

Verification

Shell mode Remote maintenance tool mode

Item Description
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Message List

This is a list of messages that appear in the printer’s system log. The system log
can be viewed using the “syslog” command.

System Log Information

Use the following command to display the system log information:
• UNIX: Use the “syslog” command and “rsh”, “rcp”, “ftp”, and “sftp” param-

eters.
• telnet : Use the “syslog” command.

Message Problem and solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect.

(In the print server mode) Login to the file 
server failed. Make sure that the print server is 
registered on the file server. If a password is 
specified for the print server, delete it.

account is unavailable: Same account name be 
used.

User account is disabled. This could be be-
cause it use the same account name as the ad-
ministrator account.

account is unavailable: The authentication 
password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set, 
and only the encryption account is set.

account is unavailable: encryption is impossi-
ble.

Encryption is not possible and account is dis-
abled. This could be because:

• Security option is not installed.

• Encryption password has not been speci-
fied.

add_sess_IPv4: bad trap <IPv4 address>, com-
munity: <community name>

The IPv4 address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IPv4 address for the TRAP destina-
tion.

add_sess_IPv6: bad trap <IPv6 address>, com-
munity: <community name>

The IPv6 address [::] is unavailable when the 
community access type is TRAP. Specify the 
host IPv6 address for the TRAP destination.

add_sess_IPv4: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_IPv6: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_IPX: bad trap <IPX address> com-
munity <community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_IPX: community <community 
name> already defined.

The same community name already exists. 
Use another community name.
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Attach FileServer= <file server name> Connection to the file server as the nearest 
server has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the 
print queue.

Authentication mode mismatch < SSID > Authentication mode is different to the AP. 
The required SSID is the SSID of the access 
point connected to when in infrastructure 
mode.

Cannot create service connection (In the remote printer mode) Connection to the 
file server has not been established. The num-
ber of file server users may have exceeded the 
maximum capacity of the file server.

Cannot find rprinter (<print server 
name>/<printer number>)

The printer with the number displayed on the 
print server does not exist. Make sure that the 
printer number is registered on the print server.

Change IP address from DHCP Server. The IP address changes when DHCP lease is re-
newed. To always assign the same IP address, 
set a static IP address to the DHCP server.

child process exec error! (process name) The network service failed to start. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representative.

Client password rejected The client’s password was rejected. Check the 
client password.

Client tls certificate rejected The client’s TLS certificate was rejected. Check 
the certificate.

Connected DHCP Server(<DHCP serverad-
dress>).

The IP address was successfully received from 
the DHCP server.

Could not attach to FileServer <error number> (In the remote printer mode) Connection to the 
file server has not been established. The file 
server has refused the connection. Check the 
file server configuration.

Could not attach to PServer <print server> (In the remote printermode) Connection to the 
print server has not been established. The 
print server has refused the connection. Check 
the print server configuration.

Current Interface Speed: xxxMbps Speed of the network (10Mbps, 100 Mbps, or 
1Gbps).

Current IP address <current IP address> Current IPv4 address.

Current IPX address <IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure 
that the DHCP is on the network.

Message Problem and solutions
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dhcpcd start The DHCPCD service (dhcp client service) has 
started.

Duplicate IP= <IP address>(from <MAC ad-
dress>).

The same IP address (IPv4, or IPv6 address) 
was used. Each IP address (IPv4, or IPv6 ad-
dress) must be unique. Check the address of 
the device indicated in [MAC address].

Established SPX Connection with PServer, 
(RPSocket= <socketnumber>, connID= <con-
nection ID>)

(In the remote printer mode) Connection to the 
print server has been established.

exiting The lpd service has ended and the system is 
exiting the process.

Exit pserver (In the print server mode) The print server 
function is disabled because the necessary 
print server settings have not been made.

Frametype = <frame typename> The frame type name is configured to be used 
on NetWare.

httpd start. The httpd service has started.

IEEE 802.11b <communication mode> mode Displays IEEE 802.11b communication mode.

inetd start. The inetd service has started.

Interface (interface name): Duplicate IP Ad-
dress (IP address).

The same IP (IPv4 or IPv6) address was used. 
Each IP address must be unique. Check the ad-
dress of the device indicated in [IP address].

<Interface> started with IP: <IP address> IP address (IPv4, or IPv4 address) has been set 
for the interface and is operating.

<Interface>: Subnet overlap. The same IP address (IPv4, or IPv6 address) 
and the subnet mask is used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or 
user request.

LeaseTime= <lease time>(sec), RenewTime= 
<renewtime>(sec).

The resource lease time received from the 
DHCP server is displayed in [lease time] in sec-
onds. The renewal time is displayed in [renew 
time] in seconds.

Login to fileserver <file server name> 
(<IPX|IPv4|IPv6>, <NDS|BINDERY>)

(In the print server mode) Login to the file 
server is in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained.

Disconnect the USB cable, and then connect it.

Name registration success. WINS Server= 
<WINS server address> NetBIOS Name= 
<NetBIOS name>

Name registration of <NetBIOS Name> to 
<WINS server address> was successful.

Name registration success in Broadcast name= 
<NetBIOS Name>

Name registration by Broadcast name of <Net-
BIOS Name> was successful.

Message Problem and solutions
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Name registration failed. name= <NetBIOS 
name>

Name registration of <NetBIOSName> failed. 
Change to different NetBIOS name.

nbtd start. The nbtd service has started.

nprinter start (Netware) (In the remote printer mode) The NetWare ser-
vice has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In the print server mode) The specified log file 
has been opened.

phy release file open failed. Replacing the network interface board is re-
quired. Contact your sales or service represen-
tative.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In the print server mode) The print queue 
cannot be established. Make sure that print 
queue exists on the specified file server.

Print server <print server name> has no print-
er.

(In the print server mode) The printer is not as-
signed to the print server. Using NWadmin, 
assign the printer, and then restart it.

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode) The print queue is 
not assigned to the printer. Using NWadmin, 
assign the print queue to the printer, and then 
restart it.

pserver start. (NetWare) (In the print server mode) The NetWare ser-
vice has started.

Required file server (<file servername>) not 
found

The required file server is not found.

received EAP Failure EAP reception failed.

restarted. The lpd service has started.

sap enable, saptype= <SAP type>, sapname= 
<SAP name>

The SAP function has started. The SAP packet 
is issued to advertise the service on the SAP ta-
ble on the NetWare server.

server identity invalid The server ID is disabled. Check the server au-
thentication.

session IPv4 <community name> not defined. The requested community name is not de-
fined.

session IPv6 <community name> not defined. The requested community name is not de-
fined.

session <community name> already defined. The requested community name is not de-
fined.

session_ipx <community name> not defined. The requested community name is not de-
fined.
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Set context to <NDS contextname> An NDS context name has been set.

smbd start. (NETBIOS) The smbd service has started.

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be ob-
tained. This could be because:

• The specified DNS server could not be 
found.

• No connection to the network has been es-
tablished.

• The specified DNS server could not be 
found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address 
could not be found in the DNS server.

SMTPC: failed to connect smtp server. time-
out.

Connection to the SMTP server failed due to 
timeout. This could be because the specified 
SMTP server name is incorrect, or no connec-
tion to the network has been established, or the 
network configuration is incorrect, so there is 
no response from the SMTP server. Check the 
SMTP server name, or the network connection 
and configuration.

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This 
could be because server other than the SMTP 
server has been specified, or the specified 
SMTP server port number is incorrect. Check 
the SMTP server name, port number, or the 
SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to 
no response from SMTP. This could be be-
cause a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the SMTP 
server name, port number, or the SMTP server 
port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This 
could be because no connection to the network 
has been established, or the network configu-
ration is incorrect, so there is no response from 
the SMTP server, or the specified SMTP server 
name is incorrect, or the specified SMTP server 
IP address could not be found in the DNS serv-
er, or a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the DNS Serv-
er’s IP address and SMTP server’s IP address, 
or the SMTP server name and SMTP port num-
ber, or the SMTP server’s SMTP port number, 
or the network connection and configuration.
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SMTPC: username or password wasn’t cor-
rect. [response code] (information)

Connection to the SMTP server failed, because 
the specified SMTP user name is incorrect, or 
the specified SMTP password is incorrect. 
Check the SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is 
available.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is 
available.

Snmp over IPX is ready. Communication over IPX with snmp is 
available.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The bonjour function is enabled.

Terminated. The bonjour function is disabled.

The print server received error <error num-
ber> during attempt to log in to the network. 
Access to the network was denied. Verify that 
the print server name and password are cor-
rect. 

Login to the file server failed. The print server 
is not registered or a password is specified. 
Register the print server without specifying a 
password.

trap account is unavailable. v3Trap cannot be sent. This could be because 
the Trap destination account is different from 
the account specified by the printer.

usbd is disable. Plug and Play function and printing is dis-
abled because usbd is disabled in the security 
mode.

Enable usbd in the security mode.

WINS name registration: No response to serv-
er <WINS server address>

There was no response from the WINS server. 
Check the correct WINS server address is en-
tered. Alternatively, check the WINS server is 
functioning properly.

WINS wrong scopeID= <Scope ID> An invalid scope ID was used. Use a valid 
scope ID.

wpa authentication Failed WPA authentication failed. Check the WPA 
configuration.

wpa authentication started WPA authentication has started.

wpa IEEE802.1X started WPA authentication has started.

wpa connecting to authenticator WPA is connecting to authenticator.

wpa link up WPA key exchange has finished, and commu-
nication has been terminated.

wpa probe response doesn’t have IE. WPA probe response does not have IE.

wpa success authenticated WPA authentication was successful.

wpa success key received WPA key reception was successful.
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Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.

Reference
For details about “syslog” command, see p.217 “Remote Maintenance by tel-
net”.

wpa waiting for key Waiting for WPA key.

wpasupd start wpasupd has started.

wpasupd stop wpasupd has ended.
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Preparing Printer Server

This section explains how to configure the printer as a Windows network print-
er. The printer is configured to enabling network clients to use it. When the net-
work printer is connected via SmartDeviceMonitor for Client, you can set the
printing notification function to notify clients of the results of their print jobs.

Important
❒ Under Windows 2000, Windows XP, or Windows Server 2003/2003 R2, to

change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A Open the [Printers] window from the [Start] menu.
The [Printers] window appears.
Under Windows XP or Windows Server 2003/2003 R2, [Printers and Faxes]
window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties]. The printer properties appear.

C On the [Sharing] tab, click [Shared as:].

D To share the printer with users using a different version of Windows, click
[Additional Drivers...].
If you have installed an alternative driver by selecting [Shared as:] during the
printer driver installation, this step can be ignored.

E Click [OK], and then close the printer properties.
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Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notifica-
tion function of SmartDeviceMonitor for Client.

Setting the print server

Important
❒ Under Windows 2000, Windows XP, or Windows Server 2003/2003 R2, to

change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A On the [Start] menu, point to [Programs], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Print Server Setting].
The print server setting dialog box appears.

B Select the [Notify client PCs of printout/data-transmission ] check box, and then
click [OK].
After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].
Click [Cancel] to interrupt the procedure.
A dialog box appears for client setting.

C A dialog box for specifying clients appears. Click [OK].
The print server setting is complete. Clients must be specified in order to re-
ceive notification.

Note
❒ Current printing jobs restart from the beginning after the spooler pauses

briefly.
❒ When the expansion function is not used, the function is automatically set

as available.
❒ If you log on using an account that does not have Administrator privileges,

the client may not be notified.
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Setting a Client

A On the [Start] menu, point to [Program], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Extended Features Settings].
A dialog box for setting the expansion function appears.

B Select the [Notify of printout/data-transmission when using print server] check box.

C Select the [Notify when using the print server] check box.

D Click [OK].
The dialog box for setting the expansion function closes.
The client setting is completed.

Note
❒ Set the printing notification function on the printer driver as well as on

SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the printer as a
“print server” or “remote printer”.

Important
❒ IPv6 cannot be used on this function.

❖ Setting procedure
• When using the printer as a print server
A Installing SmartDeviceMonitor for Admin.
B Setting the network interface board.
C Turning the printer off and then back on.

• When using the printer as a remote printer
A Installing SmartDeviceMonitor for Admin.
B Setting the network interface board.
C Setting NetWare.
D Starting the print server.

Note
❒ This procedure assumes an environment is already prepared for normal

NetWare running the printing service setting.
❒ The procedure is explained with the following example settings:

• File server’s name …CAREE
• Print server’s name …PSERV
• Printer’s name …R-PRN
• Queue name …R-QUEUE
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❖ Using SmartDeviceMonitor for Admin
To use the printer in a NetWare environment, use SmartDeviceMonitor for
Admin to set the NetWare printing environment.

Note
❒ The NetWare Client provided by Novell is required to set the printing en-

vironment using SmartDeviceMonitor for Admin under the following en-
vironments:
• NDS mode in Windows 95/98/Me
• NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

Reference
p.193 “Using SmartDeviceMonitor for Admin”.

❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If
you cannot identify the printer you want to configure, print configuration
page, and then check the printer name.



Using a Printer Server

280

7

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using Net-
Ware 3.x.

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and password appears.

C Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.

D In the left area, click [Configuration], and then click [NetWare] in “Network”.
• Print Server Name: Enter the NetWare print server name. To use the inter-

face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the speci-
fied file server is searched for. This item is mandatory. Use up to 47 char-
acters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).

• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.
• Print Server Protocol: Select the protocol for NetWare from the drop-down

menu.
• NCP Delivery Protocol: Select the protocol for NCP delivery.
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E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several before restarting Web Image
Monitor.

F Click [Logout].

Note
❒ To check that the configuration is made correctly, enter the following from

the command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

Reference
For details about printing a configuration page, see p.126 “List/Test Print
Menu”.
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Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to connect the printer as a print server using Net-
Ware 4.x, NetWare 5/5.1, or NetWare 6.0.

Important
❒ When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or

NetWare 6.0, set it to the NDS mode.
❒ When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and password appears.

C Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your adminis-
trator.

D In the left area, click [Configuration], and then click [NetWare] in “Network”.
• Print Server Name: Enter the NetWare print server name. To use the inter-

face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the speci-
fied file server is searched for. This item is mandatory. Use up to 47 char-
acters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).

• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).
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• Frame Type: Select the frame type from the drop-down menu.
• Print Server Protocol: Select the protocol for NetWare from the drop-down

menu.
• NCP Delivery Protocol: Select the protocol for NCP delivery.

E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

Note
❒ To check that the configuration is made correctly, enter the following from

the command prompt.
F:> NLIST USER/A/B

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details
about printing a configuration page, see p.126 “List/Test Print Menu” .

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.
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Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP
environment of NetWare 5/5.1.

Important
❒ When creating a queued print server in a pure IP environment of NetWare

5/5.1 or NetWare 6.0, create a print queue on the file server using NetWare
Administrator.

❒ This printer is not available as a remote printer for use in a pure IP environ-
ment.

❒ To use the printer in a pure IP environment, set it to TCP/IP.

Setting up using NWadmin

A From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

B Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Select the object in which the printer is located, and then click [Create] on
the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name.

K Select the [Define additional properties] check box, and then click [Create].

L Click [Assignments], and then click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].
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O Click [Manual load] in the [Communication type] area, and then click [OK].

P Check the settings, and then click [OK].

Q Select a context specified using NIB Setup Tool, and then click [Create] on
the [Object] menu.

R In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

S In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

T Select the [Define additional properties] check box, and then click [Create].

U Click [Assignments], and then click [Add] in the [Assignments] area.

V In the [Available objects] box, click the queue you created, and then click [OK].

W Check the settings, and then click[OK].

X Start the print server by entering the following from the console of the Net-
Ware server.
If the print server is in operation, quit and restart it.

❖ To exit
CAREE: unload pserver

❖ To start
CAREE: load pserver "print_server_name"

Setting up using Web Image Monitor

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and login password appears.

C Enter the login user name and password, and then click [Login].
For details about the login name and password, consult your administrator.

D Click [Configuration] in the left area, and then click [NetWare Print Settings].

E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].
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Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 3.x.

Setting up using PCONSOLE

A Enter “PCONSOLE” from the command prompt.
F:> PCONSOLE

B Create a print queue.
When using the existing print queue, go to the procedure for creating a printer.

C From the [Available Options] menu, select [Print Queue Information], and then
press the {Enter} key.

D Press {Insert} key, and then enter a print queue name.

E Press {Esc} key to return to the [Available Options] menu.

F Set up the network connection to a printer.

G On the [Available Options] menu, click [Print Server Information], and then press
the {Enter} key.

H To create a new print server, press the {Insert} key, and then enter a print
server name.
For a currently defined print server, select a print server in the [Print Server]
list.

I From the [Print Server Information] menu, select [Print Server Configuration].

J From the [Print Server Configuration] menu, select [Printer Configuration].

K Select the printer indicated as [Not Installed].

L To change the printer name, enter a new name.
A name “Printer x” is assigned to the printer. The “x” stands for the number
of the selected printer.

M As type, select [Remote Parallel, LPT1].
The IRQ, Buffer size, Starting form, and Queue service mode are automatical-
ly configured.

N Press the {Esc} key, and then click [Yes] on the confirmation message.

O Press the {Esc} key to return to [Print Server Configuration Menu].
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P Assign print queues to the created printer.

Q From [Print Server Configuration Menu], select [Queues Serviced By Printer].

R Select the printer created.

S Press the {Insert} key to select a queue serviced by the printer.
You can select several queues.

T Follow the instructions on the screen to make other necessary settings.
Following these steps, check that the queues are assigned.

U Press the {Esc} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

V Start the print server by entering the following from the console of the Net-
Ware server.
If the print server is in operation, quit and restart it.

❖ To quit
CAREE: unload pserver

❖ To start
CAREE: load pserver "print_server_name"

Note
❒ If the printer works as configured, the message “Waiting for job” appears.

Setting up using Web Image Monitor

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and login password appears.

C Enter the login user name and password, and then click [Login].
For details about the login name and password, consult your administrator.

D In the left area, click [Configuration], and then click [NetWare] in “Network”.

E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].
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Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 4.x, 5/5.1 and 6.

Important
❒ To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS

mode.
❒ Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

A From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

B Set up the network connection to a print queue. Select the object in which
the print queue is located in the directory tree, and then click [Create] on the
[Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name.

K Select the [Define additional properties] check box, and then click [Create].

L Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].
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N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].

P Set up the network connection to a print server. Select a context specified
using NIB Setup Tool, and then click [Create] on the [Object] menu.

Q In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

R In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

S Select the [Define additional properties] check box, and then click [Create].

T Assign the printer to the created print server. Click [Assignments], and then
click Add in the [Assignments] area.

U In the [Available objects] box, click the queue you created, and then click [OK].

V In the [Printers] area, click the printer you assigned, and then click [Printer]
[Number].

W Enter the printer number, and then click [OK]. Check the settings, and then
click [OK].

X Start the print server by entering the following from the console of the Net-
Ware server.
If the print server is in operation, quit and restart it.

❖ To exit
CAREE: unload pserver

❖ To start
CAREE: load pserver "print_server_name"

Y Enter the printer server name as the context name, and then press the {OK}
key.

Z Select the printer name on the context menu, and then press the {OK} key.
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Setting up using Web Image Monitor

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and login password appears.

C Enter the login user name and password, and then click [Login].
For details about the login name and password, consult your administrator.

D Click [Configuration] in the left area, and then click [NetWare Print Settings].

E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].
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Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

❖ Windows 95/98/Me
You can print files directly using “ftp” command.

❖ Windows 2000/XP, Windows Server 2003/2003 R2, Windows NT 4.0
You can print files directly using “lpr”, “rcp”, or “ftp” command.

Note
❒ To use “sftp” commands, use an sftp client software that is compatible with

ssh v2.

Setup

Follow the procedure below to make network environment settings.

A Enable TCP/IP with the control panel, and then set up the printer’s network
environment about TCP/IP including IP addresses.
TCP/IP of the printer is set as default.

B Install a TCP/IP in Windows to set up the network environment.
Consult the administrator for the local setting information.

C To print under Windows 2000/XP, Windows Server 2003/2003 R2, or Win-
dows NT 4.0, install “Printing service for UNIX” as the network applica-
tion. To print under Windows NT 4.0, install “Microsoft TCP/IP printing”
as the network application.

Reference
For details about setting up “IPv4 address”, see Hardware Guide.
For details about setting the “IPv4 address” of the printer using DHCP, see
p.342 “Cautions to Take When Using in a network”.
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Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of
IPv4 address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the “IPv4 address” of a printer using DHCP

Use the printer name on the configuration page as the host name.

Reference
For details about printing a configuration page, see p.126 “List/Test Print
Menu”.

In other cases

Add the IPv4 address and host name of the network printer to the hosts file on
the computer used for printing. Methods of addition vary depending on operat-
ing systems.

Windows 95/98/Me

A Copy WINDOWSHOSTS.SAM to the same directory and name it
“HOSTS” with no extension.

B Open the “WINDOWSHOSTS” file created using memo pad files, for in-
stance.

C Add an IP address and host name to the hosts file using the following for-
mat:
192.168.15.16 host  # NP

“192.168.15.16” is the “IPv4 Address”, “host” is the printer’s host name, and
“#NP” is replaced by comments. Insert a space or tab between “192.168.15.16”
and “host”, between “host” and “#NP” respectively, using one line for this
format.

D Save the file.
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Windows 2000/XP, Windows Server 2003/2003 R2, Windows NT 4.0

A Open the hosts file using memo pad files, for instance.
The hosts file is in the following folder:
WINNTSYSTEM32DRIVERSETCHOSTS

“WINNT” is the directory of the installation destination for Windows
2000/XP, Windows Server 2003/2003 R2, and Windows NT 4.0.

B Add an IPv4 address and host name to the hosts file using the following
format:
192.168.15.16 host  # NP

“192.168.15.16” is the “IPv4 Address”, “host” is the printer’s host name, and
“#NP” is replaced by comments. Insert a space or tab between “192.168.15.16”
and “host”, between “host” and “#NP” respectively, using one line for this
format.

C Save the file.

Note
❒ When using a host name under Windows Server 2003/2003 R2 with IPv6

protocol, perform host name resolution using an external DNS server. The
host file cannot be used.
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Printing Commands

The following explains printing operations using the “lpr”, “rcp”, and “ftp”
commands.
Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:
• Windows 95/98

[Start] - [Programs] - [MS-DOS Prompt]
• Windows Me

[Start] - [Programs] - [Accessories] - [MS] - [DOS Prompt]
• Windows 2000

[Start] - [Programs] - [Accessories] - [Command Prompt]
• Windows XP, Windows Server 2003/2003 R2

[Start] - [All Programs] - [Accessories] - [Command Prompt]
• Windows NT 4.0

[Start] - [Programs] - [Command Prompt]

Note
❒ Match the data format of the file to be printed with the emulation mode of the

printer.
❒ If the message “print requests full” appears, no print jobs can be accepted. Try

again when sessions end. For each command, the amount of possible sessions
is indicated as follows:
• lpr: 10
• rcp, rsh: 5
• ftp: 3

❒ Enter the file name in a format including the path from the directory execut-
ing commands.

❒ The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

lpr

❖ When specifying a printer by IP address
c:> lpr -Sprinter’s IP address [-Poption] [-ol] \pass name\file
name

❖ When using a host name instead of an IP address
c:> lpr -Sprinter's host name [-Poption] [-ol] \pass name\file
name

When using a printer with the host name “host” to print a PostScript file named
“file 1” located in the “C:\PRINT” directory, the command line is as follows:
c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1
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rcp

First, register the printer's host name in the hosts file.
c:> rcp [-b] \pass name\file name [pass name\file name...] printer's
host name:[option]

Note
❒ In file names, “*” and “?” can be used as wild cards.
❒ When printing a binary file, add the “-b” option.
When using a printer with the host name “host” to print a PostScript file named
“file 1” or “file 2” located in the “C:\PRINT” directory, the command line is as
follows:
c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

ftp

Use the “put” or “mput” command according to the number of files to be printed.

❖ When one file is printed
ftp> put \pass name\file name [option]

❖ When multiple files are printed
ftp> mput \pass name\file name [\pass name\file name...] [option]

A Formulate the printer’s IP address or the host name of the hosts file printer
as an argument and use the “ftp” command.
% ftp printer’s IP address

B Enter the user name and password, and then press the {OK} key.
For details about the user name and password, consult your administrator.
User:

Password:

CWhen printing a binary file, set the file mode to binary.
ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

D Specify files to be printed.
The following shows the examples of printing a PostScript file named “file 1”
in the “C:\PRINT” directory and printing file 1 and file 2.
ftp> put C:\PRINT\file1 filetype=RPS

ftp> mput C:\PRINT\file1 C:\PRINT\file2



Special Operations under Windows

296

8

E Quit ftp.
ftp> bye

Note
❒ “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read

as option strings.
❒ For “mput” command, option can not be defined.
❒ For “mput” command, “*” and “?” can be used as wild cards in file names.
❒ When printing a binary file in ASCII mode, print may not come out cor-

rectly.
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Mac OS

This section explains how to configure a Mac OS to use EtherTalk and USB.
The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details.

Important
❒ For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

Note
❒ The PostScript 3 printer driver is stored in the following folder on the CD-

ROM.
Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD)
files to print from a Mac OS.
Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS 8 and 9] folder.

D Double-click the [PS Driver] folder.

E Double-click the folder of the language you use.

F Open [Disk1], and then double-click the installer icon.

G Follow the instructions on the screen.
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PPD Files

A Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

C Double-click the [Printer Descriptions] folder.

D Double-click the folder of the language you use.

E Open the [Disk1] folder.

F Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

G Restart the Mac OS.
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Setting Up PPD Files

Important
❒ Make sure that the printers are connected to an AppleTalk network before

performing the following procedure.

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

D Click [Create].

E Click the printer you want to use, and then click [Select].

F A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list.

Creating a Desktop Printer Icon

Important
❒ Make sure that printers are connected to the USB before performing the fol-

lowing procedure.
To use a printer connected by USB, create a desktop printer icon.

A Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

B Click [AdobePS] in [With], click [Printer (USB) in] Create Desktop, and then
click [OK].

C Click [Change] in [USB Printer Selection].

D Select the model you are using in [Select a USB Printer:], and then click [OK].

E Click [Create].

F Enter the printer name, and then click [Save].

G Quit Desktop Printer Utility.
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Setting Up Options

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select the PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup...].

D Click [Configure].
A list of options appears.

E Select the option you want to set up, and then select an appropriate setting
for it.

F Click [OK].
The list of options closes.

G Click [OK].
The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.

Note
❒ If the option you want to select is not displayed, PPD files may not be set

up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.
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Installing Adobe Type Manager

Important
❒ Quit all applications currently running before installation. Install ATM after

you restart the computer.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive con.

C Double-click the [Mac OS 8 and 9] folder.

D Double-click the [ATM folder].

E Double-click the ATM 4.6.2 installer icon.

F Follow the instructions on the screen.

GWhen the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

H On the [Apple] menu, open [Control Panel], and then click [~ATM].
The ATM control panel opens.

Note
❒ For details about installation, see the operating instructions in the ATM

folder.
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Installing Screen fonts

Follow the procedure below to install screen fonts.
The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

A Insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

B Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

C Double-click the [Mac OS 8 and 9] folder.

D Double-click the [Fonts] folder.

E Double-click the [ScreenFonts] folder.

F Double-click the [TrueType] or Type1 folder.
Select the font type you want to use.

G Copy the fonts you want to install in Fonts under [System Folder].

H A confirmation message appears.

I Click [OK].
The fonts are installed.

J Restart the Mac OS.

Changing to EtherTalk

A Open [Control Panel], and then double-click the [AppleTalk] icon.

B On the [Connect via:] pop-up menu, click [Ethernet].

C If you change zones, select a name on the [OK] pop-up menu.

D Close the AppleTalk control panel.

E Restart the Mac OS.

Note
❒ The procedures used to configure Mac OS may vary depending on the Mac

OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Confirm the Connection to the Printer with TCP/IP.
❒ For information about installing applications required for EtherTalk, see

the Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk and USB.
Follow the procedure below to configure Mac OS X 10.1. If you are not using
Mac OS X 10.1, see the manual of the Mac OS X you are using for details.

Important
❒ For Mac OS X 10.1 or higher.
❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Note
❒ The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

Important
❒ You need an administrator name and a password (phrase). For details, con-

sult your administrator.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS X] folder.

D Double-click the [MacOSX PPD Installer] folder.

E Double-click the installer icon.

F Follow the instructions on the screen.
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Setting Up the PPD File

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click [More Printers...]. Then select the zone from the second pop-up menu.

❖ Other Mac OS X
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

C Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, select the printer you are using from the [Print
Using] popup menu.
A list of printer types appears.

D Select the PPD file for the model you are using, and then click [Add].

E Quit Printer Setup Utility.

Setting Up Options

A Start System Preferences.

B Click [Print & Fax].

C In the [Printer] list, click the name of the printer you want to use, and then
click [Printer Setup...].

D Select the option you want to set up, and then select an appropriate setting
for it.

E Click [Apply Changes].

Note
❒ If the option you want to select is not displayed, PPD files may not be set

up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.



Mac OS X

05

9

3

Using USB Interface

Follow the procedure below to setup USB connection.

Important
❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has “USB” indicated in the “Connection” column.

❖ Other Mac OS X
Click [USB] on the pop-up menu.
The connected printer appears.

C Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up
menu.
A list of printer types appears.

D Select the connected printer from the list of printer models, and then click
[Add].

E Quit Printer Setup Utility.

Note
❒ When printing with a USB connection to a Macintosh computer, printer

language does not change automatically. Use the control panel on this
printer to change printer language to [Auto] or [PS] before printing.

❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.
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Using Bonjour (Rendezvous)

Follow the procedure below to print using Bonjour (Rendezvous) under Mac OS
X 10.2.3 or higher. Ethernet, wireless LAN connections can also be used.

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has “Bonjour” indicated in the “Connection” column.

❖ Other Mac OS X
Click [Rendezvous] on the pop-up menu.

C Select the name of the connected printer from the list of printer models, and
then click [Add].
Under Mac OS X 10.4 or later, Installable Options window appears. Select the option
you want to set up, and then select an appropriate setting for it, and then [Continue].

D Quit Printer Setup Utility.
When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on this
printer to change printer language to [Auto] or [PS] before printing.

Changing to EtherTalk

Follow the procedure below to configure a Mac OS X to use EtherTalk.

Important
❒ You need an administrator name and a password (phrase). For details, con-

sult your administrator

A Open [System Preference], and then click the Network icon.

B Click [Built-in Ethernet] in the [Show:] list box.

C Click the [AppleTalk] tab.

D Select the [Make AppleTalk Active] check box.

E To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up menu.

FWhen the settings are made, click [Apply Now].

G Quit [System Preference].

Note
❒ For information about installing applications required for EtherTalk, see

the Mac OS manuals.
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Using PostScript 3

Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Normal Print
Select this for normal printing. The print job starts immediately after the print
command is given.

❖ Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the printer. The saved job can be printed from the
printer’s control panel. You can also delete the saved job.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters.
❒ Entering the “User ID:” helps you distinguish your print job from others.

❖ Locked Print
Use this function to save documents in the printer memory with a password,
and then edit and print them as you want.

Note
❒ The “User ID:” can contain to eight alphanumeric (a-z, A-Z, 0-9) charac-

ters. The “Password” must be 4-8 digits.
❒ Entering the “User ID:” helps you distinguish your print job from others.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.
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❖ Hold Print
Use this function to temporarily hold a file in the printer, and print it from the
computer or the printer’s control panel later.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters.
❒ The “File Name:” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ Entering the “User ID:” helps you distinguish your print job from others.

❖ Stored Print
Use this function to store a file in the printer, and then print it from the com-
puter or the printer’s control panel later.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters. The “Password:” must be 4-8 digits.
❒ The “File Name:” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ You can assign a password to a saved document, but password assignment

is not mandatory.
❒ Entering the “User ID:” helps you distinguish your print job from others.

❖ Store and Print
Use this function to prints the file at once and also stores the file in the printer.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters. The “Password:” must be 4-8 digits.
❒ The “File Name:” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ You can assign a password to a saved document, but password assignment

is not mandatory.
❒ Entering the “User ID:” helps you distinguish your print job from others.
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Using Sample Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ The number of pages the printer can save varies depending on the contents of

the print images. At most, the printer can save 100 jobs or 3,000 pages for Sam-
ple Print, Locked Print, Hold Print and Stored Print.

❒ Sample Print files will not appear on the display panel if they have already
been executed or deleted using the Web browser before you select [Sample
Print] from the control panel.

❒ Sample Print files printed or deleted using Web Image Monitor after you se-
lect [Sample Print] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those Sam-
ple Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If the collate option is selected in the application print
dialog box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 3,000 pages.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Set the number of copies to two or more.
The sample print job is sent to the printer, and one set is printed.

C In the pop-up menu, click [Job Log].

D On the [Job Type:] pop-up menu, select [Sample Print].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters.
The user ID associates the user with his/her jobs.

F Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining
sets.
If you want to delete a saved job, see p.82 “Sample Print”.

G On the printer’s control panel, press [Prt.Jobs].

H Select [Sample Print Jobs], and then press [Job List].
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A list of sample print files stored in the printer appears.
User ID, Date/Time and File Name also appear.

I Select the file you want to print by pressing it.
A list of print files stored in the printer appears.

J Press [Print] to change the number of sets to be printed.

K Enter the new number of sets using the number keys.
If you do not want to change the set quantity, perform the following steps.
You can enter up to 999 sets.
Press {Escape} to correct any entry mistakes.

L Press [Print].
The remaining sets are printed.

Note
❒ Press [Cancel] to cancel printing.
❒ When printing finishes, the stored file is deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.
❒ If there is a print job outstanding, this is printed before the sample print

job.

Deleting a Sample Print File

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Sample Print Jobs], and then press [Job List].
A list of sample print files stored in the printer appears.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted jobs again.
Only one file can be selected at a time.

D Press [Delete].
A confirmation screen appears.

E Press [Delete] to delete the file.
After the file is deleted, the printer screen reappears.

Note
❒ Press [Cancel] to cancel the delete request.
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Using Locked Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ The number of pages the printer can save varies depending on the contents of

the print images. At most, the printer can save 100 jobs or 3,000 pages for Sam-
ple Print, Locked Print and Hold Print.

❒ Locked Print files will not appear on the display panel if they have already
been printed or deleted using Web Image Monitor before you select [Locked
Print] using the control panel.

❒ Locked Print files printed or deleted using Web Image Monitor after you have
selected [Locked Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete
those Locked Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, locked print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 3,000 pages.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Locked Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
The user ID associates the user with his/her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the printer.
To print the document, perform the following steps.
To delete the document, see p.86 “Locked Print”.

F On the printer’s control panel, press [Prt.Jobs].

G Select [Locked Print Jobs], and then press [Job List].
A list of locked print files stored in the printer appears.
User ID, Date/Time and File Name also appear.

H Select the file you want to print by pressing it.
A list of print files stored in the printer appears.
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I Press [Print].
The password screen appears.

J Enter the password using the scroll keys, and then press the {OK} key.
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press the {OK} key to enter the password again.

K Press [Print].
The locked file is printed.

Note
❒ Press [Cancel] to cancel printing.
❒ When printing finishes, the stored file is deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.

Deleting a Locked Print File

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Locked Print Jobs], and then press [Job List].
A list of locked print files stored in the printer appears.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted jobs again.
Only one file can be selected at a time.

D Press [Delete].
A password screen appears.

E Enter the password using the scroll keys, and then press the {OK} key.
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Clear] to enter the password again.
When multiple files are selected, the printer deletes only files that correspond
to the entered password. The number of files to be deleted is displayed on the
confirmation screen.

F Press [Delete].
After the file is deleted, the printer screen reappears.

Note
❒ Press [Cancel] to cancel the delete request.
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Using Hold Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ The number of pages the printer can save varies depending on the contents of

the print images. At most, the printer can save 100 jobs or 3,000 pages for Sam-
ple Print, Locked Print and Hold Print.

❒ Hold Print files will not appear on the display panel if they have already been
printed or deleted using Web Image Monitor before you select [Hold Print] us-
ing the control panel.

❒ Hold Print files printed or deleted using Web Image Monitor after you have
selected [Hold Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete
those Hold Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, Hold print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 3,000 pages.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Hold Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters. File Name can also be set.
The user ID associates the user with his/her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the printer.
To print the document, perform the following steps.
To delete the document, see p.90 “Hold Print”.

F On the printer’s control panel, press [Prt.Jobs].
A list of print files stored in the printer appears.
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G Select [Hold Print Jobs], and then press [Job List].
A list of hold print files stored in the printer appears.
User ID, Date/Time and File Name also appear.

H Select the file you want to print by pressing it.

I Press [Print].
The hold print file is printed.

Note
❒ Press [Cancel] to cancel printing.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.
❒ When printing is completed, the stored file is deleted.

Deleting a Hold Print File

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Hold Print Jobs], and then press [Job List].
A list of hold print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted job again.
Only one file can be selected at a time.

D Press [Delete].
A confirmation screen appears.

E Press [Delete].
After the file is deleted, the printer screen reappears.

Note
❒ Press [Clear] to cancel the delete request.
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Using Stored Print

Important
❒ ou need Mac OS X v10.2 or higher to use this function.
❒ Stored Print files will not appear on the display panel if they have already

been printed or deleted using Web Image Monitor before you select [Stored
Print] using the control panel.

❒ Stored Print files printed or deleted using Web Image Monitor after you have
selected [Stored Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete
those Stored Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, Stored print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 3,000 pages.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Print]

Prints the file at once and also stores the file in the printer.

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
File Name can also be set.
The user ID associates the user with his/her jobs.
You can assign a password to a saved document, but password assignment is
not mandatory.
The password must be entered when printing or deleting.

E After making the necessary settings, click [Print].
The document file is saved in the printer.
To print the document, perform the following steps.
To delete the document, see p.93 “Stored Print”.

F On the printer’s control panel, press [Prt.Jobs].
A list of print files stored in the printer appears.
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G Select [Stored Print Jobs], and then press [Job List].
A list of Stored Print files stored in the printer appears.
User ID, Date/Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

H Select the file you want to print by pressing it.

I Press [Print].
A confirmation screen appears.
If you have already set a password, proceed to the following step.

J Enter the password using the scroll keys, and then press the {OK} key.
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press the {OK} key to enter the password again.
If you have not set the password, proceed to the following step.

K Press [Print]
The Stored Print file is printed.

Note
❒ Press [Cancel] to cancel printing.
❒ Stored Print files sent to the printer is not deleted unless you delete them

in the printer, or enable automatic deletion of Stored Print files.

Deleting a Stored Print File

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Stored Print Jobs], and then press [Job List].
A list of Stored Print files stored in the printer appears.

C Select the file you want to delete by pressing it.

D Press [Delete].
A confirmation screen appears.

E Enter the password using the scroll keys, and then press {OK}.
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press {OK} to enter the password again.

F Press [Delete].
After the file is deleted, the printer screen reappears.

Note
❒ Press [Cancel] to cancel the delete request.
❒ If you have already set a password in the printer driver, enter it to delete.
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User Code

Use this to set a user code for print logging.
Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.
The following table shows the tabs or menus where you can select this function.

Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Note
❒ For details about the paper sizes supported by this printer, see Hardware

Guide.

Mac OS Select the [Enable User Code] check box, and 
then enter a user code in the [User Code] box on 
[Job Log] in the print dialog box.

Mac OS X Select the [Enable User Code] check box, and 
then enter a user code in the [User Code] box on 
[Job Log] in the print dialog box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page 
Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.
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Fit to Paper

When the size of the document and paper size differ, set whether or not to print
according to paper size.

❖ Prompt User
Print is performed with the size of document to be printed unchanged.

❖ Nearest Size and Scale
If the paper size is smaller than the selected paper size, the driver reduces the
print size.
If the paper size is larger than the size of document to be printed, print is not
to fit the paper size.

❖ Nearest Size and Crop
When the paper size is smaller than the size of document to be printed, print
is adjusted to meet the paper size.

Input Slot

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Note
❒ For details about the paper sources, see Hardware Guide.

Resolution

Use this to set the resolution types.
The following table shows the tabs or menus where you can select this function.

Note
❒ For more information about the resolution types, see Hardware Guide.

Mac OS [Fit to Paper] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Fit to Paper] on the [Features x] tab on [Printer 
Features] in the print dialog box.

Mac OS [Paper Source:] on [General] in the print dialog 
box.

Mac OS X [Paper Feed] in the print dialog box.

Mac OS [Resolution] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Resolution] on the [Features x] tab on [Printer 
Features] in the print dialog box.
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Orientation Override

Use this to set the paper orientation.
The following table shows the tabs or menus where you can select this function.

You can select the following items:
• Off
• Landscape
• Portrait

Toner Saving

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Note
❒ For details about this function, see printer driver Help.

Collate

Use this function to enable collation. With this feature, the printer can efficiently
print collated sets of multiple-page documents.

Important
❒ Make sure that the following check boxes have not been selected.

• Mac OS
The [Collate:] check box in the print dialog box.

• Mac OS X
The [Collate:] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Mac OS [Orientation Override] on [Printer Specific Options] 
in the print dialog box.

Mac OS X [Orientation Override] on the [Feature Sets: X] tab 
on [Printer Features] in the print dialog box.

Mac OS [Toner Saving] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Toner Saving] on the [Features: Set x] tab on 
[Printer Features] in the print dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Collate:] on the [Features: Set x] tab on [Printer 
Feature] in the printer dialog box.
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Paper Type

Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Note
❒ For details about the media type supported by this printer, see Hardware

Guide.

Dithering

Use this function to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Auto
Use this setting to configure the best dithering method automatically depend-
ing on the appearance of the document to be printed.

❖ Photographic
Performs dithering using an appropriate pattern for photographs.

❖ Text
Performs dithering using an appropriate pattern for text.

❖ User Setting
Use this setting to print images set in half tone in your application.

Mac OS [Paper Type:] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Paper Type] on the [Feature Set: x] tab on [Printer 
Features] in the print dialog box.

Mac OS Dithering: on Printer Specific Options in the 
print dialog box.

Mac OS X Dithering: on the Feature Set: x tab on Printer 
Features in the print dialog box.
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Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

Important
❒ If a Macintosh and printer are connected by USB, you cannot use Printer Util-

ity for Mac.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers

and Utilities”.
❒ Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1.

Mac OS X 10.0.x and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the printer.

A Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

B Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

C Double-click the [Mac OS 8 and 9] icon to open it.
Under Mac OS X, double-click the [Mac OS X] folder.

D Double-click the [PS Utility] folder on the CD-ROM, and then drag the
[Printer Utility for Mac] file, and then drop it into the Macintosh hard disk.

E Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Driv-

ers and Utilities”.
❒ Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic

environment is supported.)
❒ Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac

Mac OS

Important
❒ Before starting Printer Utility for Mac, make sure the printer is selected in

[Chooser] on the Apple menu.

A Double-click the [Printer Utility for Mac] icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].
Printer Utility for Mac will take a few seconds to start.

Mac OS X

A Double-click the [Printer Utility for Mac] icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].

C In the [Available Printers:] box, select the printer you want to use.
If you change zones, select a name from [Available Network Zones:].
Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

D Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

E Click [Choose].
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Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

Important
❒ The following procedure to download the fonts assume that you are a system

administrator. If you are not, be sure to consult your system administrator.
❒ During the download, do not turn off the power switch, operate the panel or

open or close the cover.
❒ If the printer restarts, all the printer settings return to the defaults.
❒ Confirm that a Macintosh and the printer are connected with Appletalk.

A Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].
The dialog box to select fonts appears.

C Select the desired font files, and then click [Open].
The list of selectable font names appears.

D After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

E Click [Download].
The fonts begin to download, and the download status is shown.

FWhen the completion message appears, click [OK].

G Click [Cancel].

Note
❒ Some fonts cannot be downloaded.
❒ Before downloading, read the documentation about the fonts you want to

use.
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Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer memory and hard disk drive can be displayed.

A Select [Display Printer’s Fonts...] on the [File] menu.
A dialog box appears.

B Select [Printer’s memory] or [Printer’s disk].

C Click [OK].

Note
❒ The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer’s memory or hard disk drive.

Important
❒ You cannot delete the fonts displayed in italic.

A Select [Display Printer’s fonts] on the [File] menu.
A dialog box appears.

B Select [Printer’s memory] or [Printer’s disk].

C Select the fonts you want to delete.

D Click [Delete].
A confirmation message appears.

E Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

F Click [Continue], and then click [OK].

G Click [OK].
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Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer
hard disk drive are deleted. Before initializing, be sure to check the fonts on the
hard disk drive.

Important
❒ When initializing the printer hard disk drive from the control panel, all of the

data on the printer hard disk drive is deleted. Before initializing, be sure to
check the data on the hard disk drive.

❒ Do not turn off the power switch until initializing is completed, otherwise the
hard disk drive might be damaged.

A Select [Initialize Printer’s Disk...] on the [File] menu.
The confirmation message appears. To cancel initialization, click [Cancel].

B Click [Execute].
Initializing starts.

CWhen the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

A Select [Page Setup...] on the [File] menu.

B Select the paper size.

C Click [OK].

Printing Font Catalog

You can print the names of fonts available on the printer.

A Select [Print Fonts Catalog...] on the [File] menu.

B Click [Print].

Note
❒ The paper selected under [Page Setup] is used.
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Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

A Select [Print Fonts Sample...] on the [File] menu.

B Click [Print].

Note
❒ Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

Important
❒ You can enter up to 31 digits and letters.
❒ Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

Mac OS

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].
The printer name is changed.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G Select the printer whose name you changed, and then close the [Chooser] di-
alog box.
If there are several AppleTalk zones, select the zone the printer belongs to.
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Mac OS X

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].
The printer name is changed.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone for the Macintosh in use.

G In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

You can restart the printer.

A Select [Restart Printer] on the [File] menu.

B Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.
The fonts downloaded in the printer memory will be deleted.
If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

A Select [Download PostScript File...] on the [Utility] menu.

B Select the file name to download, click the file name, and then click [Open].

C Type the log file name, and then click [Save].
The selected file is downloaded.
Errors are recorded in the log file.
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Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

Important
❒ Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone in which you want to locate the printer, and then click [Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G In the [AppleTalk zone:] list, select the zone you changed.

H In the [Select a PostScript Printer:] list, select the printer you want to use.

I Close the [Chooser] dialog box.

Mac OS X

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone which you want to locate the printer in, and then click [Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone you changed.

G In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].
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Displaying the Printer Status

You can display and confirm the current status of the printer.

A Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

B Confirm the current status of the printer.
You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs.

C Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the
printer.

Important
❒ “Launch Dialogue Console” is recommended for users with an understand-

ing of PostScript.
❒ Do not download any file other than PostScript files to the printer.
❒ “Launch Dialogue Console” must be used at your own responsibility.

A Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

B Type the PostScript command in the editor screen.
To edit a PostScript file, select [Open] on the [File] menu to open it.
You can search or replace a character string by using the [Search] menu.

C After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.
The PostScript file is sent to the printer.
The [Reply from Printer] box opens, depending on the PostScript file you sent.

D Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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Using Authentication and Managing Users

This section explains how to improve this printer’s security.
The setting can be done only by the administrator.

❖ Enabling Authentication
To control administrators’ and users’ access to the printer, perform adminis-
trator authentication and user authentication using login user names and lo-
gin passwords. To perform authentication, the authentication function must
be enabled.

❖ Specifying Authentication Information to Log on
Users are managed using the personal information managed in the printer’s
address book.
Enabling user authentication limits usage of printer to people registered in
the address book to use the printer. Users can be managed in the address
book by the user administrator.

❖ Specifying Which Functions are Available
This can be specified by the user administrator. Specify the functions avail-
able to registered users. By making this setting, administrators can limit the
functions available to users.
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Preventing Information Leaks

❖ Guarding Against Unauthorized Copying (Unauthorized Copy Prevention)
Using the printer driver, mask and pattern can be embedded in the printed
document.

❖ Guarding Against Unauthorized Copying (Data security for copying)
Using the printer driver with the data security for the copying function, a doc-
ument can be printed with an embedded pattern of hidden text.
To gray out the copy or stored file of a copy-guarded document when the
document is copied or stored , the optional security module is required.

❖ Printing confidential files
Using the printer’s Locked Print, files can be stored in the printer as confiden-
tial files and then print them. Those file can be printed using the printer’s con-
trol panel and collected on the spot to prevent others from seeing it.

❖ Preventing Data Leaks Due to Unauthorized Transmission
You can specify in the address book which users are allowed to send files us-
ing the scanner or fax function.
You can also limit the direct entry of destinations to prevent files from being
sent to destinations not registered in the address book.

❖ Protecting Registered Information in the Address Book
This function allows administrator to specify which users have permission to
access the data in the address book. Usage of the data in the address book by
unregistered users can be prevented.
Administrator can also encrypt the data in the address book to protect the
data from unauthorized reading.

❖ Managing Log Files
Data security can by improved by deleting log files stored in the printer. By
transferring the log files, administrator can check the history data and identi-
fy unauthorized access.
To transfer the log data, the log collection server is required.

❖ Overwriting the Data on the Hard Disk
Before disposing of the printer, make sure all data on the hard disk is deleted.
Prevent data leakage by automatically deleting transmitted printer jobs from
memory.
To overwrite the hard disk data, the optional ipp unit is required.
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Limiting and Controlling Access

❖ Preventing Modification or Deletion of Stored Data
Users with access permission to stored files can be specified. Permit selected
users who have to access permissions to stored files to modify or delete the
files.

❖ Preventing Modification of Printer Settings
The printer settings that can be modified depend on the type of administrator
account.
Register the administrators so that users cannot change the administrator set-
tings.

❖ Limiting Available Functions
This function allows administrator to specify which users have accessibility
to each of the printer’s functions, to prevent unauthorized operation. Limit-
ing and Controlling Access
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Enhanced Network Security

❖ Preventing Unauthorized Access
Limit IP addresses or disable ports to prevent unauthorized access over the
network and protect the address book, stored files, and default settings.

❖ Encrypting Transmitted Passwords
Prevent login passwords, group passwords for PDF files, and IPP authentica-
tion passwords being revealed by encrypting them for transmission.
Also, encrypt the login password for administrator authentication and user
authentication.
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Configuring SSL Encryption

When you access the printer using a Web Image Monitor or IPP, you can estab-
lish encrypted communication using SSL.
When you access the printer using an application such as SmartDeviceMonitor
for Admin, you can establish encrypted communication using SNMPv3 or SSL.
To protect data from interception, analysis, and tampering, you can install a
server certificate in the printer, negotiate a secure connection, and encrypt trans-
mitted data.

❖ SSL (Secure Sockets Layer)

1. To access the printer from a user’s
computer, request for the SSL server
certificate and public key.

2. The server certificate and public
key are sent from the printer to the
user’s computer.

3. Create shared key from the user’s
computer, and then encrypt it using
public key.

4. The encrypted shared key is sent
to the printer.

5. The encrypted shared key is de-
crypted in the machine using private
key.

6. Transmit the encrypted data us-
ing the shared key, and then decrypt
the data at the machine to attain se-
cure transmission.

AQC899S
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Software and Utilities Included on the CD-ROM

The following softwares and utilities are included in the CD-ROMs that come
with the printer.

❖ Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled “Printer Drivers and Utilities”.

❖ SmartDeviceMonitor for Admin
For the system administrator to manage network printers.

Note
❒ SmartDeviceMonitor for Admin Help.

❖ DeskTopBinder - SmartDeviceMonitor for Client
For users to manage their network print status.

Note
❒ DeskTopBinder - SmartDeviceMonitor for Client Help.

Viewing the contents of the CD-ROM

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Click [Browse This CD-ROM].
Explorer starts and displays the contents of the CD-ROM.
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Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating sys-
tem. The following drivers are included on the CD-ROM provided with this
printer.

❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer us-
ing a printer language. In addition to the conventional user interface, another
preset user interface is provided.
The following operating system is supported.
• Windows 95/98/Me, Windows 2000/XP, and Windows Server 2003/2003

R2

❖ PostScript Printer Drivers and PPD files
PostScript printer drivers and the PPD files are included on the CD-ROM pro-
vided with this printer. PostScript printer drivers allow the computer to com-
municate with the printer using a printer language. PPD files allow the
printer driver to enable specific printer functions.
The following operating system is supported.
• Windows 95/98/Me, Windows 2000/XP, Windows Server 2003/2003 R2,

Mac OS, and Mac OS X.

Note
❒ The PostScript printer drivers and PPD files are included on the CD-ROM

labeled “Printer Drivers and Utilities”.
❒ For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environ-

ment is supported.)

❖ PPD files
PPD files are included on the CD-ROM provided with this printer. PPD files
allow the printer driver to enable specific printer functions.
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SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and
IPX/SPX to monitor network printers. It can monitor multiple network printers
using IP address. We recommend that administrators use this application.

❖ File path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-
ROM.
NETWORKDEVMONADMINDISK1

❖ Available functions
SmartDeviceMonitor for Admin has the following functions to check:
• printer supplies such as paper or toner;
• results of print jobs executed from the computer.

Note
❒ For information about using SmartDeviceMonitor for Admin, see Smart-

DeviceMonitor for Admin Help.

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98

Novell Client provided with Windows 95/98

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or Window NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003/2003 
R2

TCP/IP provided with Windows Server 2003/2003 R2

IPX/SPX provided with Windows Server 2003/2003 R2

NetWare Client provided with Windows Server 2003/2003 R2

Novell Client provided with Windows Server 2003/2003 R2

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Windows NT
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DeskTopBinder - SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.
• Printing in a peer-to-peer network, using TCP/IP, and IPP from Windows

95/98/Me/2000/XP, Windows Server 2003/2003 R2, and Windows NT 4.0.
• Constantly monitoring the status of devices on the network using TCP/IP

and IPX/SPX.

❖ File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-
ROM.
NETWORKDEVMONCLIENTDISK1

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98/Me

Novell Client provided with Windows 95/98/Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003/2003 
R2

TCP/IP provided with Windows Server 2003/2003 R2

IPX/SPX provided with Windows Server 2003/2003 R2

NetWare Client provided with Windows Server 2003/2003 R2

Novell Client provided with Windows Server 2003/2003 R2

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Windows NT
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❖ Available functions
SmartDeviceMonitor for Client has the following functions.
• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a
print server.

• Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery
Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).
• Executes prior group registration of printers specified for Recovery

Printing or Parallel Printing.
• Notification function

• Displays an error message when there is an error on the specified printer
while transferring or printing data.

• Notifies a print completion. You can also be notified of the print condi-
tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

• Monitoring function
• Checks printer supplies such as paper or toner.
• Simultaneously monitors multiple printers in use.
• Checks the printer’s network settings and detailed information of

printers.
• Enables you to check the print job log using the user ID

Important
❒ To perform Recovery or Parallel printing, the same options that are installed

on the original printer must be installed on the other printers also. Printers
that lack a required option cannot be used for Recovery or Parallel printing.

❒ To perform Recovery or Parallel printing, the same paper loaded in the orig-
inal printer must be loaded in the other printers also. Load all printers with
the same paper as that loaded in the tray selected for printing.

❒ Results of Recovery or Parallel Printing might differ, depending on the model
of the other printer and the options installed on it.

❒ If you select Sample Print or Locked Print, you cannot select Recovery Print-
ing or Parallel Printing.

Note
❒ For details about using SmartDeviceMonitor for Client, see SmartDevice-

Monitor for Client Help.
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Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, pack-
ets are sent back and forth, causing communication charges to be incurred. Be-
cause packet transmission is a specification of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

Note
❒ The MAC address of the printer doing the filtering is printed on the printer

configuration page. For details about printing a configuration page, see p.126
“List/Test Print Menu”.

❒ For details about configuring the printer if the router cannot be configured,
see the instructions below.

Configuring the printer with NetWare

A Following the setup method described earlier in this manual, configure the
file server.

B Set the frame type for NetWare environment.

Reference
For details about selecting a frame type, see p.143 “Host Interface Menu”.

Configuring the printer without NetWare

When not printing, the network interface board sends packets over the network.
Set NetWare to “inactive”.

Reference
For details about selecting protocols, see p.143 “Host Interface Menu”.
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Using DHCP

You can use the printer in a DHCP environment. You can also register the print-
er NetBIOS name on a WINS server when it is running. Note the following
points when an Ethernet interface is simultaneously installed.

❖ When static IPv4 addresses are set for each interface
• IPv4 address: When set at the same value, the Ethernet interface is pre-

ferred.
• Subnet mask: When a value overlaps, the Ethernet interface is preferred.
• Gateway address: The value set is used. For the gateway address, set the

gateway address located in the subnetwork set by the interface. If the value
is outside the subnet range set by the interface, it operates as “0.0.0.0”.

❖ When obtaining addresses from the DHCP server
• IP Address, Subnet Mask: you can configure addresses assigned by a

DHCP server. If IPv4 addresses overlap or the same subnet IP addresses
are selected, the effective value is assigned only to the prioritized interface.
Ethernet has default interface priority.

• AutoNet: A temporary IPv4 address starting with 169.254 and not used on
the network, is assigned to the prioritized interface.

• Gateway Address, DNS Server Address, and Domain Name: You can con-
figure the addresses assigned by DHCP to the prioritized interface.
If the gateway address is beyond the range of the subnet selected for the
interface, the printer operates using “0.0.0.0”. Ethernet has default inter-
face priority.
Ethernet has default interface priority.

❖ When there are static IPv4 addresses and addresses assigned by DHCP
• IPv4 Address and subnet mask: if a static IPv4 address is the same as an

address assigned by DHCP, or the static subnet mask address and the sub-
net mask address assigned by DHCP overlap, the printer uses the static
IPv4 address interface. The interface with the DHCP setting is set by de-
fault.
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• Gateway Address: operates using the address entered manually.
If a static address is not selected, or is set to 0.0.0.0, the interface using the
address assigned by DHCP is used.

Note
❒ NetBIOS name on a WINS server must be configured for the WINS server.
❒ Supported DHCP servers are: Windows 2000 Server, Windows Server

2003/2003 R2, and Windows NT 4.0, and the DHCP server included
with NetWare and UNIX

❒ If you do not use the WINS server, reserve the printer’s IP address in the
DHCP server so the same IPv4 address is assigned every time.

❒ To use the WINS server, change the WINS server setting to “active” us-
ing the control panel.

❒ Using the WINS server, you can configure the host name via the remote
network printer port.

❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a
network via ISDN, it will result in increased line charges. This is be-
cause your computer connects to the ISDN line whenever a packet is
transferred from the printer. If there is more than one DHCP server, use
the same setting for all servers. The printer operates using data from the
DHCP server that responds first.

Using AutoNet

If the printer IPv4 address is not assigned by a DHCP server automatically, a
temporary IPv4 address starting with 169.254, which is not used on the network,
can be automatically selected by the printer.
You must change this setting to “on” to use AutoNet.

Note
❒ The IP address assigned by the DHCP server is given priority over that select-

ed by AutoNet.
❒ You can confirm the current IPv4 address on the configuration page.
❒ When AutoNet is running, the NetBIOS name is not registered on the WINS

server.
❒ The printer cannot communicate with devices that do not have the AutoNet

function. However, this printer can communicate with Macintosh computers
running Mac OS X 10.2.3. or higher.

Reference
For more information about the configuration page, see p.126 “List/Test Print
Menu”.
See p.217 “Remote Maintenance by telnet”.
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Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when the power is turned on. This enables the NetBIOS name of the printer to
be specified from SmartDeviceMonitor for Admin even in a DHCP environ-
ment. This section explains configuring the WINS server.

Note
❒ The WINS server is supported with Windows NT 4.0 Server Service Pack 4 or

higher, and Windows 2000 Servers WINS Manager.
❒ For details about the WINS server settings, see Windows Help.
❒ If there is no reply from the WINS server, the NetBIOS name is registered by

broadcast.
❒ The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

A Start a Web browser.

B Enter “http://(printer’s address)/” in the address bar to access the printer
whose settings you want to change.
Top Page of Web Image Monitor appears.

C Click [Login].
The dialog box for entering the user name and password appears.

D Enter the user name and password, and then click [Login].
Contact your administrator for information about the settings.

E In the left area, click [Configuration], and then click [Network].

F Click [TCP/IP].

G Check that [Enable] is selected for [WINS] in the [Ethernet+IEEE 802.11b column],
and then enter the WINS server IPv4 address in [Primary WINS Server] and
[Secondary WINS Server].

H Click [OK].

I Quit Web Image Monitor.

Using telnet

See p.217 “Remote Maintenance by telnet”.
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Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes)
records (A record and PTR record) managed by the DNS server. When a DNS
server is part of the network environment to which this printer, a DNS client, is
connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static
or acquired by DHCP.

Note
❒ When the dynamic DNS function is not used, records managed by the DNS

server must be updated manually, if the printer’s IP address is changed.
❒ To update the record using the printer, the DNS server has to have one of the

following:
• No security settings made.
• If security settings are made, an IP-specified client (this printer) permits

updating.

❖ For a static IP setting
If the IP address or host name is changed, the A and PTR records are updated.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:
• Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

❖ For DHCP settings
As a substitute for the printer, the DHCP server updates the record, and one
of the following occurs:
• When the printer acquires the IP address from the DHCP server, the

DHCP server updates the A and PTR records.
• When the printer acquires the IP address from the DHCP server, the print-

er updates the A record, and the DHCP server updates the PTR record.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:
• Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

Important
❒ Dynamic update using message authentication (TSIG, SIG(0)) is not sup-

ported.
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DNS servers targeted for operation

❖ For static IP setting
• Microsoft DNS servers with standard Windows 2000 Server/Windows

Server 2003/2003 R2 features
• BIND 8.2.3 or higher

❖ For DHCP setup, when the printer updates the A record
• Microsoft DNS servers with standard Windows 2000 Server/Windows

Server 2003/2003 R2 features
• BIND 8.2.3 or higher

❖ For DHCP setup, when the DHCP server updates records
• Microsoft DNS servers with standard Windows 2000 Server/Windows

Server 2003/2003 R2 features
• BIND 8.2.3 or higher
• DNS servers with standard NetWare 5 (or a higher version) features

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record
and PTR record are as follows:
• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3

or higher versions)/Windows Server 2003/2003 R2 features
• ISC DHCP 3.0 or higher
• DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the “dns” command. For details, see p.217 “Re-
mote Maintenance by telnet” .
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Installing Font Manager 2000

Important
❒ Under Windows 2000/XP, Windows Server 2003/2003 R2, or Windows NT

4.0, installing applications by Auto Run requires administrator permission.
To install a printer driver by Auto Run, log on using an account that has ad-
ministrator permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Click [Font Manager 2000].

D Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, or 7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003/2003 R2, or Win-
dows NT 4.0 with Adobe PageMaker, you need to copy PPD files to the Page-
Maker folder.
PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME
\(Language)\DISK1\” on the CD-ROM.
The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use
the folder at this level that is appropriate for the operating system you are cur-
rently using.
The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.
• For PageMaker 6.0 default installation

The directory is “C:\PM6\RSRC\PPD4”.
• PageMaker 6.5 default installation

The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

Note
❒ If the driver is not set correctly after copying the “.ppd” file, printing may not

be performed properly.
❒ When using PageMaker, the optional features that can be selected by the

printer driver will not be active. The following procedure describes how to
activate the optional printer features.
A On the [File] menu, click [Print].

The [Print Document] dialog box appears.
B Make the necessary settings in the [Features] box.
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When Using Windows Terminal 
Service/MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition with SP6 or higher
• MetaFrame 1.8 SP3/FR1+SP3/SP4
• MetaFrame XP 1.0 SP1/SP2/FR1

❖ Windows 2000 Server/Advanced Server
• MetaFrame 1.8 SP3/FR1+SP3/SP4
• MetaFrame XP 1.0 SP1/SP2/SP3/SP4/FR1/FR2/FR3
• MetaFrame Presentation Server 3.0
• Citrix Presentation Server 4.0

❖ Windows Server 2003/2003 R2
• MetaFrame XP 1.0 FR3
• MetaFrame Presentation Server 3.0
• Citrix Presentation Cerver 4.0

Supported Printer Drivers

❖ When Windows Terminal Service is operating
• PostScript 3
• RPCS drivers

Note
❒ Some RPCS printer driver functions do not work if Windows Terminal Ser-

vice is installed.
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Limitations

The following limitations apply to the Windows Terminal Service environment.
These limitations are built in Windows Terminal Service or MetaFrame.

❖ Windows Terminal Service
In an environment where Windows Terminal Service is installed, some print-
er driver functions are unavailable, even if no Windows Terminal Service
functions are used. Use the install mode to install SmartDeviceMonitor for
Client in an environment where Terminal Service is running on a Windows
NT Server 4.0 Terminal Server Edition or Windows 2000 Server family com-
puter. The following are the two methods of installation using the install
mode:
A Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor

for Client.
B Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt:
CHANGE USER /EXECUTE

Note
❒ For more information, see Windows Help.

❖ MetaFrame’s [Auto-creating client printers]
Using [Auto-creating client printers], you can select a logical printer created by
copying the client’s local printer data to the MetaFrame server. We strongly
recommend testing this function in your network environment before using
it for your work.
• The settings for optional equipment will not be stored in the server after

the equipment is disconnected. The settings for optional equipment will be
restored to its defaults each time the client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.
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• If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the follow-
ing:
• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

• MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.

❖ MetaFrame’s [Printer driver replication]
Using [Printer driver replication], you can distribute printer drivers across all
servers in a server farm. We strongly recommend testing this function in your
network environment before using it for your work. When Using Windows
Terminal Service/MetaFrame
• If the printer drivers are not properly copied, install them directly onto

each server.
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Copyright Information about Installed 
Applications

expat

Use of the software installed on this product, including the controller (hereinaf-
ter “software”) and the expat Version 1.95.2 application software (hereinafter
“expat 1.95.2”), is subject to the following conditions:
The product manufacturer provides warranty and support to the software of the
product including expat 1.95.2 and the product manufacturer allows the initial
developer of expat 1.95.2 to be free from these obligations.
Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd
and Clark Cooper
Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the “Software”), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, sub-
ject to the following conditions:
The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AU-
THORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAG-
ES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFT-
WARE.

Note
❒ Information on expat 1.95.2 is available at:
❒ http://expat.sourceforge.net/

JPEG LIBRARY

The software installed on this product is based in part on the work of the Inde-
pendent JPEG Group.
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NetBSD

Copyright Notice of NetBSD
For all users to use this product:
This product contains NetBSD operating system:
For the most part, the software constituting the NetBSD operating system is not
in the public domain; its authors retain their copyright.
The following text shows the copyright notice used for many of the NetBSD
source code. For exact copyright notice applicable for each of the files/binaries,
the source code tree must be consulted.
A full source code can be found at http://www.netbsd.org/.
Copyright © 1999, 2000 The NetBSD Foundation, Inc.
All rights reserved.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:
A Redistributions of source code must retain the above copyright notice, this list

of conditions and the following disclaimer.
B Redistributions in binary form must reproduce the above copyright notice,

this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

C All advertising materials mentioning features or use of this software must
display the following acknowledgment:
This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

D Neither the name of The NetBSD Foundation nor the names of its contribu-
tors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMIT-
ED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTH-
ERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Authors Name List

All product names mentioned herein are trademarks of their respective owners.
The following notices are required to satisfy the license terms of the software
that we have mentioned in this document:
• This product includes software developed by the University of California,

Berkeley and its contributors.
• This product includes software developed by Jonathan R. Stone for the NetB-

SD Project.
• This product includes software developed by the NetBSD Foundation, Inc.

and its contributors.
• This product includes software developed by Manuel Bouyer.
• This product includes software developed by Charles Hannum.
• This product includes software developed by Charles M. Hannum.
• This product includes software developed by Christopher G. Demetriou.
• This product includes software developed by TooLs GmbH.
• This product includes software developed by Terrence R. Lambert.
• This product includes software developed by Adam Glass and Charles Hannum.
• This product includes software developed by Theo de Raadt.
• This product includes software developed by Jonathan Stone and Jason R.

Thorpe for the NetBSD Project.
• This product includes software developed by the University of California,

Lawrence Berkeley Laboratory and its contributors.
• This product includes software developed by Christos Zoulas.
• This product includes software developed by Christopher G. Demetriou for

the NetBSD Project.
• This product includes software developed by Paul Kranenburg.
• This product includes software developed by Adam Glass.
• This product includes software developed by Jonathan Stone.
• This product includes software developed by Jonathan Stone for the NetBSD

Project.
• This product includes software developed by Winning Strategies, Inc.
• This product includes software developed by Frank van der Linden for the

NetBSD Project.
• This product includes software developed for the NetBSD Project by Frank

van der Linden.
• This product includes software developed for the NetBSD Project by Jason R.

Thorpe.
• The software was developed by the University of California, Berkeley.
• This product includes software developed by Chris Provenzano, the Univer-

sity of California, Berkeley, and contributors.
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Samba(Ver 2.2.2-1.1)

Copyright © Andrew Tridgell 1994-1998
This program is free software; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free Software
Foundation; either version 2 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILI-
TY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public
License for more details. You should have received a copy of the GNU General
Public License along with this program; if not, write to the Free Software Foun-
dation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

RSA BSAFE ®

• This product includes RSA BSAFE ® cryptographic or security protocol soft-
ware from RSA Security Inc.

• RSA is a registered trademark and BSAFE is a registered trademark of RSA
Security Inc. in the United States and/or other countries.

• RSA Security Inc. All rights reserved.



57
3

INDEX
A

access,   218
Administrator Mode,   191
Adobe Type Manager,   301
Authentication,   331
Authentication and Managing Users,   331
Auto E-mail Notification,   212
autonet,   219

B

Banner Page,   44
Bidirectional Communication is Disabled,   53
Bitmap Images,   181, 184
Bonjour,   220, 306

C

CAD,   165, 167
CAD application,   151
CALS Files,   151, 152, 183
Canceling a Print Job,   100
Canceling a Print Job, Mac OS,   102
Canceling a Print Job, Windows,   101
CD-ROM,   337
Changing Comments,   206
Changing Names,   206
Changing the Paper Type,   198
Changing the Port Settings for 

SmartDeviceMonitor for Client,   24
Character Group Commands,   174
Collate,   105, 320
Conditions for Bidirectional 

Communication,   52
Configuration Page,   126
Configuring the WINS Server,   345
Confirming the Connection Method,   3
Control Panel,   iv
Copyright Information,   353
Creating a Desktop Printer Icon,   299

D

Deleting Fonts,   325
Deleting Sample Print Files,   85
DeskTopBinder Lite,   74
devicename,   221
DHCP,   343
dhcp,   222
Dial-up Router,   342
Digitization Commands,   172
diprint,   223
Displaying the Printer Status,   330
Dithering,   321
dns,   224
document defaults, RPCS,   61
domainname,   226
Downloading PostScript Files,   328
Downloading PS Fonts,   324

E

Energy Saver Mode,   203
Error Log,   103
EtherTalk,   302, 306
expat,   353
Extended Character,   170

F

Fan Fold,   110
Fit to Paper,   319
Folding Finisher,   109
Folding Finisher Cautions,   111
Fold Type,   110
Font Manager 2000,   348
Form Feed,   44
ftp,   156, 157
Function Palette,   74

G

General Settings,   159, 161
GL/2 Files,   151, 152, 169
GL/2 Print Settings,   159, 163
GL/2 & TIFF,   159



358
H

HDI Driver,   152, 156, 165, 167
Help,   155, 168
help,   226
Hold Print,   90, 91, 92, 308
Host Interface,   143
hostname,   227
How to Read This Manual,   ii
HP-GL,   169
HP-GL/2,   174
HP-GL/2 Filter Coordinates,   173
HP-RTL,   178

I

IEEE 802.11b,   249
ifconfig,   228
info,   229
Initializing Printer Disk,   326
Input Slot,   319
Installing DeskTopBinder,   7
Installing the PostScript 3 Printer Driver 

(Windows 2000),   40
Installing the PostScript 3 Printer Driver 

(Windows 2000 - IPP),   18
Installing the PostScript 3 Printer Driver 

(Windows 2000) (Standard TCP/IP),   28
Installing the PostScript 3 Printer Driver 

(Windows 2000 - TCP/IP),   16
Installing the PostScript 3 Printer Driver 

(Windows 95/98/Me),   39
Installing the PostScript 3 Printer Driver 

(Windows 95/98/Me - IPP),   14
Installing the PostScript 3 Printer Driver 

(Windows XP, Windows Server 2003/
2003 R2),   41

Installing the PostScript 3 Printer Driver 
(Windows XP, Windows Server 2003/
2003 R2 - IPP),   22

Installing the PostScript 3 Printer Driver 
(Windows XP, Windows Server 2003/
2003 R2) (LPR),   35

Installing the PostScript 3 Printer Driver 
(Windows XP, Windows Server 2003/
2003 R2) (Standard TCP/IP),   30

Installing the PostScript 3 Printer Driver 
(Windows XP, Windows Server 2003/
2003 R2 - TCP/IP),   20

Installing the PPD Files,   303
Installing the RPCS Printer Driver,   37
Installing the RPCS Printer Driver (LPR),   32
Installing the RPCS Printer Driver 

(Standard TCP/IP),   26

IPP,   10, 209, 231
ipp,   230

J

Job Spool,   245
Job Type,   308

L

Label Default Status,   174
Language,   150
Launching the Dialogue Console,   330
Line Attribute,   172
List/Test Print,   126
Local Connection,   6
Locked Print,   86, 87, 89, 308
Locking the Menus,   197
lpr,   156, 231

M

Mac OS,   71, 297, 323
Mac OS X,   303, 323
Mail authentication,   213
Maintenance,   121
Manuals for This Printer,   i
Menu Chart,   113
message,   267
MetaFrame,   350
Model-Specific Information,   iii

N

Names of Major Options,   ii
NetBSD,   354
NetWare,   278
netware,   232
NetWare 3.x,   280, 286
NetWare 4.x,   282, 288
NetWare 5/5.1,   282, 284, 288
NetWare 6/6.5,   282, 284, 288
Network Connection,   3
Network Interface Board configuration,   260

O

On-demand E-mail,   214
On-demand E-mail Notification,   212
Option Settings,   52
Orientation Override,   320



59
3

P

PageMaker,   349
Page Setup,   326
Paper Input,   116
Paper Size,   318
Paper Type,   321
Password,   233
PDF Direct Print,   73, 74
PDF Direct Print Properties,   74, 77
PDF Password,   74
Plotter Control Commands,   171
Plotter Information,   172
Plotter Setup Commands,   169
Plotting Basic Characters,   170
Plotting Circles, Ovals,

 and Multiple Shapes,   169
Plotting Domain,   170
PostScript 3,   63, 65, 67, 69, 308
PostScript 3 Printer Driver,   12, 297
PostScript 3 Printer Driver (NetWare),   44
PPD,   297
Printer configuration,   257
printer driver,   338
Printer Fonts,   325
Printer Information,   254, 258
Printer Properties,   55, 57, 59, 61, 63, 65, 

67, 69
Printer Server,   275
Printer Status,   205, 208, 210
Printer Utility for Mac,   322, 323, 324, 325, 

326, 327, 328, 329, 330
Printing after Resetting the Printer,   45
Printing All Print Jobs,   98
Printing a PDF File Directly,   73
Printing Commands,   152, 156, 294
Printing Files Directly from Windows,   291
Printing Font Catalog,   326
Printing Font Sample,   327
Printing GL/2 and TIFF Files,   151
Printing Method,   73
Printing the Selected Print Job,   97
print job,   258
Print Job Function,   79
Print Job Screen,   79
print log,   259
Print Settings,   134
Print Settings for GL/2 & TIFF,   159
prnlog,   234
Pure IP,   284

R

rcp,   156, 157
Renaming the Printer,   327
Rendezvous,   306
Resolution,   319
Restarting the Printer,   328
route,   235
RPCS,   55, 57, 59, 61
RPCS Printer Driver,   8, 10

S

Samba,   356
Sample Print,   82, 85, 308
Screen fonts,   302
Security Options,   138
Selecting the Zone,   329
set,   237
Setting a Password,   204
Setting Spool Printing,   108
Setting Up as a Remote Printer,   280, 282, 

284, 286, 288
Setting Up for Printing,   63, 71
Setting Up Options,   300, 304, 305
Setting Up PPD Files,   299
Setting Up the PPD File, Mac OS X,   304
show,   239
slp,   239
SmartDeviceMonitor for Admin,   193, 

196, 197, 198, 199, 203, 204, 205, 206, 207, 
339

SmartDeviceMonitor for Client,   7, 208, 
209, 340

SmartDeviceMonitor Port,   7
smb,   240
SNMP,   253
snmp,   241
sntp,   244
Software and Utilities,   337
Spool Print,   207
Spool Printing,   107
spoolsw,   245
ssdp,   245
ssh,   246
SSL (Secure Sockets Layer),   335
Standard TCP/IP Port,   26
status,   247
Stored Print,   93, 94, 96, 308
Symbols,   ii
System,   130
system log,   247, 267



360
 EN USA G180-6505

T

TCP/IP,   8, 12
TCP/IP address,   228
telnet,   217
Terminal Service,   350
TIFF/CALS Print Settings,   159, 164
TIFF Files,   151, 152, 179
Toner Saving/Level Color,   320

U

UNIX,   78
upnp,   247
USB Connection,   46
User Code,   318
User ID Screen,   97
User Information,   199
Using as the Windows Network Printer,   37
Using Commands,   78
Using Keys,   iv
Using Sample Print,   310
Using Stored Print,   316
Using the Dynamic DNS Function,   346
Using the LPR Port,   32
Using USB Interface,   305

V

Viewing or Deleting Spooled Jobs,   108

W

web,   248
Web Image Monitor,   185
Web Image Monitor Help,   191
Web Printing Tool,   152
Windows 2000,   48, 57, 65
Windows 95/98/Me,   12, 55, 63
Windows Me,   46
Windows NT 4.0,   61, 69
Windows Server 2003/2003 R2,   49, 59, 67
Windows XP,   49, 59, 67
wins,   252



Copyright © 2007



O
perating Instructions

Softw
are G

uide
EN USA G
180-6505


	Operating Instructions Software Guide
	Introduction
	Important
	Trademarks
	Notes

	Manuals for This Printer
	How to Read This Manual
	Symbols
	Names of Major Options

	Model-Specific Information
	Using Keys
	TABLE OF CONTENTS
	1. Preparing for Printing
	Quick Install
	Confirming the Connection Method
	Network Connection
	Using this printer as the Windows printing port
	Using as a network printer
	Local Connection


	Using the SmartDeviceMonitor Port
	Installing DeskTopBinder-SmartDeviceMonitor for Client
	Installing the RPCS Printer Driver (TCP/IP)
	Installing the RPCS Printer Driver (IPP)
	Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)
	Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)
	Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)
	Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)
	Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003/2003 R2 - TCP/IP)
	Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003/2003 R2 - IPP)
	Changing the Port Settings for SmartDeviceMonitor for Client

	Using the Standard TCP/IP Port
	Installing the RPCS Printer Driver
	Installing the PostScript 3 Printer Driver (Windows 2000)
	Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003/2003 R2)

	Using the LPR Port
	Installing the RPCS Printer Driver
	Installing the PostScript 3 Printer Driver (Windows 2000)
	Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003/2003 R2)

	Using as the Windows Network Printer
	Installing the RPCS Printer Driver
	Installing the PostScript 3 Printer Driver (Windows 95/98/Me)
	Installing the PostScript 3 Printer Driver (Windows 2000)
	Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003/2003 R2)

	Using as the NetWare Print Server/Remote Printer
	When using the PostScript 3 Printer Driver
	Form Feed
	Banner Page
	Printing after Resetting the Printer

	Installing the Printer Driver Using USB
	Windows Me - USB
	Windows 2000 - USB
	Windows XP, Windows Server 2003/2003 R2- USB

	Having Problems Installing the Printer Driver from the CD-ROM
	Making Option Settings for the Printer
	Conditions for Bidirectional Communication
	If Bidirectional Communication is Disabled

	Memory Capacity and Paper Size

	2. Setting Up the Printer Driver
	RPCS - Accessing the Printer Properties
	Windows 95/98/Me - Accessing the Printer Properties
	Making printer default settings
	Making printer settings from an application

	Windows 2000 - Accessing the Printer Properties
	Making printer default settings - the printer properties
	Making printer default settings - printing preferences
	Making printer settings from an application

	Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties
	Making printer default settings - the printer properties
	Making printer default settings - printing preferences
	Making printer settings from an application

	Windows NT 4.0 - Accessing the Printer Properties
	Making printer default settings - the printer properties
	Making printer default settings - default
	Making printer settings from an application


	PostScript 3 - Setting Up for Printing
	Windows 95/98/Me - Accessing the Printer Properties
	Making printer default settings
	Making printer settings from an application

	Windows 2000 - Accessing the Printer Properties
	Making printer default settings - the printer properties
	Making printer default settings - printing preferences
	Making printer settings from an application

	Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties
	Making printer default settings - the printer properties
	Making printer default settings - printing preferences
	Making printer settings from an application

	Windows NT 4.0 - Accessing the Printer Properties
	Making printer default settings - the printer properties
	Making printer default settings - default
	Making printer settings from an application

	Mac OS - Setting Up for Printing
	Making paper settings from an application
	Setting up for printing from an application



	3. Other Print Operations
	Printing a PDF File Directly
	Printing Method
	Using DeskTopBinder Lite
	PDF Direct Print Properties

	Using Commands

	Using the Print Job Function
	Print Job Screen

	Printing from the Print Job Screen
	Sample Print
	Printing a Sample Print file
	Deleting Sample Print files

	Locked Print
	Printing a Locked Print file
	Deleting Locked Print files

	Hold Print
	Printing a Hold Print file
	Deleting Hold Print files

	Stored Print
	Printing a Stored Print file
	Deleting Stored Print files


	Printing from the User ID Screen
	Printing the Selected Print Job
	Printing All Print Jobs

	Canceling a Print Job
	Canceling a Print Job Using the Control Panel
	Windows - Canceling a Print Job from the computer
	Mac OS - Canceling a Print Job from the computer

	Checking the Error Log
	Collate
	Spool Printing
	Setting Spool Printing
	Viewing or Deleting Spooled Jobs Using Web Image Monitor

	Printing with the Folding Finisher
	Fold Types
	Folding Finisher Cautions


	4. Making Printer Settings Using the Control Panel
	Menu Chart
	Paper Input Menu
	Changing the Paper Input Menu
	Automatic tray selection
	Tray Priority

	Paper Input Menu Parameters

	Maintenance Menu
	Changing the Maintenance Menu
	Automatic deletion of temporary jobs in the hard disk

	Maintenance Menu Parameters
	General Settings
	Timer Settings
	HD Management


	List/Test Print Menu
	Printing a Configuration Page
	Interpreting the Configuration Page
	List/Test Print Menu Parameters

	System Menu
	Changing the System Menu
	System Menu Parameters

	Print Settings Menu
	Changing the Print Settings Menu
	Print Settings Menu Parameters

	Security Options Menu
	Changing the Security Options Menu
	Security Options Menu Parameters

	Host Interface Menu
	Changing the Host Interface Menu
	Host Interface Menu Parameters

	Language Menu
	Changing the Language Menu
	Language Menu Parameters


	5. Printing GL/2 and TIFF Files
	Printable Files
	To Print
	Using Web Printing Tool
	About Web Printing Tool
	Displaying top page
	Basic operations of Web Printing Tool
	About password authentication
	How to use help

	Using From HDI Driver
	Using From the Printing Commands
	lpr
	rcp
	ftp


	Print Settings for GL/2 & TIFF
	Adjusting the Print Settings for GL/2 & TIFF
	General Settings
	GL/2 Print Settings
	TIFF/CALS Print Settings

	Using the HDI Driver for AutoCAD
	Setup CD-ROM
	CD-ROM Folders

	Installing the HDI Driver
	Displaying and Printing Help
	Displaying Help
	Printing Help


	Printable GL/2 Files
	HP-GL Specifications
	HP-GL command syntax
	Plotter setup commands
	Commands for plotting Circles, Ovals, and Multiple Shapes
	Commands for plotting basic characters
	Commands for extended character sets
	Commands for changing the plotting domain
	Plotter control commands
	Digitization commands
	Commands for obtaining plotter information
	Line attribute commands
	HP-GL/2 filter coordinates

	HP-GL/2 Specifications
	Character group commands
	Label default status
	Character codes that can be used with LB commands
	Font specification and selection
	Parameters that can be used with SD and AD commands

	HP-RTL Specifications
	Logical Operation (ESC*|#o|ESC*|#o)


	Printable TIFF Files
	TIFF Data Specifications
	TIFF files that can be processed
	TIFF header
	TIFF directory
	TIFF tags
	Bitmap images


	Printable CALS Files
	CALS Data Specifications
	CALS files that can be processed
	CALS headers
	Bitmap image data



	6. Monitoring and Configuring the Printer
	Using Web Image Monitor
	Displaying Top Page
	When User Authentication is Set
	Login (using Web Image Monitor)
	Log Off (using Web Image Monitor)

	About Menu and Mode
	Access in the Administrator Mode
	Displaying Web Image Monitor Help
	Downloading Help
	Linking the URL of the Help File to the Help Button


	Using SmartDeviceMonitor for Admin
	Installing SmartDeviceMonitor for Admin
	Changing the Network Interface Board Configuration
	Locking the Menus on the Printer’s Control Panel
	Changing the Paper Type
	Managing User Information
	Starting User Management Tool
	Displaying the Number of Sheets Printed
	Exporting the information about the number of pages printed
	Resetting the number of pages printed to 0
	Restricting Functions

	Setting Applicable Functions to New Users
	Configuring the Energy Saver Mode
	Setting a Password
	Checking the Printer Status
	Changing Names and Comments

	Viewing and Deleting Spool Print Jobs
	Using SmartDeviceMonitor for Client
	Monitoring Printers
	Checking the Printer Status
	When Using IPP with SmartDeviceMonitor for Client

	Printer Status Notification by E-Mail
	Auto E-mail Notification
	On-demand E-mail Notification
	Mail authentication
	Sending On-demand E-mail

	Remote Maintenance by telnet
	Using telnet
	access
	autonet
	bonjour (rendezvous)
	devicename
	dhcp
	diprint
	dns
	domainname
	help
	hostname
	ifconfig
	info
	ipp
	ipv6
	lpr
	netware
	passwd
	pathmtu
	prnlog
	route
	set
	show
	slp
	smb
	snmp
	sntp
	spoolsw
	ssdp
	ssh
	status
	syslog
	upnp
	web
	wiconfig
	wins

	SNMP
	Getting Printer Information over the Network
	Printer configuration

	Understanding the Displayed Information
	Print Job Information
	Print Log Information
	Configuring the Network Interface Board

	Message List
	System Log Information


	7. Using a Printer Server
	Preparing Printer Server
	Printing notification via SmartDeviceMonitor for Client
	Setting the print server
	Setting a Client


	Using NetWare
	Setting Up as a Print Server (NetWare 3.x)
	Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)
	Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment
	Setting Up as a Remote Printer (NetWare 3.x)
	Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)


	8. Special Operations under Windows
	Printing Files Directly from Windows
	Setup
	Using a Host Name Instead of an IPv4 Address
	When using DNS
	When setting the “IPv4 address” of a printer using DHCP
	In other cases

	Printing Commands
	lpr
	rcp
	ftp



	9. Mac OS Configuration
	Mac OS
	Installing the PostScript 3 Printer Driver and PPD File
	Setting Up PPD Files
	Creating a Desktop Printer Icon
	Setting Up Options
	Installing Adobe Type Manager
	Installing Screen fonts
	Changing to EtherTalk

	Mac OS X
	Installing the PPD Files
	Setting Up the PPD File
	Setting Up Options
	Using USB Interface
	Using Bonjour (Rendezvous)
	Changing to EtherTalk

	Configuring the Printer
	Using PostScript 3
	Job Type
	Using Sample Print
	Using Locked Print
	Using Hold Print
	Using Stored Print

	User Code
	Paper Size
	Fit to Paper
	Input Slot
	Resolution
	Orientation Override
	Toner Saving
	Collate
	Paper Type
	Dithering

	Printer Utility for Mac
	Installing Printer Utility for Mac
	Starting Printer Utility for Mac
	Mac OS
	Mac OS X

	Printer Utility for Mac Functions
	Downloading PS Fonts
	Displaying Printer Fonts
	Deleting Fonts
	Initializing the Printer Disk
	Page Setup
	Printing Font Catalog
	Printing Font Sample
	Renaming the Printer
	Restarting the Printer
	Downloading PostScript Files
	Selecting the Zone
	Displaying the Printer Status
	Launching the Dialogue Console



	10. Security Measures Provided by this Printer
	Using Authentication and Managing Users
	Preventing Information Leaks
	Limiting and Controlling Access
	Enhanced Network Security
	Configuring SSL Encryption

	11. Appendix
	Software and Utilities Included on the CD-ROM
	Printer Drivers for This Printer
	SmartDeviceMonitor for Admin
	DeskTopBinder - SmartDeviceMonitor for Client

	Cautions to Take When Using in a network
	Connecting a Dial-up Router to a Network
	Configuring the router
	Configuring the printer with NetWare
	Configuring the printer without NetWare

	Using DHCP
	Using AutoNet

	Configuring the WINS Server
	Using Web Image Monitor
	Using telnet

	Using the Dynamic DNS Function
	Updating
	DNS servers targeted for operation
	DHCP servers targeted for operation
	Setting the dynamic DNS function


	Installing Font Manager 2000
	Using Adobe PageMaker Version 6.0, 6.5, or 7.0
	When Using Windows Terminal Service/MetaFrame
	Operating Environment
	Supported Printer Drivers
	Limitations

	Copyright Information about Installed Applications
	expat
	JPEG LIBRARY
	NetBSD
	Authors Name List

	Samba(Ver 2.2.2-1.1)
	RSA BSAFE


	INDEX

